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1 What�s New in This Release
What�s New in Siebel Medical Handheld
Table 1 lists changes described in this version of the documentation to support Release 7.7 of the 
software. 

Table 1. New Product Features in Siebel Medical Handheld, Version 7.7

Topic Description

Enhanced Administration

�Application Administration� on 
page 39

New administration screens allow easier administration of 
your Siebel Medical Handheld application.

Signature capture

�Enabling Signature Capture in 
Siebel Handheld� on page 35

You can configure views within your Siebel Medical Handheld 
application which allow you to capture signatures.

Barcode scanning

�Administering Barcode Settings for 
Siebel Medical Handheld� on 
page 44

This new feature allows you to set up barcode scanning with 
your Siebel Medical Handheld application.

Enhanced synchronization 
monitoring ability

�About Monitoring Synchronization 
Sessions for Siebel Handheld� on 
page 50

This new feature allows you to monitor various aspects of 
user synchronization sessions through Administration 
screens and views.

�Managing Consigned Inventory 
with Siebel Medical Handheld� on 
page 153

Using your Medical Handheld application you can work, track, 
and manage consignment inventory.

�Managing and Performing Cycle 
Counts with Medical Handheld� on 
page 155

You can assign cycle counts to users; have these assignments 
accessed at the time of sync; and users can collect cycle 
count information, reconcile accounts, and upload the new 
data. 
Siebel Medical Handheld Guide Version 7.7 ■ 11



What�s New in This Release ■  
Siebel Medical Handheld Guide Version 7.712 ■



2 Overview of Siebel Medical 
Handheld
This chapter includes the following topics:

■ �About Siebel Handheld� on page 13

■ �Overview of Siebel Handheld Synchronization� on page 14

■ �Siebel Handheld Synchronization Methods and Architecture� on page 14

■ �Overview of Siebel Handheld Client Application Configuration� on page 15

About Siebel Handheld
Siebel Handheld provides a subset of functionality to that of the Siebel Web Client. The Siebel 
Handheld Client differs from the Siebel Web Client and the Siebel Mobile Web Client in that it uses a 
selected subset of views, accommodates smaller screen sizes, and has a reduced memory capacity. 
For a list of functional differences, see Chapter 3, �Application Development.�

Some features that are available on the Siebel Mobile Web Client are not available on the Siebel 
Handheld. Scripting and Siebel engines (for example, Pricing and Reporting) are not supported on 
the handheld. For a list of features that are not supported, see �Unsupported Features for Siebel 
Handheld� on page 18. 

Some supported features of the Siebel Handheld client are as follows:

■ Application Development with Siebel Tools: Siebel Handheld applications can be configured 
in Siebel Tools using the Web Applet Designer. You can take your existing Siebel application and 
use this as the basis for the Siebel Handheld application, or you can create a new application by 
using the Siebel Tools application shipped on the Siebel Handheld application DVD. See 
Chapter 3, �Application Development,� for more information.

■ Data filtering: Filtering allows you to specify a subset of data to be used on the handheld device. 
Filtering is an important feature of a Siebel Handheld deployment because of the relatively large 
size of the average enterprise database in comparison to the relatively limited memory 
capabilities of handheld devices. It is important that you allocate sufficient time in the project 
plan to create and test the handheld filters. See �Application Development� on page 17 for more 
information.

■ Deployment options: The Siebel Handheld application can be installed on Windows-powered 
devices in one of two ways. The first is to create a partnership between a desktop or laptop PC 
and the handheld device using Microsoft ActiveSync. The second is to install the Siebel Handheld 
application from external media, for example, a Cabinet (CAB) file. Handheld patches can be 
remotely deployed using PatchAgent. For more information, see Chapter 6, �Deployment of Siebel 
Handheld.�
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Overview of Siebel Medical Handheld ■  Overview of Siebel Handheld Synchronization
■ Patch Updates. Siebel Handheld automatically applies the latest software patches to the 
handheld device when needed. Companion Sync allows users to Synchronize the Handheld 
Database to the local database on Companion PC and invokes Siebel Remote to synchronize the 
local database with the server database.

■ Backing Up and Restoring Data: The Siebel Handheld application provides database backup 
functionality. A database restore utility is also included with the application. See Chapter 4, 
�Application Administration,� and Appendix A, �Troubleshooting,� for details.

Overview of Siebel Handheld 
Synchronization
The Siebel Handheld Synchronization (Sync) client synchronizes data between the Siebel Handheld 
database and the Mobile Web Client database or server database. The synchronization process does 
the following: 

■ Updates the Siebel server database with changes made to the Siebel Handheld database

■ Updates the database on the handheld device with changes made to the Siebel server database

■ Downloads metadata changes, such as object definitions for new or modified screens or views

■ Allows users to select filters to limit the amount of data that is downloaded

■ Automatically applies the latest software patches to the handheld device when needed

Siebel Handheld Synchronization 
Methods and Architecture
The following methods can be used to synchronize data on the handheld device with data in the 
Siebel server database: Companion Sync (CS), Direct Server Sync (DSS) and Direct Server Sync by 
means of Proxy (DSSvP). The architecture of these methods is discussed in the following sections.

Handheld Synchronization Servers
There are two types of synchronization servers: direct synchronization servers and companion 
synchronization servers. A direct synchronization server run on the Siebel application server can 
accept concurrent synchronization requests from multiple synchronization clients. When connecting 
to a direct synchronization server, the Siebel Handheld Sync client synchronizes its data with the 
server-side database. Companion Sync allows users to synchronize the Handheld Database to the 
local database on a companion PC device and invokes Siebel Remote to synchronize a local database 
with the server database. 

In Direct Server Sync mode, the Siebel Handheld Synchronization client uses the HTTP protocol over 
a network connection to communicate with the handheld synchronization server. Users should 
configure their handheld devices for communication over the desired network.
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Configuration
A companion synchronization server runs on a companion personal computer with a Mobile Web 
Client installation and supports synchronization with a data source specified in a client configuration; 
the database resides on the companion PC.

Companion Sync
Companion Sync allows users to synchronize the Siebel Handheld application and database with a 
Siebel Remote database on a Mobile Web Client.

Microsoft ActiveSync is used to connect the handheld device and the companion PC through a serial 
or USB connection or through a network connection. The user launches Siebel Handheld Sync from 
companion PC or the device. The user can change the default filters using Siebel Handheld Sync.

Direct Server Sync
Direct Server Sync allows users to synchronize their Siebel Handheld application and database 
directly with the Siebel server. The user connects the handheld device to the Siebel application server 
through a network connection that uses the HTTP protocol. The connection runs through a IIS Web 
server to the Siebel Gateway Name server and application server, where the Sync server components 
are installed and running. 

Direct Server Sync by Means of Proxy
Direct Server Sync by means of Proxy (DSSvP) allows users to synchronize their Siebel Handheld 
application and database directly with the Siebel server. The user connects the handheld device to 
the Siebel application server through ActiveSync and the network connection established by the 
companion PC. The connection runs through a IIS Web server to the Siebel Gateway Name server 
and application server, where the Sync server components are installed.

Overview of Siebel Handheld Client 
Application Configuration
The following provides an overview of the configuration process of the Handheld client. Complete the 
following steps to configure your handheld client application.

To configure the Siebel Handheld client

1 Define the user functionality. 

Determine which user interface elements (such as screens, views, toolbars, applets, find, and 
help) will be necessary for your Siebel Handheld Client end users. For more information, see 
�About Defining User Functionality in Siebel Handheld� on page 20.

2 Configure the Siebel Handheld Client user interface. 

The process for configuring user interface elements in the Siebel Handheld Client is the same as 
that for other Siebel clients. For more information, see �Configuring User Interface Elements in 
Siebel Handheld� on page 24 and Configuring Siebel eBusiness Applications.
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Configuration
3 Identify all eScript or VB script.

Siebel Handheld applications do not currently support scripting, including eScript or VB script. 
Scripting used in your Siebel application may conflict with your Siebel Handheld application 
configuration.

4 Compile the new configuration.

For more information, see �Compiling the Siebel Handheld Application� on page 32.

5 Test the new configuration. 

Test the configuration, repeating the previous steps, to address any configuration errors.

After completing the Siebel Handheld Client configuration, you are ready to install it on the handheld 
devices. To install the Siebel Handheld configuration on a handheld device, see the instructions in 
�Installing on the Siebel Handheld Application� on page 99.
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3 Application Development
This chapter includes the following topics:

■ �Overview of Siebel Handheld Architecture� on page 17

■ �Unsupported Features for Siebel Handheld� on page 18

■ �About Defining User Functionality in Siebel Handheld� on page 20

■ �Configuration Guidelines for Siebel Handheld� on page 21

■ �About Creating Siebel Handheld Projects� on page 22

■ �Designing Screens and Views for Siebel Handheld� on page 22

■ �Configuring User Interface Elements in Siebel Handheld� on page 24

■ �Preventing Synchronization Conflicts with Siebel Handheld� on page 31

■ �Recommended Configuration Guidelines for Siebel Handheld� on page 31

■ �Compiling the Siebel Handheld Application� on page 32

■ �Configuring Printing from the Siebel Handheld Application� on page 32

■ �Testing the Siebel Handheld Application� on page 37

Overview of Siebel Handheld 
Architecture
The process for configuring a Siebel Handheld Client has a few differences, described in this chapter, 
from the process for configuring other types of Siebel clients.

NOTE: Readers should familiarize themselves with the Siebel client configuration process described 
in Configuring Siebel eBusiness Applications before attempting to configure the Siebel Handheld 
Client.

The five layers in the Siebel Handheld architecture are comparable to those used on the Siebel Web 
Client: 

Application layer. The application layer starts and closes the application.

User Interface layer. The user interface layer renders the display and interacts with actions of the 
user.

Object Manager layer. The object manager layer provides a consistent object behavior and 
interaction between all business objects within the application.

Data Manager layer. The data manager layer maintains an object-oriented abstraction of the native 
data stored in the data repositories for the benefit of the object manager.
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Database layer. The database layer includes the data that Siebel Handheld users access.

Your Administrator configures an application on the Siebel client using Siebel Tools and compiles the 
Siebel repository (.srf) file. During the synchronization process, information specific to the Siebel 
Handheld Client is extracted from the Siebel repository file. This information is used to create a 
repository metalanguage (.rml) file, that is downloaded to the handheld device. The repository 
metalanguage file has all of the layout information for the handheld device. For more information on 
Siebel Tools, see Using Siebel Tools. 

Unsupported Features for Siebel 
Handheld
The differences between configuring user interface elements for the Siebel Web Client and the Siebel 
Handheld Client are shown in Table 2.

The following are not supported in Siebel Handheld applications:

■ The following applet types are not supported:

■ Chart

■ Explorer

■ More than two applets per view is not supported. A maximum of two applets may be displayed 
at one time. 

■ Group boxes are not supported. See �Group Boxes� on page 26 for information on how to 
accommodate this limitation.

■ Alarm Manager is not supported. Therefore, if an alarm check box is added to an applet and the 
check box is selected, no alarm sounds.

■ The base time zone is determined by the system settings on the server and cannot be changed 
on the handheld device.

■ Alphabet tabs are not supported.

■ Scripting is not supported. However, any scripts on the business components will be executed 
during synchronization.

■ Siebel Workflow is not supported. 

■ Assessment creation is not supported.

Table 2. Configuring Siebel Client User Interface Elements

Client Siebel Tools SWT Template Files
Specialized 
Algorithms

Siebel Web Client Yes Yes No

Siebel Handheld Client Yes No Yes
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Application Development ■  Unsupported Features for Siebel Handheld
See the following topics which outline, more specifically, other unsupported features. 

Multi-Value Groups (MVG)
The Multi-Value Group applet is not supported on the Siebel Handheld Client; however, the Multi-
Value Group relationship is supported. The Multi-Value Group (MVG) control button does not appear 
on fields in Siebel Handheld Client applications. Instead, MVGs can be implemented as parent-child 
views. As a result, MVG fields are not editable within the parent record. In the Siebel Web Client, 
addresses of accounts are added, deleted, or edited through the Business Address MVG applet. 
However, in the Siebel Sales Handheld Client, these functions must be done through a Business 
Address child applet with an Account applet as its parent.

On the handheld, all MVG fields are displayed as read-only fields with the primary record visible. If 
you have an application or business requirement that requires the user to view or update all the 
records in the MVG, you must configure a separate view for that MVG. For example, the Address field 
in the Accounts or My Accounts view is an MVG. In the Siebel Handheld Client that field is read-only 
and displays the primary record. In order for the handheld user to see and update the addresses, 
the new Address view is configured in Siebel Tools. This new Address view is visible in the Show drop-
down list.

Functions
Siebel Handheld applications support most of the calculated fields and operations used in the Siebel 
Web applications with a few exceptions. See Table 3 for a list of the unsupported functions.

Table 3. Unsupported Functions

Function Name

BCHasRows

DockingNodeId

DockingNodeName

DockingNodeRoutId

EAILookupExternal

EAILookupSiebel

EXISTS

GetHQInstanceId

GetHQInstanceName

GetNumBCRows

GetProfileAttr

GetXAval

IsDocked
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The NOT key word is not supported on Booleans. Use the != operator instead. For example, "Active" 
!= "Y".

The RowIdToRowNum function is supported differently in the handheld applications than in the Web 
applications. In Web applications, RowIdToRowNum converts a row Id to a numeric value. In the 
handheld applications, it returns the row ID itself.

Installing the Siebel Handheld Client
For information on installing the Handheld client, see Chapter 6, �Deployment of Siebel Handheld.�

About Defining User Functionality in 
Siebel Handheld
The first step in configuring a Siebel Handheld Client is to determine which user interface elements 
are necessary. Siebel Handheld Client users have different requirements from Siebel Web Client 
users. Keep in mind the differences in display size, memory capacity, and input methods between 
handheld devices and larger computers, such as desktop computers.

The goal is to create applications that are easy for your end users to use and which take advantage 
of the strengths of the handheld device platform. Because of processing speed, memory limitations, 
and form factor differences, you should only include those user interface elements that are necessary 
for users to complete their job responsibilities.

LanguageName

LocaleName

LookupMessage

LookupTranslation

NOT

RepositoryId

RepositoryName

RowIdToRowNum

ToolsLanguage

Table 3. Unsupported Functions

Function Name
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Configuration Guidelines for Siebel 
Handheld
There are a few general guidelines you should bear in mind when configuring for the Siebel Handheld 
application. Use these guidelines when you design any new objects for the Siebel Handheld Client. 
This approach facilitates a logical separation of the Siebel Handheld Client user interface elements 
from the Siebel Web Client user interface elements. 

■ Identify User Activities

To conserve memory (and thereby improve performance) and ease navigation, identify business 
processes that are required by end users and develop applications that support these processes. 
If more than one type of user needs a Siebel Handheld Client application, it is preferable to divide 
the application into multiple responsibilities rather than give all possible users access to all 
available screens and views. Responsibilities are fully configurable by the application developer.

■ Limit the number of screens and views

Limit the number of screens and views. Determine critical business processes that the handheld 
will support and only pick the views that are necessary and make sense based on business 
requirements. 

■ Limit the number of applets for each view

Design each view so that it has one or, at most, two applets. Limiting the number of applets 
enhances performance, and enriches the user experience.

NOTE: In some instances, Siebel Systems found it necessary to create a view with three applets 
in its handheld applications. For these views, a toggle button was added to the applet so that the 
user can easily navigate between the two child applets.

■ Limit the number of columns and fields for each applet

Design each applet so that it only contains columns and fields that are required for end-user 
tasks. 

■ Design applications that contain as few screen and view hierarchy levels as possible

In a Web-based application, you may have views with many applets, and the user toggles 
between the applets. However, for handheld applications, create a larger number of views with 
fewer applets to allow users to quickly find information with a minimal amount of toggling.

■ Design for the Handheld Screen

Consider the following questions when designing your applets:

■ If you are using a list applet, how wide is that list applet going to be? 

■ What are the most important fields and columns that a user needs to see at a glance before 
scrolling? 

■ If you have a form applet that is a parent, for example, what fields do you really need in 
order to avoid scrolling?

■ Because there is less screen space on a handheld device than on a laptop or desktop, the 
most important data should be immediately visible.
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About Creating Siebel Handheld Projects
The Siebel Handheld projects appear in the list of projects in Siebel Tools; when Project is selected 
in the Object Explorer, the list of projects is displayed in the Object List Editor.

Use a naming convention that allows you to easily identify applications, screens, views, and applets 
belonging to a particular Siebel Handheld application. This allows you to locate all the object 
definitions in a Siebel Handheld application by querying on the name in the Object List Editor. For 
example, all of the Siebel Handheld Client screens, views, applets, toolbars, and menus use either 
an SHCE prefix (for example, SHCE Sales Account List View) or a CE suffix. Use the Object List Editor 
to query for views that contain the prefix SHCE or the suffix CE; doing so displays all of the Siebel 
Handheld Client views.

If you create a new Siebel Handheld application, create a new suffix or prefix to identify the name 
of the application and each screen, view, and applet name. For example, you could use PPC_SHCE 
for an application.

Designing Screens and Views for Siebel 
Handheld
Each view in a Siebel Handheld application can display a maximum of two applets at a time, 
regardless of the number of applets in the view. If there are more than two applets in a view, the 
user can navigate to additional applets by toggling.

Screen Allocation
The amount of screen space available for applets is determined by the type of applets in the view. 
Two applets are stacked above one another. A parent form applet in a two-applet view displays 
multiple fields on a screen. Users use the scroll bar to navigate. The form applet dynamically resizes 
if there are fewer than five fields and, therefore, does not waste screen display space with empty 
lines. The maximum number of fields that are displayed at one time is configurable by setting the 
Max Parent Applet Size preference in the User Preferences dialog. See �Setting User Preferences in 
the Siebel Handheld Application� on page 113 for more information on this user preference.

Toggling Between Multiple-Applet Views 
The Siebel Handheld Client application displays up to two applets at one time. If the view has only 
one applet, the applet takes up the entire display area. For views with two or more applets, the first 
two applets in the view are displayed, and the user toggles to see the other applets. The first applet 
is always displayed and the second applet changes as you toggle.

By default, the user toggles by choosing the View > Toggle menu item. In addition, it is 
recommended that you provide a toggle button as a visual cue to the end user that there are 
additional applets. Add a toggle button to each applet except the first applet. Identify the button with 
a Toggle caption and set methodInvoked to ToggleApplet.
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Drill-down Only Views
Some views may be drill-down only views�that is, they can only be accessed by navigating from 
another view. These views should not be accessible through the Show drop-down list. However, when 
the end user navigates to the view, the view title appears in the Show drop-down list. To configure 
a drill-down only view, set the view title as you would for any other view and set the ScreenMenu 
property to FALSE. See Configuring Siebel eBusiness Applications for more information.

Applet Focus Behavior
When navigating between views, there may be instances when you need to override the default 
behavior for giving focus to an applet

The GotoView method is used to navigate from one view to another. A button control is added to the 
applet in the view you want to navigate from, the button�s methodInvoked property is set to 
GotoView and the button�s View property is set to the view that is to be created. When the GotoView 
method is executed, it builds the specified view. If the view includes a parent and child applet, 
GotoView gives focus to the child applet. This is the desired behavior in most instances when you 
are simply navigating from one view to another.

If the desired behavior is to navigate to a new view and, additionally, create a new record, then you 
must use the GotoViewNewRecord method. This method calls two methods; it calls GotoView, and 
then it calls NewRecord, which creates a new record in the new view. 

In some instances the default behavior of these methods does not produce the intended behavior. 
For example, in the Orders view of the Service Requests screen, when you tap the Create New Order 
button, it takes you to the Order Details view, which contains a parent form applet (Service Request 
Order) and a child list applet (Service Order Entry Line Item). In this instance, when the Create New 
Order button�s GotoViewNewRecord method is executed, you want a new order to be created. 
However, the default behavior is to give focus to the child applet rather than creating a new record 
in the parent applet. Therefore, you need to override the default behavior of GotoView with the 
control user property OverrideDefaultApplet, and set the value to the applet that you want to give 
focus. The valid values are 0 (parent) and 1 (child). For example, if you create a button labeled 
�Create Service Request Order,� you would define user properties shown in Table 4:

Views with Associated Print Templates or Reports
Print templates are text files that you design and create for printing. After creating a print template, 
you associate it with an applet. When an end user chooses to print a view, the print template that is 
associated with the applet is automatically selected and used for printing. Follow these guidelines 
when creating print templates:

■ Only one print template can be associated with an applet.

Table 4.

Name Value

View SHCE Service Order Line Items View

OverrideDefaultApplet 0
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■ The print template name for a particular display applet is registered in the Mail Template property 
in the Applet object associated with the applet.

■ The template must be placed in the Templates directory.

■ The template name that goes into the Mail Template property should not include a path name or 
extension. For example, if the full path of the template is \Program Files\Siebel 
Handheld\Templates\InvoiceTemplate.txt, you would enter only the root name InvoiceTemplate 
in the property field.

■ The template file itself must have a .txt extension on the device. In the case of Siebel Medical 
for Handheld the provided print template is called: QuoteTemplate.txt. 

For more information, see Appendix E, �Print Configuration Settings.�

Configuring User Interface Elements in 
Siebel Handheld
When configuring user interface elements on the Siebel Handheld Client, also consider the processing 
speed and memory constraints of handheld devices. The constraint on processing speed affects the 
performance of a handheld device. The performance of a handheld device is also related to the 
number of screens and views downloaded to the handheld device. Because handheld devices are not 
meant to provide the same functionality as larger devices, such as laptops, the number of screens 
and views must be kept to a minimum on the handheld device.

Due to size constraints on handheld devices, the Siebel Handheld Client displays user interface 
elements differently from the Siebel Web Client. Consider these differences when configuring the 
Siebel Handheld Client application. For example, Siebel Handheld Client does not support an 
alphabetical index.

Configuring List Applets for the Handheld Client
You configure list applets and list columns for Siebel Handheld applications the same way you 
configure them for other Siebel applications. 

Recommended Strategy for Configuring List Applets
The recommended strategy when configuring the Siebel Handheld Client is to use the list applets for 
record navigation and to rely on form applets to provide the record details.

The following are additional guidelines to follow when designing list applets:

■ Configure specific list applets for your Siebel Handheld application, rather than reusing Siebel 
Web Client list applets.
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■ Remove all but the essential list columns. Because there is limited screen area to display list 
columns, omit all unnecessary columns to minimize horizontal scrolling. 

You may either remove the columns from the application or set the Show in List property on the 
column to FALSE.These two methods are different in the following ways. If the columns are 
removed from the application, these data won't be downloaded to the handheld device, which 
keeps the handheld data and a minimum and, in turn, optimizes synchronization performance. 
If the Show in List property on the column is set to FALSE, the data is still downloaded to the 
device but is not shown by default. This second approach, though without the synchronization 
optimization benefit, does allow convenience for the user who wants to customize visible 
columns. You should take these concerns into account when setting up users. 

■ Reorder the remaining list columns so that the most frequently used columns are furthest to the 
left.

■ Reduce the default width of the list columns so that more columns can be viewed at one time.

■ Use hyperlinks to ease navigation by enabling users to drill into a form applet. 

These changes can minimize the amount of horizontal scrolling and column reordering that users 
must do. Limiting the number of list columns to those that are essential minimizes the amount of 
data downloaded to the device, resulting in faster synchronization times and more economical use 
of device memory.

NOTE: All required fields on form and list applets appear with an asterisk (*). If an administrator 
specifies that a field is required, the field appears with an asterisk in the user interface.

Use Siebel Tools to modify, or rearrange List Columns. For more information on the List Column 
options, see Configuring Siebel eBusiness Applications.

You may make columns available, but not visible by default, by setting the Show In List property of 
the column to FALSE. From the Siebel Handheld application, you can make the columns visible from 
the View > Columns Displayed menu option. In order for the change to be reflected in the application, 
you must compile the application and synchronize with the handheld device. In addition, you must 
delete the \Program Files\Siebel Handheld\siebel.ssf file on the handheld. If this file is not deleted, 
the change to the Show In List parameter is not reflected in the application. 

Configuring Form Applets for the Handheld Client
The handheld uses a specialized algorithm to format and display form applets. Due to the display 
limitations on the device, only one pair of label and field controls are displayed on each row of the 
form, regardless of the layout shown within Siebel Tools.

Layout Sequence
When configuring for the handheld device, the Applet Web Template Items in the Applet Web 
Template determine the controls that appear on a form applet. The layout of form applets on the 
handheld device is determined by the HTML Sequence field set on control objects.
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The HTML Sequence field determines the screen layout of a handheld device. Controls are ordered 
from top-to-bottom based on their HTML Sequence property values. Label and control pairs that do 
not fit on the same line as other label and control pairs wrap to the next line.

Labels
Keep field labels in applications short (approximately 12 characters or fewer, depending on the 
character width). Use abbreviations where possible. Labels that are too long are truncated.

Group Boxes
Group boxes are not supported and are not displayed in form applets, even if they are added in the 
Web Applet Designer. Therefore, reword the field labels to include group box information if necessary. 
For example, you may have two group boxes on the form, one labeled Ship To and another labeled 
Bill To. Each group box includes a field named Address. Because group boxes are not supported, the 
Ship To and Bill To labels are lost, and two fields with the identical Address label remain. Therefore, 
you must rename the Address labels �Ship To Addr� and �Bill To Addr,� or some other label that 
distinguishes them.

Using Auto Pop-Up Lists in the Handheld Client
Sometimes when a user encounters a new view, he or she must perform an action, such as filling in 
a required field by selecting a value from a pop-up list. Rather than requiring the end user to tap the 
control to open the pop-up list, you can configure the view so that the pop-up list automatically opens 
when the end user gets to that view. To configure a pop-up list to open automatically, add the user 
property on the applet with Name set to AutoPopupField. Depending on the type of applet, this 
property is set differently:

■ For list applets, set the AutoPopupField property to the Business Component field name.

■ For form applets, set the AutoPopupField property to the name of the control.

About Home Page Applets in Siebel Handheld
To configure a Home Page applet, create an applet that has controls of HTML Type Button only. Use 
the following guidelines in creating your Home Page applets:

■ Set the MethodInvoked property of these controls to GotoView. Then add a user property for the 
control, and set the Name parameter to �View� and set the Value parameter to the view name.

■ Set the Caption field.

■ Set the HTML Sequence field according to the order in which the buttons are laid out on the 
device. The buttons appear on the Home Page applet of the handheld device, laid out in rows of 
three buttons.
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About Buttons in Handheld
Set the HTML Type field on buttons to Button, MiniButton, PushButton, or MiniButtonEditNew. All of 
these HTML Types map to the same button control on the handheld device.

Buttons with text labels on them are sized to the minimum width required to fit the text on the 
buttons.

NOTE: You cannot use scripting to augment the button functionality in handheld applications.

You may add buttons as long as the method invoked is supported by the class or superclass of the 
frame or business component. You may also remove buttons from an applet. Be careful when 
removing buttons because you may alter the behavior of your application in unintended ways. Table 5 
describes the behavior of buttons on the different screens. Use this table to guide your decisions 
about removing buttons from your handheld applications.

Table 5. Button Functionality 

Screen View Button Button Functionality

Cycle Count Cycle 
Count 
Detail

Count 
Complete

■ Updates cycle count record in the Cycle Count > 
My Pending Cycle Count view.

■ Updates Status to Done.

■ Updates End Date field with current date/time.

■ Calculates the variance between the cycle count 
and inventory.

■ Creates inventory transactions to adjust inventory.

■ Updates Inventory Location product Bucket fields 
and calculates usage.

■ Makes Cycle Count Detail and Product Detail 
records read-only.

■ Makes Cycle Count record read-only.

■ Saves all records.

■ Commits all inventory transactions associated with 
location which do not require approval.

■ Navigates to Inventory > Move Approvals view if 
any transaction requires approval (for example, 
part moves). Otherwise, navigates to Inventory > 
Inventory Detail view.

Cycle Count Cycle 
Count 
Detail

Scan ■ Enable barcode scanning.

■ Navigates to the Scan Barcodes Form view.
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Cycle Count My Pending 
Cycle 
Count

Start ■ Updates cycle count record in the Cycle Count > 
My Pending Cycle Count view.

■ Updates Start Date field to the current date/
time.

■ Updates Status to In Progress.

■ Navigates to Cycle Count Detail View for selected 
cycle count record.

Cycle Count My Pending 
Cycle 
Count

Usage ■ Navigates to Inventory > Inventory Detail View for 
the inventory location on which the Cycle Count 
record is associated to.

Cycle Count My Pending 
Cycle 
Count

Schedule ■ Navigates to Calendar - Weekly View focused on 
current day.

Inventory Inventory 
Detail

Rollup ■ Updates Inventory Location record:

■ Updates Last Roll Up field with current date/
time.

■ Aggregates Qty, Current Usage and Average 
Usage for each level in the hierarchy from the 
leaf level products up to the leaf level defined 
by the Rollup Level field for that inventory 
location*

■ Displays Min and calculates Delta field for 
items in the hierarchy with Consignment Level 
= True.  

NOTE: You define Rollup Level field for that Inventory 
location through the Inventory > Inventory Location > 
More Info view. For information on setting up 
inventory locations, see Siebel Order Management 
Guide.

Inventory Inventory 
Location

Move ■ Navigates to the Part Move view.

■ Pre-populates fields in the Part Move view 
depending on where the move was initiated.

NOTE: The Move button is also available in the Cycle 
Count > Product Detail view (drill-down only view), 
Cycle Count > Scan Barcodes (drill-down only view), 
Inventory > Assets view, Move > Transaction view. 
Depending on where the Move button was clicked, the 
fields will be pre-populated based on information that 
is available on these views.

Table 5. Button Functionality 

Screen View Button Button Functionality
Siebel Medical Handheld Guide Version 7.728 ■



Application Development ■  Configuring User Interface Elements in Siebel Handheld
About the Menu Bar in Handheld
The menu object definition in the Siebel repository that is implemented in handheld applications is 
named SHCE Generic. The default menu bar configuration for the Siebel Handheld Client includes the 
following menus: File, Edit, View, and Help. You may remove or rename menus on the menu bar, but 
you cannot add new menus. You may reorder the menu items by changing the Position property for 
the menu items. Generally, use the default menu bar configuration for all of your Siebel Handheld 
Client applications. 

Inventory Move 
Approvals

Sign ■ Pops up Signature Capture screen.

Opportunities Quotes AutoQuote ■ Generate Quote and Quote Items records based on 
the opportunity and products associated to the 
opportunity.

NOTE: For more information on AutoQuote 
functionality, please refer to �Using Auto Quote in 
Medical Handheld� on page 142.

Quote Quote 
Items

Print ■ Prints Quote report based on Quote print template.

Quote Quote 
Items

Toggle ■ Toggles between Quote List Applet and Quote 
Form Applet to display details on discounts for the 
quote item record.

NOTE: For more information on AutoQuote 
functionality, please refer to �Using Auto Quote in 
Medical Handheld� on page 142.

Quote Order AutoOrder ■ Generates Order and order Line Item records 
based on the quote and quote items for that quote.

NOTE: For more information on AutoOrder 
functionality, see �Creating Orders in Medical Handheld� 
on page 145.

Cycle Count Scan 
Barcodes

Stop ■ Disables barcode scanning.

■ Navigates to Cycle Count > Cycle Count Detail 
view.

Cycle Count Scan 
Barcodes

Clear ■ Clears fields.

■ Performs an undo operation for cases in which a 
cycle count record was created as a result of the 
scan.

Table 5. Button Functionality 

Screen View Button Button Functionality
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About Toolbars in Handheld
This section describes how to configure the toolbar for your application.

Table 6 shows the supported toolbar functions.

The default toolbar can be configured in Siebel Tools by configuring the SHCE Main toolbar object. 
SHCE Main is the main toolbar that is downloaded to the handheld device. If a toolbar named SHCE 
Main does not exist in your repository, a default toolbar, Main, is downloaded instead.

The SHCE Main toolbar contains the default buttons for the device: Back, Forward, New Record, New 
Query, and Execute Query. Change the order of the buttons on the display by modifying the Position 
property of the toolbar items. Remove a toolbar button by deleting it or making it inactive.

You can add additional default buttons to the toolbar by creating toolbar items whose Command 
property matches the name of an active bitmap in the SHCE Command Icons bitmap category. Do 
not add bitmaps to the SHCE Command Icons bitmap category because only those commands, which 
are already provided, are supported on the device. No additional commands are supported. You can 
remove a bitmap or make a bitmap inactive if you do not want it to appear in the Customize Toolbar 
dialog box.

You can change the bitmap for a toolbar by reimporting the bitmap from the SHCE Command Icons 
bitmap category.

An end user can personalize the toolbar by selecting View > Toolbar.

For more information on toolbars, refer to Configuring Siebel eBusiness Applications.

About the Status Bar in Handheld
The status bar is located above the toolbar. The status bar displays the status of an applet with focus, 
including the applet title and record item count (for example, Contacts: 1 of 13).

Table 6. Supported Toolbar Functions

Toolbar Functions

Back, Forward

New Record

New Query, Execute Query

Next Record, Previous Record, First Record, Last Record

Minimize/Maximize

Delete Record
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About Hyperlinks in Handheld
Configuring a drilldown, or clicking a hyperlink or dynamic hyperlink in the Siebel Handheld Client, 
is performed the same way as with other Siebel clients. For more information on configuring 
drilldowns, see Configuring Siebel eBusiness Applications.

Preventing Synchronization Conflicts 
with Siebel Handheld
Because multiple users are synchronizing with the server, conflicts may occur when any single user 
synchronizes his handheld. For more information on how to configure your application to prevent 
synchronization conflicts, see Chapter 7, �Synchronization Conflict Handling and Recovery with 
Handheld.�

Recommended Configuration Guidelines 
for Siebel Handheld
The Siebel Handheld Client application performs best if you use the following guidelines: 

■ Keep the number of views in your application to 30 or fewer.

■ For optimal usability, limit each view to one or two applets.

■ To minimize horizontal scrolling, limit the number of columns displayed in a list applet to no more 
than ten.

■ There is no limit on the number of fields in form applets of single-applet views. However, to 
minimize scrolling, keep the number of fields to 20 or fewer.

■ For each screen, create a view called My * or All * as a single list-applet view. For example, for 
the Activities screen, create a My Contacts view that has the Contacts list applet only.

■ For each screen, create a single-applet More Info view. Create this applet as a form applet. For 
example, for the Contacts screen, create a More Info view that has the Contacts form applet only.

■ Use a form applet for the parent for each parent-child view.

■ In a multi-applet view, limit the number of fields in form applets to five or fewer. Add additional 
fields only if the field width is short�for example a check box field. Reduce the number of fields 
if the fields are multiline�for example, a Comments box that contains three lines of text.

■ Do not include read-only check boxes in form applets. It is very difficult for users to discern that 
the check box is not editable.

■ Limit the number of views within a screen to 12 or fewer so that the View drop-down list is not 
too long and unwieldy.

■ Limit the number of screens to six or fewer so that the Screen drop-down list is not too long and 
unwieldy.
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■ Keep query names to about 15 characters or fewer, so that they fit in the Queries drop-down list. 
For example, North American Organization is too long for a query name, so you should change 
it to a shorter name, such as N. American Org. The number of characters is a general guide 
because characters vary in width (for example, W is wider than i).

■ Keep screen names to about 15 characters or fewer, so that they fit in the Screen drop-down list. 
The number of characters is a general guide because characters vary in width.

■ Keep view names to about 30 characters or fewer so that they fit in the View drop-down list. The 
number of characters is a general guide because characters vary in width.

■ Limit the size of the dbfile.txt file to less than two megabytes (MB). The RDBMS on the handheld 
device is approximately three times the size of dbfile.txt. If the data files are so large that they 
cannot be imported into the database with the available memory, users cannot successfully 
synchronize their data. 

Compiling the Siebel Handheld 
Application
Compiling the repository for the Siebel Handheld Client is identical to compiling on the Siebel Web 
Client Using Siebel Tools. Perform a full compilation the first time; subsequent compilations can be 
incremental, replacing only the projects that are affected. This assumes that you have organized all 
of your handheld object definitions in one project or a limited set of projects.

When you compile your application, a Siebel repository file (.srf) is created and put in the destination 
directory you specified during the compile procedure. Make this .srf file the source of repository 
information for the Siebel Handheld test client machine, defining all Siebel applications for that 
client, when you move it to your local \Siebel\objects directory.

It is strongly recommended that you make a backup of the existing .srf file in your local 
\Siebel\objects directory before overwriting it with the new one. That way, if you make an error or 
you want to revert to the original application, you have a backup that you can easily restore. For 
more information, see Using Siebel Tools.

Configuring Printing from the Siebel 
Handheld Application
Users may print from any view in the application. However, they are not necessarily printing what 
they see on their screen. They may print a portion of the data they view or data that is not viewable 
at the time. 

A print template defines the document that is to be printed. After the template has been defined, it 
must be associated with an applet in a view.

This section provides information on the following topics:

■ Defining documents

■ Designing print applets
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■ Configuring applets for printing

■ Creating print buttons

■ Creating print templates

Defining Documents for Handheld
Defining documents for printing includes several steps:

■ Determine the documents your users need to print.

■ Determine the views from which they are most likely to print the documents.

■ Lay out the document for printing.

Determining which documents users will need and the views from which they are most likely to print 
requires that you have a good understanding of the users� day-to-day work.

Whether the existing applets in a view include most of the required data or only a small portion is a 
secondary consideration. It is not likely that a printout of the existing applets, which are formatted 
for an electronic PDA interface, will provide an acceptable or usable printed document. In most 
instances, you need to create additional applets that are specifically used for printing data.

The printed document will be composed of several applets which are added to the view. The applets 
pull the data from the underlying business components. These applets, in turn, direct the data to the 
print templates discussed in Appendix D, �Print Tagging Language.�

Designing Print Applets for Handheld
The print template references applets associated with the view and is how you specify what data 
appears in the printed document. For information on print templates, see �Creating Print Templates 
for the Handheld Application� on page 35. As you design your applets, you should be aware of the print 
specifications of the printers used in the field. Portable printers typically print on two-inch or 
four-inch wide paper. You need to design your applets so that the data fits within the limits of the 
paper width. Keep your documents simple so that they work with different sizes of paper. The 
following are some guidelines to use when designing your applets to accommodate the smaller paper 
sizes.

Form Applets 
Data from only one business component can be displayed on each line in your document. When you 
design your form applets, keep in mind that you can display a maximum of two columns of data in 
form applets. You can specify that each column of data is preceded by an optional caption column. 
This means you can have up to four columns displayed in your document�two data columns and two 
caption columns. Alternatively, you may have no captions, and simply display one or two columns of 
data.

The ratio between caption and data columns is, respectively, 35 percent and 65 percent. This is a 
fixed relationship that cannot be customized in the template.
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List Applets 
When specifying the width of a column, you can either specify it with a unit of measurement or as a 
percentage of the total page width. For example, you can specify that the first column is 20 mm, and 
the second column is 40 mm. If the width of the paper you print to is narrower than 60 mm, the 
column widths automatically adjust to fit the printable width as a proportion of the specified width. 
Therefore, the first column will always be 33 percent, and the second column will be 67 percent of 
the paper width. The minimum width for a column is 8 mm, which includes a 3 mm gutter margin 
between columns.

You can specify any number of columns in your list applet. However, if the width of the column is less 
than 8 mm, the application ignores the column and does not print it.

On narrow paper widths, data from a field may not all fit on one line. Data that does not fit can be 
specified, in the Applet tag, to wrap to the next line and keep wrapping until the data in that field is 
completely displayed. The printable width of the page is equal to the paper width minus the left and 
right margins (PaperWidth � [LeftMargin + RightMargin]). These parameters are set in the setup.ini 
file. For more information on setting these parameters, see Appendix E, �Print Configuration Settings.�

Configuring Applets for Printing for the Handheld 
Application
Configure print applets as you would any other applet using Siebel Tools. In addition, set the 
following properties for each applet in the view.

■ Set the HTML Popup Dimension value to 0x0. 

The 0x0 setting hides the applet from the end user who should not see the applet that is used to 
generate the document. Exposing these applets would complicate a product that is tightly 
configured for an effective and efficient workflow on a small mobile device.

NOTE: For compatibility with previous versions, Siebel Systems continues to support the name, 
Popup Dimension, for this property. However, it is recommended that you use HTML Popup 
Dimension.

■ Set the name of the Mail Template to be the name of the print template file. For more information 
on the print template file, see �Creating Print Templates for the Handheld Application� on page 35. 
For more information on the Mail Template property, see �Views with Associated Print Templates 
or Reports� on page 23.

Configuring Print Buttons for the Handheld Application
While users can use the File > Print menu option to print a document, it is helpful to include a Print 
button on the applet to give users a visual reminder that it is possible to print from a particular view.

When you design your applets, keep the following in mind when deciding where to place the print 
button:
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■ Add the print button to the applet that is visible to the user. Do not add the print button to the 
print applet, which the user never sees.

■ Consider what the desired behavior is when determining the placement of a print button. 

For example, in a parent-child view, you may want to add the print button to the parent applet 
to ensure that the print button is always enabled. This is not necessarily true if the print button 
is placed on the child list applet. If there are no items in the list applet, the print button is 
disabled, and the end user cannot print from that view. If you only want the end user to print 
when there are list items, then placing the button on the child list applet is appropriate.

To configure a print button

1 From Siebel Tools, add a control to the print applet and specify HTML Type = Button.

2 Set Method Invoked = Print.

3 Set the Display Name property of the button. Generally, this is set to Print.

Creating Print Templates for the Handheld Application
Once you have identified and created the necessary views, you are ready to create print templates. 
A print template is a text file that includes instructions for printing a document. It specifies the data 
to be printed, document layout options, and text formatting. These instructions are specified using 
a print tagging language that is described in Appendix D, �Print Tagging Language.�

Configuring Business Object Filters in 
Siebel Handheld
You must configure the Business Object Filters for the Handheld application. These filters affect how 
data is synchronized between the handheld device and the Siebel database. For information about 
configuring the default Business Object Filters, see �Setting Business Object Filters for Siebel Handheld 
Users� on page 43. 

Enabling Signature Capture in Siebel 
Handheld
You can enable any handheld view to launch and capture signatures from a customer. The views are 
able to capture multiple signatures from within any view. Signatures are converted to an ASCII text 
format and stored with the Siebel database as ASCII text. Signatures can also be optionally encoded 
so as to prevent use of the signature outside of the context in which the signature was captured. The 
header is configurable allowing you to display any literal value, field value or calculated field value.

The signature field can be configured to show information such as disclaimers and, optionally, the 
date and time a signature is being captured. 
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At the bottom of the signature dialog box are 3 buttons. These buttons are described in Table 7:

Signature Capture Applet Control User Properties
There are 17 customizable applet level user properties that control various elements of signature 
capture. Most of these user properties are optional except for one user property that is required to 
pop up the signature dialog. This user property is named, "Signature." Setting this property to "Y" 
(yes) will enable the signature control to pop the signature dialog.

Table 8 lists the Applet control user properties to control the display of signature control. 

Table 7. Signature Capture screen buttons

Button Description

Accept Tap this button to commit the signature to the database.

Clear Tap this button to reset and clear the signature field.

Cancel Tap this button to discard the signature, closet the signature 
dialog box and return to the view that first invoked the 
signature dialog box. 

Table 8. Signature Capture Applet Control User Properties

User Property Description

SignatureDataField Field to save and fetch signature data.

NOTE: This field can be a calculated field.

SignatureHeaderField Field to fetch signature header data.

NOTE: This field can be a calculated field.

SignatureFooterField Field to fetch signature footer data.

SignatureHeaderSaveField Field to save the signature header data.

SignatureFooterSaveField Field to save the signature footer data.

MaximumHeaderLines Maximum number of text lines to display header.

MaximumFooterLines Maximum number of text lines to display footer.

SignatureHeight Height of signature capture control. The default value is 80 
pixels. Maximum value is 200 pixels.

SignatureDate �Y� appends a date to the end of the footer.

SignatureTime �Y� appends a time to the end of a footer and date.

Signature �Y� enables a signature control for the field.

ShowData �Y� enables redisplay of signature data.

EncryptKey Encryption string for storing and reading signatures.
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Testing the Siebel Handheld Application
Before deploying your application to your end users, be sure to thoroughly test the application by 
synchronizing to a handheld device. The handheld configuration is downloaded to the device where 
you can test the functionality and verify that you have the desired behavior. Another equally 
important aspect of handheld testing is to check to see how much data is downloaded to the device. 
If too many records are downloaded, this increases the length of time it takes to synchronize the 
handheld and slows down the application performance. Check the server log file to see how many 
records are downloaded for each business component. You must set the LoggingLevels parameter to 
25555 to capture this information in the log file. 

For more information on the LoggingLevels parameter, see �Configuring Server Logging Levels� on 
page 80. For more information on the server log files, see �Direct Server Sync Log Files� on page 173 
and �Companion Sync Log Files� on page 174. 

WritingGuide Defines appearance of the writing guide within the signature 
control.

InkColor Color of the ink used to display signatures.

InkWidth Width of ink writer.

BorderStyle Defines border style.

Table 8. Signature Capture Applet Control User Properties

User Property Description
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4 Application Administration
This chapter includes the following topics:

■ �Overview of Siebel Handheld Administration Screens� on page 39

■ �Setting Up Users in Siebel Handheld� on page 41

■ �Assigning User Responsibilities to Siebel Handheld Users� on page 41

■ �Administering Siebel Handheld Views� on page 41

■ �Setting Business Component Filters for Siebel Handheld Users� on page 42

■ �Setting Business Object Filters for Siebel Handheld Users� on page 43

■ �Administering Barcode Settings for Siebel Medical Handheld� on page 44

■ �About Monitoring Synchronization Sessions for Siebel Handheld� on page 50

■ �Monitoring Synchronization Sessions for Siebel Handheld� on page 50

■ �Obtaining Error Details from Siebel Handheld Synchronization Sessions� on page 51

■ �Obtaining Business Component Information from Siebel Handheld Synchronization Conflicts� on 
page 51

■ �Obtaining an Audit Trail for Siebel Handheld Synchronization Sessions� on page 51

■ �Acting Upon Synchronization Errors in Siebel Handheld� on page 52

■ �Administering Server Components for Siebel Handheld� on page 52

■ �Administering Siebel Medical Handheld� on page 53

■ �Administering Products for Siebel Medical Handheld� on page 57

■ �Capturing Product Hierarchies for Siebel Medical Handheld� on page 59

Overview of Siebel Handheld 
Administration Screens
You Administer Siebel Handheld from a number of administration screens. You access the 
administration screens from the Site Map on the Siebel Mobile Web Client, and you access the Siebel 
server from the Siebel Connected Web Client. 

The chapter is designed to show you how to administer Siebel Handheld. Key tasks are outlined that 
you can perform using the Mobile Administration screens. Your organization may follow a different 
task sequence according to its business requirements.

Following is a list of Administration screens you use when administering your handheld applications. 
You access these through either the Siebel Mobile Web Client, or through a direct server 
synchronization.
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■ Application Administration: This screen lists all the handheld applications available within 
your enterprise. From this view you can create new application settings and administer settings 
that have already been created. The following views are used by the synchronization engine to 
extract application definition and user data.

■ Business Component Filters: This view contains the synchronization filter settings for 
business components. If you wish to make other business components visible to your users, 
you change filter settings in this view. 

■ Business Object Filters: This view is where you define data which is downloaded to the 
Handheld client upon synchronization.

■ Settings: This view allows you to define parameter settings for your application. 

■ Barcode Administration: This screen allows you to create new barcode definitions for your 
handheld applications.

■ Barcode Enabling: This screen allows you to set which views in the Siebel Handheld application 
are enabled for barcode scanning.

■ Conflict Administration: This screen allows you access to all data conflict information created 
by handheld users who synchronize directly to the server. You can take action on particular 
conflicts and review audit trail information of all conflicts. 

■ Audit Trail: This view, when enabled, allow you to obtain information about action taken on 
a particular data conflict. 

■ Business Component Detail: This setting allows you to see business component 
information associated with a particular data conflict. 

■ Error Details: This view allows you to get detailed information about specific data conflicts. 
You are also able to take particular action about any given conflict. 

■ Field Value: This view shows the details of a conflict. This provides a more detailed view 
than the Error Details view. 

■ Server Component Administration: This screen allows you to manage server-level settings 
for synchronization components. These settings are used by the synchronization engine to 
extract application definition and user data. 

■ Session Administration: This screen contains a detailed information about user 
synchronization sessions. Use this view to monitor and investigate handheld user 
synchronization activities. 

■ User Administration: This screen allows you to manage user-specific settings, such as business 
object and business components filters, that filter the data that display to the user. The data sets 
contained in these user screens are used by the synchronization engine to extract application 
definitions and user data. The Siebel Handheld application is populated by these data when the 
user performs synchronization.

■ User Business Component Filters: This setting contains user-specific sync filter directives 
for business components. 

■ User Business Object Filters: These settings contain user-specific queries for business 
objects. In this setting, you define a data set that is downloaded, at the time of sync, to the 
Handheld client. 
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■ User Settings: This setting allows you to control user-specific settings which override 
component and application settings.

Setting Up Users in Siebel Handheld 
To set up users on a Siebel Handheld application, perform the following tasks: 

■ �Assigning User Responsibilities to Siebel Handheld Users� on page 41

■ �Administering Siebel Handheld Views� on page 41

■ �Setting Business Component Filters for Siebel Handheld Users� on page 42

■ �Setting Business Object Filters for Siebel Handheld Users� on page 43

Assigning User Responsibilities to Siebel 
Handheld Users
You must create user accounts and assign responsibilities and passwords for each handheld user. The 
steps are the same as those for creating user accounts, assigning responsibilities and passwords for 
the Siebel Web Client. See Applications Administration Guide for more information on this topic.

Administering Siebel Handheld Views
There are two administrative tasks associated with handheld views:

■ If you have added a new view or changed the name of a view, you must add the view or update 
the name of the view in the Application Administration screen.

■ Add the default views in the Application Administration screens.

Adding Views to the Handheld Application
You add new views to the Siebel Handheld application from the Application Administration screen in 
any Siebel Web Client application. You must be logged on as an administrator. (If you are using the 
Siebel Mobile Web Client to log in as an administrator, you must also specify the /editseeddata 
parameter.)

To add new views to Siebel Handheld

1 Launch the Web Client application that uses the same database which the Siebel Handheld 
application will synchronize to (or will use to synchronize to).

NOTE: If you launch the application from a mobile Web client, specify the 
/editseeddata parameter.

2 Choose Navigate > Site Map > Application Administration> Views.
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3 Add the new views.

4 In the Responsibilities view, associate each view with the appropriate handheld responsibility.

5 Add appropriate users to the responsibility.

NOTE: For more detailed instructions on adding views and associating views with 
responsibilities, see Applications Administration Guide.

Specifying Views for the Handheld Application
The Siebel Handheld application uses a small subset of views in the Siebel enterprise application. 
Because there are memory resource constraints on the handheld devices, it is recommended that 
you extract only those views that are used on the handheld.

There are two methods for specifying which views are extracted to the handheld. The first method 
is to compile an .srf of only those views that are relevant to the Siebel Handheld application. Or, 
alternatively, you may specify the handheld views in Administration-Mobile > Settings view. 

The views are specified in the Administration-Mobile > Settings view. By default, all views for the 
Siebel Handheld application are listed here. Edit the list so that only those views which your 
application is using appear in the list. 

The combination of the .srf file, the specified settings in the Settings view, and the user's 
responsibility determines which views are extracted. Siebel Server uses the information in the 
Settings view and the .srf file during synchronization in the following way:

■ If no default views are specified, all the views in the .srf are extracted during synchronization. If 
the .srf contains only the handheld-specific views, then this is the same as listing each handheld 
view in the handheld configuration file.

■ If default views are specified Application-Administration > Settings view, then only those views 
are extracted. If there are some views that do not match the views in the .srf file, these are 
ignored.

■ If default views are specified in the Application-Administration > Settings view, but none of the 
views match those listed in the .srf file, then all the views in the .srf are extracted.

Setting Business Component Filters for 
Siebel Handheld Users
The Business Components View in the Application Administration screen contains the sync filter 
settings for business components. If you wish to add or remove business component filter settings 
for users, you do so in this view. 

To add a business component filter setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > 
Application Administration. 
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2 In the Application Administration screen, select the appropriate application, then click the 
Business Component view tab.

3 Click New, then enter the required information. 

Some fields in the Business Component view are described in the following table: 

To remove a business component filter setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > 
Application Administration. 

2 In the Application Administration screen, select the appropriate application, then click the 
Business Component Filters view tab.

3 Select the filter setting record wish to remove. 

4 From the Business Component Filters menu, choose Delete Record. 

Setting Business Object Filters for Siebel 
Handheld Users
The Business Components View in the Application Administration screen contains the sync filter 
settings for business objects. If you wish to add or remove business object filter settings for users, 
you do so in this view.

To add a business object filter setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile. 

2 In the Application Administration screen, select the appropriate application, and then click the 
Business Object Filters view tab.

3 Click New, and then enter the required information. 

Field Comments

Owner A text box. Enter the Handheld application to which the 
business component will be associated. For example, Siebel 
<Application name> for CE.

Business Component A text box. Enter the business component name. For 
example, Period.

Name A text box. Enter the business component filter name. For 
example, Filter 1.

Query A text box. Enter the syntax for the query. For example, 
[Start Date] <=Today()
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4 The fields in the Business Object Filters view are described in the following table: 

To remove a business object filter setting

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > 
Application Administration. 

2 In the Application Administration screen, select the appropriate application, and then click the 
Business Object Filters view tab.

3 Select the filter setting record wish to remove. 

4 From the Business Object Filters menu, choose Delete Record. 

Administering Barcode Settings for 
Siebel Medical Handheld
By default Siebel Medical Handheld can scan and parse data from HIBC and UCC/EAN barcodes. 
However, Siebel Administrators can set up Siebel Medical Handheld to scan and parse any 1-
dimensional barcode. To do this, Siebel Administrators would need to define the barcodes and how 
data will be parsed from these barcodes in the Barcode Administration views. 

About the Barcode Parsing Algorithm Used in Siebel 
Medical Handheld
Barcode readers are like any other input device. The reader takes a barcode and converts it to a set 
of characters. Siebel Medical Handheld utilizes a specialized barcode class which defines the 
algorithm used to parse and automatically validate data from these converted characters. Out of the 
box, Siebel Medical Handheld can parse data from HIBC and UCC/EAN barcodes but Siebel 
Administrators can easily define new one-dimensional (1D) barcodes in the Barcode Administrations 
views.

Field Comments

Owner A text box. Enter the Handheld application to which the 
business component will be associated. For example, Siebel 
<Application Name> for CE.

Default Check the box to allow the filter to work by default. 

Business Object A text box. Enter the business object name. For example, 
Account.

Name A text box. Enter the business object filter name. For 
example, BOFilter 1.

Query A text box. Enter the syntax for the query. For example, All.
Siebel Medical Handheld Guide Version 7.744 ■



Application Administration ■  Administering Barcode Settings for Siebel Medical Handheld
It is therefore important to understand how Siebel's barcode algorithm will use data defined in the 
Barcode Administration View to parse information from the barcode. Table 9 defines these applets as 
well as the underlying business component and tables on which they are based.

SHCE Barcode Item is a child of SHCE Barcode. Thus, for each record in S_Barcode table there are 
many child records in the S_Barcode_Item table. 

The barcode parsing algorithm uses barcode definitions in the Barcode Applet to identify the barcode. 
It uses the values specified in the Prefix, Min Length, and Max Length fields to find a match. Once it 
finds a match, it will determine the corresponding values in the Barcode Type and Separator (Ascii 
#) fields. It will then use this information to parse data from the barcode into property sets as 
defined in Barcode Item Applet.

The Barcode Type and Separator (Ascii #) fields determine how the child records in the Barcode Item 
applet will be used to parse data from the barcode. 

There are only two types of barcodes. Table 10 describes the type of barcodes standards.

The Separator (Ascii #) field defines the Ascii character that will be used to separate data elements 
if there is more than one element that is variable (for example, there is more than one record where 
Min Length is not equal to Max Length in the Barcode Item Applet).

The table below provides examples of how the barcode parsing algorithm will use data in the Barcode 
Administration views to parse data from Location-based barcode and a Code-Based barcode:

Table 9. Barcode Applets

Applet
Business 
Component Table Description

Barcode SHCE Barcode S_Barcode Lists barcode defined for Siebel Medical 
Handheld.

Barcode Item SHCE Barcode 
Item

S_Barcode_Item Lists data that will be parsed from the 
barcode.

Table 10. Types of Barcodes

Barcode Type Description Example

Location Barcode standards which always 
contact same data elements in the 
same order.

HIBC

Code Barcode standards which contain 
different element in any order. 
Data elements are preceded by a 
code.

UCC/EAN
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Example of Location Barcode Type
Table 11 provides an example of the Location Barcode type. 

Location Barcode Type: HIBC +$$3061211220152LC

Data is parsed based on the child records in the Barcode Item Applet. Since Barcode Type = Location, 
the parsing algorithm used the sequence listed in Table 12 to parse data from the barcode.

Thus the relevant data that will be parsed from this barcode is as follows:

■ Expiry Data = Dec 11, 2006

■ Serial Number = 12201

■ Lot Number = 52

Example of Code Barcode Type
Table 13 provides an example of the Code Barcode type.

Table 11. Matching Record in Barcode Applet

Name Sequence Min Length
Max 
Length Prefix Type

Separator 
(ASCII #)

Medical 
HIBC

Secondary

+$$3

8 16 24 +$$3 Location

Table 12. Child Records in Barcode Items Applet

Name Sequence Min Length
Max 
Length

Data 
Desc

Data 
Format

Output: Data 
Parsed from 
Barcode

Plus 1 4 4 Plus +$$3

Expiry 
Date

2 6 6 Expiry 
Date

YYMMDD 061211

Serial 
Number

3 5 5 Serial 
Number

12201

Lot 
Number

4 0 8 Lot 
Number

52

LC 5 1 1 LC L

CC 6 1 1 CC C
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Code Barcode Type: UCC/ EAN ^17040606106654355^2111202^3050

Data Parsed Based on Child Records in Barcode Item Applet. Since Barcode Type = Code and 
Separator (Ascii#) = 29 (corresponds to ^), the parsing algorithm used the Code and Sequence to 
parse data from the barcode, and used the ^ character to distinguish variable data elements.

NOTE: The child records displayed in this table represent only a subset of all Barcode Item child 
records for Medical UCC/EAN Primary. These represent the child records that have a match in the 
barcode that we are trying to parse.

Thus the relevant data that will parsed from this barcode is as follows:

■ Lot Number = 6654355

■ Expiry Date = June 6, 2004

■ Serial Number = 11202

Table 13. Matching Record in Barcode Applet

Name Sequence Min Length
Max 
Length Prefix Type

Separator 
(ASCII #)

Medical 
UCC/EAN 
Primary

31 16 17 01 Code 29

Table 14. Child Records in Barcode Items Applet

Name Code Sequence Min Length
Max 
Length

Data 
Desc

Data 
Format

Output: 
Data 
Parsed 
from 
Barcode

Code 17 17 1 2 2 Code 17 17

Expiry 
Date

17 2 6 6 Expiry 
Date

YYMMDD 040606

Code 10 10 1 2 2 Code 10 10

Lot 
Number

10 2 1 20 Lot 
Number

6654355

Code 21 21 1 2 2 Code 21 21

Serial 
Number

21 2 1 20 Serial 
Number

11202

Code 30 30 1 2 2 Code 30 30

Quantity 30 2 1 8 Quantity 50
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■ Quantity = 50

Creating New Barcode Definitions for the Handheld 
Application
You can define new one-dimensional barcodes in the Barcode Administration views. To define a new 
barcode, you would need to create a new barcode definition in the Barcode screen, then create 
corresponding records in the Barcode Item view to define data elements within the barcode. 

To create a new barcode definition

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Barcode 
Administration.

2 Click New, then fill in the fields. 

The fields in the Barcodes list are described in the following table: 

3 In the Barcode Item view, add new records to identify how data will be parsed from barcode.

Depending on the type of barcode standard you just defined (either Location or Code), you then 
need to create new records in the Barcode Item Applet to identify how data will parse into 
property sets.

Field Comments

Name Required. Any descriptive name for the barcode. Must be 
unique for all records defined in the Barcode screen.

Sequence Required. Order in which to parse a barcode.

Barcode Type Required. Type of Barcode Standard. Can either be 
Location or Code. For details on Location and Code barcode 
types, see �Administering Barcode Settings for Siebel Medical 
Handheld� on page 44.

Buscomp Required. Used to designate which business component the 
target data is be placed into.

Min Length Used to determine a minimum number, in digits, for data 
scanned. If data is of a fixed, minimum length is equal to 
maximum length. 

Max Length Used to determine a maximum number, in digits, for data 
scanned. If data is of a fixed, maximum length, enter a 
number which stands for the number of digits. 

Prefix Required. Defines the value that the parsing algorithm will 
use to identify barcode definition to use.

Suffix Optional. Allows you to associate suffixes with individual 
fields.
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4 In the Barcode Item applet, Click New, then update the required fields.

Some of the fields are described in the following table:

Enabling Applications Views for Barcode Scanning
You can enable any existing or new view for barcode scanning.

NOTE: You need to edit the user properties for the view applet's underlying business component. 
See Appendix C, �User Properties� for details on how to edit the Barcode Fields user property.

To enable an application view for barcode scanning

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Barcode 
Enabling.

2 Click New, then enter the necessary information. 

The fields in the Barcodes list are described in the following table: 

Field Comments

Name Required. Used by algorithm to identify what field to parse 
this data into (for example Lot Number, corresponds to Lot 
Number field).

Code Applicable for Code barcodes only. The number that 
precedes a data element in a barcode.

Sequence Required. For Code barcodes, once code has been 
matched, this corresponds to sequence used to parse data 
from barcodes for that data element. For Location 
barcodes, this corresponds to sequence used to parse data 
from barcodes.

Min Length Required. Minimum Length of the character string for this 
data element. If this is a variable length string, then 
Minimum Length is not equal to Maximum Length. 

Max Length Required. Maximum Length of the character string for this 
data element. If this is a variable length string, then 
Minimum Length is not equal to Maximum Length. 

Data Format Optional. Defines format for data element (for example for 
date, MMDDYY).

Field Comments

View The view in the handheld device from which the scan 
occurs.

Applet The applet within the view.
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About Monitoring Synchronization 
Sessions for Siebel Handheld
You monitor Handheld application synchronization sessions and synchronization conflicts from a 
number of screens within the Siebel Mobile Web Client, or if you are using DSS or DSSvP you do so 
directly on the Siebel server. Every time a user synchronizes with the server, a record is made. 

The following topics relate to synchronization monitoring. 

■ �Monitoring Synchronization Sessions for Siebel Handheld� on page 50

■ �Obtaining Error Details from Siebel Handheld Synchronization Sessions� on page 51

■ �Obtaining Business Component Information from Siebel Handheld Synchronization Conflicts� on 
page 51

■ �Obtaining an Audit Trail for Siebel Handheld Synchronization Sessions� on page 51

■ �Acting Upon Synchronization Errors in Siebel Handheld� on page 52

Monitoring Synchronization Sessions for 
Siebel Handheld
The Session Administration > Sync Status screen allows you to gather all data related to each sync 
session a user performs. The Sync Status screen contains two views: the Sync Sessions view, and 
the Extraction Info view. These views allow you to do the following:

■ Sync Status Screen: Allows you to monitor each user sync session, and includes such data as: 
sync status, the date, type of sync and so on. 

■ Sync Sessions View: Allows you to gather further information on the status of each sync session, 
including conflicts during the sync, the size of the data extracted, and so on.

■ Extraction Info View: Allows you a detailed look at all data extracted during the sync session, 
including business component information, the number of records extracted, the filters applied 
and so on. 

To monitor synchronization sessions

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Session 
Administration. 

The Sync Status screen appears, with two subordinate views, Sync Sessions and Extraction Info.

Buscomp The business component from which the information is be 
drawn.

Buscomp Field The specific field within the business component.

Field Comments
Siebel Medical Handheld Guide Version 7.750 ■



Application Administration ■  Obtaining Error Details from Siebel Handheld
Synchronization Sessions
Obtaining Error Details from Siebel 
Handheld Synchronization Sessions
This setting allows you to obtain details of sync errors that occur during individual sync sessions. 

To obtain synchronization error details

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Conflict 
Administration. 

The Transactions screen appears.

2 In the Transactions screen, select the appropriate record, and then click the Error Details view 
tab.

3 In the Error Details list, select or query for the desired record. 

Obtaining Business Component 
Information from Siebel Handheld 
Synchronization Conflicts
The Transactions view on the Conflict Administration screen allows you to obtain business component 
information related to synchronization errors that occur during individual sync sessions. 

To obtain business component error details

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Conflict 
Administration. 

The Transactions screen appears.

2 In the Transactions screen, select the appropriate record, and then click the Business 
Components view tab.

Obtaining an Audit Trail for Siebel 
Handheld Synchronization Sessions
The Transactions view on the Conflict Administration screen allows you to obtain audit trail 
information for an action that was taken against a particular transaction. 

To obtain synchronization error details

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Conflict 
Administration. 

The Transactions screen appears.
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2 In the Transactions screen, select the appropriate record, and then click the Audit view tab.

Acting Upon Synchronization Errors in 
Siebel Handheld
Upon reviewing a synchronization error, you can act upon it by performing one of three different 
actions. 

To act upon handheld sync transaction errors

1 From the application-level menu, select Navigate > Site Map > Administration-Mobile > Conflict 
Administration.

The Transactions list appears. The transaction buttons are described in the following table:

2 Click either Reapply, Export, or Ignore depending on your needs.

Administering Server Components for 
Siebel Handheld
You administer server components from the Administration-Mobile > Server Component screen. The 
component displayed is based on the application selected in the Application Administration view. The 
Server Component Administration screen is used for overriding application settings at the component 
level on a specific server. This screen is where you define server level settings, which override 
settings defined at the application level. The data entered here is used by the synchronization engine 
when the user synchronizes with the server. 

The Server Component screen contains a list of server components associated with the application 
that was selected in the Application Administration screen. For each server component, the Settings 
view details the associated settings. 

Action Result

Reapply Reapplies the selected transaction with values listed in the 
view (or Field Value view).

Export Exports the content of the transaction into a text file.

Ignore Accepts the current status and does not act upon the error.
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Administering Siebel Medical Handheld
The following section details administration procedures associated with the Siebel Medical Handheld. 
Note that this may be a subset of the administrative procedures that are required for your total 
solution. This section details administrative procedures as they relate to Siebel Medical Handheld. 
Please refer to Siebel Life Sciences Guide for a more comprehensive set of administration 
procedures.

Scenario for Administering Siebel Medical Handheld
This section outlines an example process performed by a Siebel Administrator and end users. Your 
company may follow a different process according to its business requirements.

A medical device company would like to track a product for consignment inventory management. The 
Administrator has already defined the product in the system so would just need to define how this 
product is going to be managed for consignment inventory. He uses the capture hierarchy command 
to update the product hierarchy so that sales representatives are able to view hierarchical results 
when analyzing inventory using the handheld. He then recreates the product hierarchy for each 
inventory location where these products are being kept and defines consignment levels at that 
inventory location. For some products, he is required to record inventory that was sent to an 
inventory location or to a sales representative. He then assigns cycle counts to sales representatives.

Key tasks in Administering Siebel Medical Handheld are:
■ Administering products for consignment inventory management

■ Capturing product hierarchy

■ Managing Inventory Locations

■ Recreating product hierarchies in Inventory Locations

■ Setting Consignment Levels for Inventory

■ Creating Assets 

■ Recording Inventory Movement 

■ Viewing signatures for Approval-required moves

■ Assigning Cycle Counts
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About Product Hierarchies
A product hierarchy is a grouping of products. It is a way to track relationships between products, 
product groups or product classes. A product hierarchy is similar to a family tree on which you have 
a root parent product, parents and child products, and leaf-level products. Your company can track 
many product hierarchies for a certain inventory location. An example of one product hierarchy is 
shown in Figure 1:

In this product hierarchy, Product A is the root parent. Product A is the parent product of Product B 
and Product C. Product B and Product C are child products of Product A. Product B in turn is the 
parent product of Product D and Product E. Product D and Product E are child products of Product B. 
Product D, Product E and Product C are all leaf-level products.

With Medical Handheld, users are able to view detailed inventory and usage information for all 
products in a product hierarchy in a hierarchical manner. By navigating to the product hierarchy 
views, users can see aggregated product information on: inventory, current and historical average 
usage. You can set up what level in the product hierarchy is shown in the handheld.

About Products, Assets and Inventory Transactions
Assets are physical instances of a product. Depending on how you administer a product, Medical 
Handheld keeps track of assets differently. For example, products that are not serialized, not unique, 
and are not tracked by lot number are simply tracked by product. When counting these products, 
assets are not created in the assets table nor associated to a product during a cycle count. On the 
other hand, products that are serialized require creation (if there are no asset records) of asset 
records in the assets table and association to this product during a cycle count. During an inventory 
count, transactions are created to adjust inventory information.

You would need to determine how your company would like to track products for consignment 
inventory. Depending on how you define your products, the handheld generates transactions 
automatically to create an asset record in the assets table, associate these assets to the product, or 
adjust inventory transactions to update inventory information when a cycle count is performed. 
These transactions update inventory information on the server during sync. 

Figure 1. Product Hierarchy
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Table 15 summarizes how cycle count records are generated by the handheld when a sales 
representative performs a cycle count.

Table 15. Cycle Count Records Overview

Product 
Serialized?

Product Track by 
Lot #?

Product 
Unique?

Product and Asset Tracking During a 
Cycle Count?

Yes Not Applicable Not Applicable Check whether asset already exists in the 
assets table.

If asset does not exist, create a new asset 
and associate the asset with the product 
for the cycle count being performed. If the 
product has not been counted, create a 
new detail record on this product, and 
associate the asset with this product.

If asset already exists, associate this asset 
with the product for the cycle count being 
performed. If the product has not been 
counted, create a new detail record on this 
product, and associate the asset with this 
product.

No Not Applicable Yes Check whether asset already exists in the 
assets table.

If asset does not exist, create a new asset 
and associate the asset with the product 
for the cycle count being performed. If the 
product has not been counted, create a 
new detail record on this product, and 
associate the asset with this product.

If asset already exists, associate this asset 
with the product for the cycle count being 
performed. If the product has not been 
counted, create a new detail record on this 
product, and associate the asset with this 
product.
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NOTE: The main difference between Serialized and Unique products is how uniqueness of the assets 
is defined. Serialized products have more business rules associated with them. Unique products are 
like Serialized products but do not have business rules associated with them, allowing a lot more 
flexibility in choosing which fields define uniqueness of an asset. For more information on how 
products are managed, see Siebel Life Sciences Guide.

About Usage Calculations
Sales representatives can use the Medical Handheld to analyze usage behavior on consigned 
inventory. They can compare Average Usage (in the field called Use in the Inventory Detail views) 
and Historical Average Usage (in the field called Avg in the Inventory Detail views). Average Usage 
is the quantity used over a predefined number of days based on the last two cycle counts performed. 
The Historical Average Usage is the quantity used over a predefined number of days based on all 
cycle counts ever performed for that product. By comparing these two calculations, sales 
representatives will be able to determine whether there are any significant changes to usage 
behavior for a certain product. They can use this information to identify cross-sell and up-sell 
opportunities. 

Detailed calculations are as follows:

■ On Count Complete, store Current Usage is based on adjustment and Current Count Date. 
Current Usage is the difference between what was counted and what the application expects to 
have.

No Yes No Always create a new asset and create an 
association between the asset and the 
product for the cycle count. If a product 
has not been counted, create a product 
detail and associate the asset with that 
product detail.

Update the quantity information on the 
cycle count asset record if the quantity is 
included in the barcode data, or else set 
the quantity to 1

NOTE: Upon count complete, old asset 
records are deleted, so only the most 
recently counted assets are displayed.

No No No If a product has been counted, increment 
the quantity of that product by 1.

If not, create a new product detail and set 
the quantity equal to 1.

Table 15. Cycle Count Records Overview

Product 
Serialized?

Product Track by 
Lot #?

Product 
Unique?

Product and Asset Tracking During a 
Cycle Count?
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■ Calculate and store New Daily Usage = Current Usage / (Current Count Date - Last Count Date).

■ Calculate New Historical Daily Usage = ((Historical Daily Usage x Number of Counts)+New Daily 
Usage)/ (Number of Counts + 1).

■ Calculate and store Historical Average Usage = New Historical Average Usage x Use Days.

■ Calculate and store Average Usage = New Daily Usage x Use Days.

■ Store Current Count Date as Last Count Date. 

NOTE: Use Days is defined by the Administrator for each inventory location. See �Managing Inventory 
Locations with Siebel Medical Handheld� on page 59 to determine how to define Use Days. If Use Days 
is not defined for the Inventory Location (for example, field is blank), a default input of 30 is used 
to calculate usage. Usage is calculated when Sales Representatives tap 'Count Complete' button as 
they complete a cycle count. It will only be calculated for products that are counted during that cycle 
count. Also, Usage numbers will not be calculated during the first time that a cycle count is performed 
on an inventory location. Usage calculations need a reference cycle count, since it is the first cycle 
count, the application will not be able to calculate meaningful numbers. 

Administering Products for Siebel Medical Handheld
You need to set up products for cycle counting and inventory management on the handheld. A 
comprehensive set of procedures on how to manage products is included in the Managing Products 
section of the Siebel Life Sciences Guide.

To administer products for consignment inventory management

1 From the application-level menu, Select Navigate > Site map > Administration-Product > 
Products.

2 Select the product from the Products List.

3 Click the hyperlinked entry in the Name field.

The More Info view appears. This view allows you to define the product for consignment inventory 
management. The relevant fields are described in the following table:

Field Description

Product The name of the product.

Part # Part number of the product.

Type Type of product. For a description of Managing Products 
and Product Types, see Siebel Life Sciences Guide.

NOTE: Product must be of type: Sample, Device, or 
Equipment to enable the Lot# Tracking field.
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>1 Barcode Checked if product requires two barcodes to uniquely 
identify its assets.

This determines whether the application waits for a 
second barcode when scanning this product during a 
cycle count.

Expression Used to generate unique asset numbers from the 
product's barcode. It is a concatenation of the data 
descriptions for barcode items. For example, if the 
expression is Lot Number, Serial Number, then the 
serial number and lot number portions of the barcode 
are the product's unique asset numbers. These 
barcodes can be found in the Handheld Administration 
screen > Barcodes view.

Leaf-Level Calculated when Capture Hierarchy button is clicked. 
Indicates that the product has no children in the 
product hierarchy. Only leaf-level products are physical 
products, that can be purchased and inventoried. 
Products that are not leaf-level represent groups of 
products.

Lot # Tracking Flag that when checked indicates that the product is 
tracked by lot number. If this field is checked, you must 
define lot numbers for the product. 

For more information on managing products, see Siebel 
Life Sciences Guide.

Parent Product The parent product of this product within the product 
hierarchy. 

Level Calculated when Capture Hierarchy button is clicked. 
Number that indicates the position of the product in the 
product hierarchy. If a product is a root parent (top of 
the product hierarchy), level is set to 1.

Requires 
Approval

Flag that if checked, and if the Requires Approval field 
in the Inventory screen > Inventory Locations view is 
set to Product, then customer approval (Handheld 
signature capture) is required when the product is 
moved out of an inventory location.

Roll Up Level Must be defined for all root parents. Indicates at what 
level, the handheld displays hierarchical results for 
inventory analysis. For example, a Rollup Level = 2 
shows Root Parent information on the handheld. Rollup 
Level = 3 does not show information on Root Parent, 
and child products of Root Parent and so on.

Field Description
Siebel Medical Handheld Guide Version 7.758 ■



Application Administration ■  Administering Siebel Medical Handheld
For more information on administering and managing products, see Siebel Life Sciences Guide.

Capturing Product Hierarchies for Siebel Medical 
Handheld
To appear in a Medical Handheld inventory, a product must belong to a product hierarchy that has 
been captured. The following procedure describes how to capture a product hierarchy.

NOTE: Make sure you have recaptured the hierarchy after editing the relationships between 
products.

To capture a product's hierarchy

1 From the application-level menu, choose Navigate > Site Map > Administration-Product 
Administration.

Select the root products whose hierarchies you want to capture. If you select a product that is 
not a root, that product is ignored. A dialog box lists these ignored records.

2 Click Capture Hierarchy.

This prepares the product data so that it can be used by the Medical Handheld application to track 
inventory. For more information, see �Administering Products for Siebel Medical Handheld� on 
page 57. 

Managing Inventory Locations with Siebel Medical 
Handheld
When tracking consigned inventory for a customer, you need to create an inventory location and 
associate this inventory location with the account. You can then view and keep track of inventory at 
this location.

Root Calculated when Capture Hierarchy button is clicked. 
Identifies the root parent product of the product 
hierarchy to which the product belongs.

Short Days The product is short dated this number of days before 
expiration. If this field is null, the Short Days setting in 
Application Administration > System Preferences is 
used.

Unique ID Identifies the product based on barcode data. This is 
the HIBC, UCC/EAN, or NDC number. It is used to map 
barcode data to the product.

Field Description
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To create and administer inventory locations

1 From the application-level menu, choose Navigate > Site Map > Inventory.

2 In the My Inventory Locations list, create a new record and enter the date for the appropriate 
fields. 

Some of the fields are described in the following table:

To view inventory data for an inventory location

1 From the application-level menu, choose Navigate > Site Map > Inventory.

Select an inventory location from the My Inventory Location list applet

2 Click the hyperlink in the Name field. 

The Product Inventory view appears for that Inventory Location. 

Field Description

Name Name to uniquely identify Inventory Location.

Type Type of inventory location. For example, warehouse or 
trunk.

Position Indicates employee associated with the inventory 
location. 

Ownership Indicates type of ownership.

Owner Company Identifies the account that owns the inventory location.

Contact Identifies contact information for the inventory location 
The data is used by sales representatives when 
scheduling cycle counts for that inventory location on 
the handheld.

Requires Approval Indicates what type of approval (handheld signature 
capture) is required for movement of inventory. If the 
field is set to Product, the handheld uses product 
settings defined in the Product Administration screen to 
determine whether the movement requires an 
approval. If the field is set to inventory location, all 
movement of inventory requires an approval.

Use Days Used to calculate Average and Historical Average 
Usage. For more information, see �About Usage 
Calculations� on page 56.
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Re-creating Product Hierarchies in Inventory Locations 
with Siebel Medical Handheld
After creating an inventory location, you define which product, product classes and product groups 
are tracked in that inventory location. You can use the generate hierarchy command to re-create 
product hierarchies in an inventory location. You must define product hierarchies for an inventory 
location so that sales representatives are able to view inventory and usage results in a hierarchical 
manner in the product hierarchy views.

To re-create product hierarchies in an inventory location

1 From the application-level menu, choose Navigate > Site Map > Inventory.

2 Select an inventory location from the My Inventory Location list, and then click on the hyperlink 
in the Name field.

The Product Inventory view for this Inventory location appears. 

3 In Product Inventory list create a new record.

4 Click the select button in the Product field. 

The Pick Product picklist appears.

5 Select a product from picklist, and click OK.

6 In the External Location form, click Generate Hierarchy.

Clicking the Generate Hierarchy button launches a business service that creates new product 
inventory records for all products belonging to the same product hierarchy that the product you 
select belongs. For each product inventory record created, corresponding records in the 
Inventory Level list applet are also created for On-Hand Goods inventory.

Setting Consignment Levels for Inventory for Medical 
Handheld
After defining products and re-creating the product hierarchy, you then need to define consignment 
levels. 

To define consignment levels for inventory

1 From the application-level menu, choose Navigate > Site Map > Inventory.
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2 Select an inventory location from the My Inventory Location list, and then click on the hyperlink 
in the Name field.

The Product Inventory view appears for this Inventory location. You can set consignment levels 
by updating the fields in the Product Inventory List. The fields are explained in the following 
table:

Creating Assets for Medical Handheld
For some inventory, administrators may be required to keep track of assets, for instance, serialized 
products. In these cases they would need to create assets and associate these assets with products. 

To create assets

1 From the application-level menu, choose Navigate > Site Map > Assets.

2 In the All Assets list, create a new record. 

3 Update the required fields.

Some of the fields are described in the following table:

Field Description

Min Minimum level of inventory the customer agreed to 
keep at that inventory location, usually, in return for 
pricing benefits.

Max Maximum level of inventory required at that inventory 
location.

Consignment Level Flag that when checked, indicates whether this product 
is consigned.

Field Description

Asset # Asset Number. Automatically generated but can be 
edited.

Product Product Name.

NOTE: Once Product is selected, other fields are also 
updated, including: Serial #, Type, Serialized.

Lot # If the Product has Lot# Tracking selected in the Product 
Administration > More Info views, then you need to 
select Lot# for this asset. 
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Managing Inventory Transactions for Medical Handheld
After creating assets, you can then create inventory transactions to record movement of inventory 
from one inventory location to another. You can also keep track of inventory transactions created as 
part of a cycle count and view signatures captured for approval-required moves. 

NOTE: All inventory transactions created by the Medical Handheld are created for On-Hand Goods 
bucket. For more information on Managing Inventory and Inventory Transactions, Siebel Field 
Service Guide.

To record movement of inventory

1 From the application-level menu, choose Navigate > Site Map > Inventory Transactions

2 In the All Inventory list, create a new record and update the required fields. 

Some fields are described in the following table:

Unique ID Used to identify the asset from product barcode data.

This should be created based on the Expression field in 
the Product Administration > More Info view for the 
product. For example, if Expression is set to: Lot 
Number, Serial Number, then Unique ID should be a 
concatenation of Lot Number and Serial Number values 
for this asset.

Use By Expiration date.

State Calculated based on Expiration Date. An asset can be 
good, short dated, or expired.

Days Left Calculated based on Expiration Date and current date. 
Days before the product expires. 

Field Description

Type Type of inventory transaction. For example, Stock 
Transfer or Receive Other. For information on 
transaction types, please refer to Siebel Field Service 
Guide.

Product Product being moved.

Source Location Source location. This can be virtual (External Location) 
or a physical location (warehouse, trunk, or a 
customer's inventory location).

Field Description
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3 Click the Transaction # Hyperlink.

The Inventory Transaction > Assets view appears.

4 In the Assets applet, create a new record.

5 Click the select button in the Asset # field. 

The Pick Asset picklist appears.

6 Select an asset, then click OK.

Viewing Signatures Captured For Approval-Required 
Moves from Medical Handheld
Sales representatives can decide to move inventory from a customer's inventory location, as in the 
case of expired or short-dated product. Your company might decide to enforce varying levels of 
control for movements that are done on certain products (for example, controlled substances, new 
products, and so on). Or, your company might want to enforce control on all inventory movements 
done on specific inventory locations. In these cases, your company can enforce sales representatives 
to capture signature directly on the handheld. You can then view signatures captured for these 
inventory transactions.

To view signatures captured for approval-required moves

1 From the application-level menu, choose Navigate > Site Map > Inventory Transactions.

2 In the All Inventory list, query for the inventory transaction you need. 

3 Click the hyperlink in the Transaction # field. 

Destination Location Destination location. This can be virtual (External 
Location) or a physical location (warehouse, trunk, or 
a customer's inventory location).

Source Availability; 
Source Status; 
Destination 
Availability; Status

Defines inventory level at source location for that 
product. Inventory levels are categories of products 
defined by a combination of availability and status. 
Both availability and status can have a variety of 
values. Availability values are Customer Owned, In 
Transit, On Hand, On Order, and Reserved. Status 
values are Good and Defective. 

NOTE: When sales representatives are performing 
cycle counts, transactions are automatically generated 
with Availability = On Hand and Status = Good.

For information on transaction types, Siebel Field 
Service Guide.

Field Description
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4 Click the Approvals view tab. 

Assigning Cycle Counts for Medical Handheld
A regular task for the administrator is assigning cycle counts to be performed by sales 
representatives on an inventory location. 

The process below describes how cycle count can be assigned manually. But you can automate this 
process, or define rules in assigning cycle counts. For more information on Cycle Counts and Cycle 
Count Administration, please refer to Siebel Field Service Guide. 

To assign a cycle count

1 From the application-level menu, choose Navigate > Site Map > Cycle Counting.

2 In the My Pending Cycle Count list, create a new record. 

Some fields are described in the following table:

Sales representatives receive this pending cycle count the next time they synchronize.

Field Description

Inventory Location Location on which to perform the cycle count.

Owner Owner of the cycle count. Determines who is assigned 
this cycle count.

Due Date Required date when the cycle count should be 
completed by.
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5 Data Filtering
The following topics are covered in this chapter:

■ �Developing Data Filters for Handheld� on page 67

■ �General and Default Business Object Filters� on page 68

■ �Recommendation for Managing Handheld Business Object Filters� on page 68

■ �Filtering Data for Pick Applets� on page 69

Developing Data Filters for Handheld
The following general steps for are recommended for developing Handheld synchronization filters.

■ Identify the screens and views of your application. Then identify the business components that 
are required to support each screen and view, noting the areas where each business component 
occurs. For example, identify the form, list, or pick applets that are based on each business 
component.

■ Within Siebel Tools, establish the base parent-child relationships and any reverse relationships 
at the component level.

■ Review the business components that occur in picklists and consider creating default sync filter 
declarations for those that will cause large numbers of records to synchronize to the device. 
These declarations are created and maintained in the Mobile Administration screens.

■ For each business component, determine whether it is possible to apply a search specification to 
all instances of the business component within the Siebel Handheld application. Develop a set of 
suitable Query by Example (QBE) declarations in the Mobile Administration screens. Common 
examples of business components that are suitable for global QBEs include: 

■ Employees (for large organizations)

■ Activities (for example, filter for current Activities, Activities of only certain kinds)

■ Accounts (for example, by geography) 

■ Products (for example, active, orderable products)

■ Orders (for example, open, closed in last three months)

■ Create appropriate business object synchronization filters for each business object and make 
sure that each business object includes a default filter. Default filters make sure that users avoid 
accidental download of an excessive number of records.
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General and Default Business Object 
Filters
There are two types of synchronization filters in Siebel Handheld�general and default filters.

■ General sync filters. Filters users select to specify the records users want downloaded to their 
Siebel Handheld application.

■ Default sync filters. Filters displayed by default the first time the user taps the Select Filters 
button on the Handheld Sync user interface or if the user synchronizes without first selecting a 
filter.

There is no naming convention for Siebel Handheld Business Object Filters. The default filter for a 
business object is indicated by checking the Default flag in the Administration-Mobile > Application 
Administration > Business Object Filters view. 

An asterisk (*) preceding a filter name indicates the filter could be used for sync, if selected, and 
does not display in the query list in the application. For example, �*No_Accounts.�

General filters appear in the Set Filters dialog when users synchronize their data and, if selected, in 
the Siebel Handheld application in the Queries drop-down list.

An example of a general filter name is My Big Opportunities. 

Default filters appear in the Set Filters dialog when users synchronize their data and, if selected, in 
the Siebel Handheld application in the Queries drop-down list. Default filters with the asterisk (*) 
prefix only appear in the Set Filters dialog; this filter does not show up in the application.

There should only be one default query for each business object. 

CAUTION: Administrators must be sure to define a default filter for each business object in the 
Siebel Handheld application. If no filters are applied during the synchronization process, an 
unacceptably high volume of data will be downloaded to the handheld device.

Recommendation for Managing 
Handheld Business Object Filters
The following sections provide recommendations for creating and managing filters with various 
synchronization methods.

Companion Deployments
Administrators typically provide their users with an initial set of Handheld Business Object filters and 
instruct them how to manage the synchronization filters themselves later. They are maintained in 
the Administration-Mobile > Application Administration > Business Object Filters view. This view is 
hidden from mobile users so they cannot create their own Business Object Filters. 

There are several sample Handheld Business Object Filters in the sample database, as well as in the 
Siebel 7.7 seed data.
Siebel Medical Handheld Guide Version 7.768 ■



Data Filtering ■  Filtering Data for Pick Applets
Stand-Alone Deployments
For Direct Server Sync deployments, administrators can create user-specific business object and 
business component filters in the Administration-Mobile > User Administration view. For more 
information, see �Setting Business Component Filters for Siebel Handheld Users� on page 42 and 
�Setting Business Object Filters for Siebel Handheld Users� on page 43. 

NOTE: These Business Object Filters are made available to all end users and, therefore, must be 
defined with the needs of all end users in mind. 

Filtering Data for Pick Applets
Exercise caution when modifying filter for pick applets, and do so only with the support of a skilled 
Siebel configurator. 

Use default Business Object declarations to force the extraction of data for a given business 
component in the context of a given Business Object and Visibility type. For more information on 
visibility designations, see �Designating Visibility� on page 72. The Default Business Object 
extractions are performed in the first phase of data extraction.

You will most often use these declarations to extract additional data that is not extracted as part of 
the user interface extraction. This may be useful for business components that are referenced 
programmatically by other business components, but are not exposed in the user interface. The 
default business object declarations are used to enforce the extraction of a subset of data to the 
handheld that would not have been otherwise extracted or, most commonly, to filter the data 
downloaded for dynamic picklists or pick applets.

All pick data is not downloaded to the device due to the memory constraints on the device. Only pick 
data for fields that are editable is downloaded. Therefore, if you are doing a query on a pick field, 
you may not be able to display the picklist. When viewing a record in an applet, if a pick field is read-
only, its pick button will be disabled. If end users select a read-only field with a pick control, they 
receive the following error: �No data available in picklist because field is read-only.�
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Configuration Directives
These directives are located in the Mobile Administration > Application Administration > Settings 
view. Table 16 lists the configuration directives that are used to filter data:

Table 16. Configuration Directives

English LOV Display Name Definition

Allow Remember Password Enable option for end user to remember username and 
password.

Batch Download Stagger Distributes extraction over a period of time.

Batch Initial Download Sets base time for first poll.

Batch Poll Frequency Sets polling frequency.

Client Sync Default Default sync type for sync client.

DB Extract Thread Load The load (or weight) assigned to each individual Database 
Extractor thread.

Database Extract Threshold This is the minimum time the Database Extractor will 
continue extraction of business components before 
causing a handshake with the client.

Default BusComp User Props Defines subset of user props extracted for a business 
component.

Default Business Object Amends application definition to include additional 
business objects including "hidden" and RBOs.

Default Fields Identifies fields from DefaultBusObj that will be extracted 
to device.

Default Insert Mode Sets default for Insert Failure Mode.

Default Pick Mode Sets default for Extended Pick.

Enable Batch Extraction Enables Batch Sync.

Enable Sql Trace Interweaves SQL tracing into handheld sync log file.

Extraction Expiration Determines valid life span of extract.

Logging Levels Sets logging levels (must be 5 octal digits).

Max Throttle Wait Time This is the upper limit on the amount of time any 
individual throttling request will be allowed to wait.

Max Total Thread Loads The maximum number of total thread loads that will be 
allowed to run across the scope defined by Thread 
Throttle Scope.

No Database BusComp Define a business component that must be omitted from 
the device database and excluded from database 
extraction.
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CAUTION: Be extremely careful when modifying these declarations. The business objects that are 
required for internal application functioning differ by application.

Examples of Business Object Declarations
You can set the Default Business Object declarations in the Administration-Mobile > Application 
Adminitration > Settings screen, as described in the following examples.

The general format is as follows:

DefaultBusObjs22 = Opportunity | 3 | | Account | [Account Status]  = "Active" | Action 
| [Start Date] >= Today () - 30 AND [Start Date] < Today () + 90

The example Default Business Object declaration results in an extraction of the Account and Action 
business components where they occur with visibility �3� using the business object filter indicated. 
They are not extracted in context of opportunities even though the Opportunity business object was 
identified. The business object filters are generally used only for extracting business components 
that do not correspond to any views or applets. Business object declarations identify specific business 
components within the business object to be extracted. The business object filters normally give a 
query based on the primary business component in the business object, but do not force extraction 
of any business components mentioned in the query, therefore, in order for a business component 
to be extracted from the business object it must be attached to an applet.

Note that there is no business object filter included in the example. A business object filter is only 
included when you want to force the use of a particular business object synchronization filter. See 
�General and Default Business Object Filters� on page 68 for more information on business object 
synchronization filters.

In the following example, the declaration is used to extract all of the Price List Line Items that will 
display within the Orders screen.

DefaultBusObjs13=  Order Entry (Sales)|0||Price List Item|

No Extract BusComp Define a business component that must be excluded from 
database extraction.

Schema Change Notification Define a Business Service which should receive the 
Handheld Schema Change Notification.

Thread Throttle Scope Defines the scope of the thread throttling mechanism.

Transaction Thread Load The load (or weight) assigned to each individual 
Transaction Processor thread.

Transaction Threshold This is the minimum time the Transaction Processor will 
continue processing transactions before causing a 
handshake with the client.

Table 16. Configuration Directives

English LOV Display Name Definition
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Note that this declaration lacks an associated business component statement. When this is the case, 
all of the records available to the user for the given visibility are extracted.

Another less common way to use the Default Business Object declarations is to set a single Handheld 
business object synchronization filter for the business objects that are synchronized.

Designating Visibility
It is very important that you use the correct visibility designation in the Default Business Object 
declarations. The visibility entered should be the visibility that governs the data displayed for the 
business component within the context of the Business Object specified in the declaration. In the 
previous Example 1, visibility code 3 is designated. This corresponds to All Visibility, which is the 
visibility that applies to the Account business component when it is used in a pick applet.

You determine the correct visibility to use by examining View and Business Component properties 
within Siebel Tools. When creating a Default Business Object declaration to restrict the volume of 
data extracted for a pick applet, begin by examining the Popup Visibility Type in Business Component 
Properties. Cross-reference the visibility type to the list below, and enter the appropriate visibility 
code in the declaration. If the Popup Visibility Type field on the Business Component is null, the 
default value is All. Table 17 summarizes popup visibility types and the corresponding visibility codes.

.

NOTE: Do not use the Group, Catalog, or Sub Organization Popup Visibility Types. These are not 
supported in the CE handheld applications.

Table 17. Visibility Codes

Popup Visibility Type Visibility Codes

Sales Representative 0

Manager 1

Personal 2

All 3

None 4

Organization 5

Contact 6
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Overriding the Popup Visibility
If the Popup Visibility Type setting is not sufficiently restrictive (for example, All visibility), this can 
lead to a large number of records being extracted when the picklist is processed during 
synchronization. Making the Popup Visibility Type more restrictive reduces the number of records 
extracted for picklists. The OverridePopupVisibility user property for an applet overrides the Popup 
Visibility Type on a business component. Use this property when the desired visibility differs from the 
business component�s Popup Visibility Type, and you do not want to change the Popup Visibility Type. 
If several picklists use the same business component, you can also use the OverridePopupVisibility 
user property to vary the visibility of the picklists in the different applets.

There are two considerations you should keep in mind if multiple applications are sharing the same 
repository. First, changing the Popup Visibility Type has a global effect for all instances where the 
business component is used. If multiple applications share the same repository and use the same 
business components, changing the Popup Visibility Type for a common business component could 
have an undesirable effect for another application. Second, if multiple applications share the same 
applet, the picklist in each applet shares the same visibility as defined by OverridePopupVisibility 
property. This is because the OverridePopupVisibility property is set on the containing applet.

In Siebel Tools, navigate to Applet > Applet User Properties, and define the OverridePopupVisibility 
user property on the applet containing the control that opens the pick applet. See Table 18 for a 
description of the syntax. Assign a value to this property using the syntax shown, where <buscomp 
field n> is the underlying business component field of an applet control or column, and <visibility 
type> is the code corresponding to the desired visibility of the picklist�s business component. (See 
Table 17 for a list of the visibility codes.) Because the name of the OverridePopupVisibility parameter 
must be unique, append a unique number to the name of the parameter for any other picklists, for 
example, OverridePopupVisibility1, OverridePopupVisibility2, and so on.

NOTE: If OverridePopupVisibility is used, then the picklist and pick applet search specifications are 
ignored during synchronization when the records for the picklist are extracted.

Table 18. OverridePopupVisibility Syntax

Name Value

OverridePopupVisibility <buscomp field 1>, <visibility type>

OverridePopupVisibility1 <buscomp field 2>, <visibility type>

OverridePopupVisibility<n> <buscomp field n + 1>, <visibility type>
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6 Deployment of Siebel Handheld
This chapter includes the following topics:

■ �Scripting in the Siebel Handheld Client� on page 75

■ �Overview of Server Installation in Support of the Siebel Handheld Client� on page 76

■ �Process of Server Installation for Siebel Handheld Direct Server Sync� on page 78

■ �About Siebel Handheld Synchronization Performance and Scalability� on page 81

■ �Siebel Mobile Web Client Installation� on page 82

■ �Process for Installing the Siebel Handheld Application� on page 82

■ �Installing Print Templates in the Siebel Handheld Install Directory� on page 86

■ �Setting up Siebel Handheld Application Installation on a CompactFlash Card� on page 86

■ �Setting the Siebel Handheld Application Restart Parameter� on page 87

■ �Changing the SyncURL on Siebel Handheld Devices� on page 87

■ �Installing the Siebel Handheld Application from External Media� on page 88

■ �Distributing Siebel Handheld Application Patches� on page 88

Scripting in the Siebel Handheld Client
The Siebel Handheld Client does not execute Siebel Visual Basic (VB) or Siebel eScript scripting.

The Siebel Web Client application runs Siebel VB or Siebel eScript scripts and specialized business 
component logic at synchronization time, rather than in real time on the handheld device. This has 
significant consequences in applets and controls, because scripts attached to applets and controls 
are ignored.

Be aware of the following additional issues with respect to scripts and validation: 

■ Deactivating scripts. Do not deactivate existing scripts in Siebel Tools to make the handheld 
device or the synchronization process accept data it is excluding. The script is probably used by 
the Siebel Web Client, and you can cause damage elsewhere.

■ Calls to user interface methods. When a business component script makes a call to a user 
interface method (such as MsgBox), the script cannot be executed, and the record update, 
deletion, or addition is rejected during synchronization. Strictly speaking, a script attached to a 
business component should not interact with the user interface, but it is nevertheless a common 
practice.
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Any Siebel Visual Basic code should be restricted to the business component level. Applet-level Siebel 
Visual Basic will not be executed and, therefore, should not be written for the Siebel Handheld Client 
application. As a substitute to using Siebel Visual Basic on the Siebel Handheld Client application, for 
real-time execution, use the following business component user properties:

■ BC/Field Read Only Field...for making fields or business components read-only dynamically.

■ Pickmap for fields on the picklist.

Do not use message boxes or prompts on the Siebel Visual Basic code used in conjunction with the 
Siebel Handheld Client application business components. If the business component is shared 
between the Siebel Handheld Client application and a laptop, use the following construct to 
determine if the code is being executed in real time on the laptop or during synchronization:

'ActiveViewName is only available when the script is called real time on the laptop

If (TheApplication.ActiveViewName<>"") then

MsgBox"....."

End If

Overview of Server Installation in 
Support of the Siebel Handheld Client
This section provides an overview of important factors to consider when planning Direct Server 
Synchronization (DSS) infrastructure. One aspect of successful planning and execution of a Siebel 
Handheld DSS deployment is to understand hardware and network requirements. While these factors 
are generally applicable to all deployments, there are unique aspects to each customer configuration 
and implementation strategy. Therefore, it is highly recommended that customers conduct detailed 
configuration, sizing, and production readiness reviews with Siebel Expert Services. This is especially 
important for complex deployments, such as those supporting large numbers of users over wide 
geographic areas. 

You can also improve the performance and scalability of DSS deployments by working with the Siebel 
application server component parameters. For more information about the Siebel application server, 
see �Optimizing Server Process Management� on page 81.

NOTE: The recommendations in this chapter are general ones and are intended to raise your 
awareness of the key factors in handheld synchronization, performance, and scalability. These 
factors must be confirmed for your actual environment, and the usage patterns in your enterprise 
should be taken into consideration.
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Server Topology Overview
The diagram in Figure 2 shows the servers and components that are required to deploy Direct Server 
Sync. The components are the Siebel database, Siebel server, Siebel Web engine, and Siebel 
Handheld. The synchronization components are the Siebel Sync engine which resides on Siebel 
server and the Sync client on Siebel Handheld. 

CAUTION: Companion Sync uses Siebel Remote to complete the synchronization process to the 
Siebel server from the laptop. The remote mobile user's routing model must be set to Handheld User. 
Otherwise, sync will fail. For more information, see Siebel Remote and Replication Manager 
Administration Guide.

You can improve performance by properly selecting the machine that each server runs on (Web 
server, Siebel server, database server). For example, increasing the memory and number of spindles 
improves the database server performance, and increasing the number of CPUs and the amount of 
memory improves the performance of the application server.

Recommended Hardware and Network Configuration
There are many factors to take into account when designing and implementing your server and 
network hardware and architecture, and sizing your database. The critical factor in sizing a handheld 
implementation is the expected peak synchronization load. Specific application variables to consider 
in calculating this load are: the number of concurrent users, number of transactions, and size of the 
data file. These variables should be considered within the context of the hardware specifications, 
including memory and processor speed.

The following resources are available as you plan your Siebel Handheld implementation:

■ Refer to Microsoft and manufacturer documentation for comprehensive information on server 
hardware and registry parameters.

■ Refer to Siebel Technical Note 405, Siebel Handheld Synchronization for specific 
recommendations on the following topics: 

■ Server Architecture

■ Server Hardware and Registry Parameters

Figure 2. DSS Servers and Components
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■ Database Server Sizing

■ Database Tuning

■ Dial-Up and Network

■ Wireless

■ VPN (Virtual Private Networks)

■ The Expert Services Handheld Review Package assists customers with planning their hardware 
and network for handheld implementations. Contact Siebel Expert Services for more information 
about this program.

Process of Server Installation for Siebel 
Handheld Direct Server Sync
The server components that are required for Siebel Handheld are installed when you install the Siebel 
server. See the Siebel Server installation guide for your operating system for details on installing and 
configuring Siebel server. The Siebel server installer copies the necessary DLLs to create an Object 
Manager for Direct Server Sync and creates and configures a Server Component and Component 
Group. The rest of this subsection describes which options you must select to correctly install the 
software, along with creating or configuring additional Object Managers.

This process includes the following tasks:

■ �Installing the DSS Components Using the Siebel Server Installer� on page 78

■ �Editing the DSS Object Manager Configuration File� on page 79

■ �Configuring Server Logging Levels� on page 80

■ �Optimizing Server Process Management� on page 81

Installing the DSS Components Using the Siebel Server Installer
Install the Siebel server, following the instructions in the Siebel server installation guide for the 
operating system you are using. When you reach the Setup Type screen in the Installer wizard, you 
are presented with three installation options:

■ Typical. This setup option installs all Siebel server components except those displayed. 

■ Compact. This setup option installs only those components necessary to run the Siebel server, 
but no additional components or help.

■ Custom. This setup option lets you customize your installation by choosing the specific 
components you want to install.
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Direct Server Sync
To install the Direct Server Sync components with your Siebel Server installation

1 In the Setup Type screen, choose the Custom setting, and then click Next.

NOTE: At this screen, you may also choose a different directory for your Siebel server 
installation. 

2 Choose from the following components:

■ Object Manager Component

■ Handheld Synchronization

■ Siebel Data Quality Connector

■ Remote Search Support

■ Siebel Java Integrator

The listed Custom Installation options are all selectable.

NOTE: You must enable Handheld Synchronization to enable Direct Server Sync for your DSS 
installation.

3 Click Next.

Continue with the installation in Siebel Installation Guide for Microsoft Windows: Servers, Mobile 
Web Clients, Tools.

The install wizard automatically installs and configures the DSS components. In addition, the 
installer creates a configuration file that includes the parameters necessary to properly run the DSS 
server components and the Business Component filters file.

Editing the DSS Object Manager Configuration File
You must edit the configuration (.cfg) file associated with the DSS server components that you 
installed and configured to reflect your company's environment.

To edit your configuration file

1 In Windows Explorer, navigate to the directory where the Siebel server is installed and locate the 
configuration file associated with the DSS server component. By default, this directory is 
C:\Siebel Root\ siebsrvr\BIN\ENU.

NOTE: By default, the name of the DSS Object Manager configuration file is medicalce.cfg, but 
you can change the name of this file.

2 Create a backup copy of the configuration file and name it medicalce.cfg.bak.

This step allows you to recover the original version of the file if you encounter errors.

3 Open the configuration file using a text editor.
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4 Enter parameter values appropriate for your deployment.

The following table shows the parameters in the .cfg file that may need to be edited to reflect 
your environment. All other parameters in this section should not require change. 

5 Save your changes.

6 Restart the component or server.

Configuring Server Logging Levels
To set the logging level, two things need to be done. Logging level must be a number 0-5. 

To configure server logging levels

1 Log into Server Manager from a (m:\siebel\bin\w32ud) prompt. 

2 Run the following: 

change evtloglvl HandheldSyncLog=[LogLevel] for comp [OMName], where [LogLevel] = an 

integer between 1 - 5 (5 enables all logging) and [OMName] = the OM name (for example, 

<ApplicationName>CEObjMgr_enu). 

Parameter Default Value Description

[Siebel] 
section 

ApplicationName SiebelMedicalCE The Siebel Handheld application. This 
value must match the name of the 
application as it is specified in Siebel Tools.

ApplicationTitle Siebel Medical The name of the Siebel Handheld 
application as shown on the Title bar on 
the browser. This parameter is only used if 
the Siebel Tools application developed for 
the handheld is run on the Web client.

ApplicationSplash
Text

Siebel Medical 
CE

The Siebel Handheld application name as 
shown on the splash screen. This 
parameter is only used if the Siebel Tools 
application developed for the handheld is 
run on the Web client.

ComponentName  Required for Direct Server Sync, it is 
entered in the registry on the handheld 
device.
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Optimizing Server Process Management
Several parameters are outlined below that help optimize server processing for Direct Server Sync. 
To set these parameters, log into a Siebel client as a user with Administrative responsibility and 
navigate to Servers > Components > Component Parameters through the Screens menu. Select the 
SalesCE ObjManager (or the appropriate Siebel Handheld application) and update the following 
parameters to optimize threads per process. For further information and assistance, see Technical 
Note 405, Siebel Handheld Synchronization, and contact Siebel Expert Services about the Siebel 
Expert Services Handheld Review Package.

■ Max tasks. This parameter determines the maximum number of threads that can run 
concurrently for a given component. The value of this parameter should equal the maximum 
expected peak number of concurrent synchronizations.

■ Min MT servers. This parameter determines how many multithreaded server processes are 
started by default for the Siebel Object Manager.

■ Max MT Servers. This parameter defines the maximum number of processes supported by the 
instance of the Siebel Object Manager. The value for this parameter should be the same as Min 
MT servers and should be set so that threads per process (Max Tasks/Max MT Servers) is 
optimized.

About Siebel Handheld Synchronization 
Performance and Scalability
There are a number of factors that affect the performance and scalability of handheld 
synchronization. It is very important that administrators and those involved in the design and 
deployment of Siebel Handheld understand the impact of usage parameters on synchronization 
performance and scalability. For more information, see Technical Note 405, Siebel Handheld 
Synchronization for application-specific variables affecting synchronization and data from 
synchronization scalability tests. 

Using Multiple Synchronization Servers
As you scale your deployment, you may need to use multiple synchronization servers to 
accommodate all of your users. Your end users must be manually assigned to a particular server. 
Resonate products cannot be used for load balancing. Refer to Technical Note 405, Siebel Handheld 
Synchronization and to your hardware manufacturer�s documentation for more information on 
scaling deployments.

Synchronization Security
The synchronization data stream can be secured using SSL (Secure Sockets Layer). 
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Siebel Mobile Web Client Installation
You must edit the configuration (.cfg) file associated with syncmanager.exe (the Companion Sync 
executable) that was installed with the Siebel Mobile Web Client to reflect your user's environment. 
It may not be practical to individually edit each Companion Sync user's .cfg file; therefore, it is 
recommended that you create one edited file and distribute it to all your users with Siebel Anywhere. 
See Siebel Anywhere Administration Guide for more information.

Process for Installing the Siebel 
Handheld Application
Before you deploy the Siebel Handheld application, there are several tasks you need to perform. This 
process includes the following tasks:

■ �Editing the Handheld Application Installation Configuration File� on page 82

■ �Enabling Handheld User Database Backup� on page 84

■ �Deploying Patches to the Handheld Application with Direct Server Sync� on page 89

■ �Deploying Handheld Application Patches with Companion Sync� on page 90

■ �Creating Handheld Application Upgrade Kits to Remotely Deploy Patch Files� on page 91

■ �Downloading Patches to the Handheld Device� on page 91

Editing the Handheld Application Installation 
Configuration File
The Siebel Handheld application setup.ini file configures the Siebel Handheld Client application 
installer. Before you deploy a custom-configured Siebel Handheld application, you must update the 
parameters in the setup.ini file so that the correct values are written to the device registry before 
distributing the client installer to end users.

The setup.ini file resides in the Siebel Handheld application directory (for example, the Medical 
Handheld directory) on the Siebel Handheld DVD-ROM. To modify this file, create a Siebel Handheld 
installation directory on the network, or create and duplicate a custom DVD-ROM for distribution to 
end users. This installation directory must include the same files and directory structure as the 
original DVD-ROM. Then, modify the setup.ini file in the custom installation directory.

NOTE: If you wish to set up parameter values other than default values, add the parameter to the 
setup.ini file and add the proper values.
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Table 19 lists the parameters that you may need to modify in the setup.ini file, their default value, 
and a description of the parameter.

Table 19. Siebel Handheld setup.ini Parameters

Parameter Default Value Description

Version 7.7 Version of the desktop Siebel application 
against which the Siebel Handheld version 
synchronizes.

Application Title SiebelMedicalCE The Siebel Handheld application. This value 
must match the name of the application as it 
is specified in Siebel Tools.

ApplicationName SiebelMedicalCE The Siebel Handheld application. This value 
must match the name of the application as it 
is specified in Siebel Tools. 

ApplicationSplashText SiebelMedicalCE The Siebel Handheld application name as 
shown on the splash screen.

MultiCurrency True Required for the application to handle 
multiple currencies.

SyncURL http://Web 
Server Name or 
IP address/
Virtual Directory 
Name

Required for Direct Server Sync or 
Companion Server Sync. This value is 
entered in the registry on the handheld. See 
�Changing the SyncURL on Siebel Handheld 
Devices� on page 87 for more information on 
this parameter.

[EndUserLocalization] Section

User DefinedLang Y

LogUserDefinedLangErrors N

[Printing] Section See Appendix E, �Print Configuration 
Settings,�for more information on the 
parameters used to configure printing.

[Backup] Section Enables handheld database backups.

See �Editing the Database Backup Parameters� 
on page 85 for more information on settings 
for the parameters in this section of the 
setup.ini file.

[ApplicationLocation] Section Specifies where the Siebel Handheld 
application and database are installed.

See �Setting up Siebel Handheld Application 
Installation on a CompactFlash Card� on 
page 86 for more information on the 
parameters in this section of the setup.ini 
file.
Siebel Medical Handheld Guide Version 7.7 ■ 83



Deployment of Siebel Handheld ■  Process for Installing the Siebel Handheld Application
Enabling Handheld User Database Backup 
Siebel Systems provides a way to automatically back up a snapshot of the user�s database and 
current settings, and to restore those settings in the event of a total device failure. The backup 
functionality automatically copies all the necessary files to a single compressed file. Each time the 
user backs up, the backup process creates a new copy of the file and deletes older backups. The 
backup process must close the application in order to copy the RDBMS and handheld configuration 
files. After the files are copied, it automatically restarts the application.

The backup feature must be enabled in the application. (For more information on enabling the backup 
feature, see �Setting Up Database Backups.�) If the backup feature is enabled, a backup is created 
during every synchronization. This way, the user retains an up-to-date snapshot of the database, 
and older backup versions are removed.

InternetOptionReceiveTimeout 600000 Length of time to receive data (except data 
extraction) from the server before the 
handheld client times out. This parameter 
only applies to synchronizations using Direct 
Server Sync.

In milliseconds. The default value, 600000, is 
10 minutes.

InternetOptionSendTimeout 600000 Length of time to send data to the server in a 
single call the handheld client times out. This 
parameter only applies to synchronizations 
using Direct Server Sync.

In milliseconds. The default value, 600000, is 
10 minutes.

InternetOptionDataExtractionTi
meout

900000 Length of time to extract data from the 
server to the handheld device the handheld 
client times out. This parameter only applies 
to synchronizations using Direct Server Sync.

[Logging] Section

TXNErrorLevel 1 This level controls the extent of transaction 
error information received from the server

DefaultLogLevel 2 This is for logging messages

MaxLogFileSize 2000 This is for the maximum log file size in KB

MaxSavedLogFiles 3 Determines the number of log files to save.

Table 19. Siebel Handheld setup.ini Parameters

Parameter Default Value Description
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When the database backup feature is enabled, a database backup occurs automatically at the end of 
each synchronization. This makes the overall time to synchronize somewhat longer. The size of the 
database and the speed of the CompactFlash card also affect the time it takes to complete 
synchronization.

NOTE: Backups should not be used as a replacement for synchronization.

Setting Up Database Backups
In order to back up the database:

■ Provide users with an external memory card.

■ Install the Siebel Handheld application with the backup functionality enabled.

■ Instruct users to back up their database on a regular basis.

Backing Up to External Media
It is recommended that you back up to external media�for example, a CompactFlash card.

Backing up data to a directory in memory is an option, if external media is not available on the 
handheld device. However, if the handheld device is damaged, the backup in memory may not be 
retrievable. Also, when backup data is stored in memory, the amount of memory available to run the 
application decreases, and application performance may suffer.

Editing the Database Backup Parameters
Before users can back up the database on their handheld devices, you must first enable the Backup 
menu item on the Siebel Handheld application. This requires editing the setup.ini file to enable 
backup.

The following is an example of the default settings for the backup parameters:

[Backup]
BackupLocation = \Storage Card\Siebel Backup
BackupEnabled = N

■ BackupEnabled = [Y/N] The default is N (No). Change this setting to Y (Yes) to enable the Backup 
menu item and to trigger a backup to occur automatically after each synchronization.

If the product is installed with Backup = N, the backup menu item is disabled. You need to change 
the parameter, then reinstall the product in order to enable the menu item.

■ BackupLocation = [Backup location] The default is an external storage card. Specify the location 
where you want the data backed up. It is recommended that you do not back up to internal RAM 
because this may have a negative effect on the performance of the application. However, if you 
back up to RAM, then specify the directory location where you want the data backed up.

For more information on the setup.ini file, see Chapter 8, �Installing the Handheld Application.�
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Restoring from a Backup
For information on restoring a database from a backup, see �Backing Up and Restoring Data with the 
Siebel Handheld Client� on page 114.

Installing Print Templates in the Siebel 
Handheld Install Directory
If your application allows printing, you must include all print templates in the template subdirectory 
of the Siebel Handheld Install directory. The print templates are language-specific, so copy the 
templates to the template subdirectory within the language directory of the language you are 
deploying (for example, ...\ENU\Template). If the template includes double byte characters, such as 
Japanese string, you must save the template files as Unicode (UTF16) files. For supported language 
codes, see System Requirements and Supported Platforms on Siebel SupportWeb. 

See Appendix E, �Print Configuration Settings�for more information about Printing.

Setting up Siebel Handheld Application 
Installation on a CompactFlash Card
The default, when installing Siebel Handheld applications, is to install both the application and the 
database into RAM on the device. In most instances, there is sufficient available memory, and end 
users are satisfied with the application performance. There are situations, however, where you may 
need to optimize the application performance. You can improve performance by installing the Siebel 
Handheld application on an external storage device.

To improve the performance of the application, it is recommended that you install the application 
binary files on a CompactFlash card. By doing so, you can free up program memory. Installing the 
data on the CompactFlash card is not recommended because performance likely degrades.

You can specify, in the application�s setup.ini file, where the application files and database files are 
to be installed. By default, this is set to the handheld device. In the ApplicationLocation section of 
the setup.ini file, there are two parameters. The following shows the default settings for these 
parameters:

[ApplicationLocation]
ApplicationBinariesLocation = Device
ApplicationDataLocation = Device

■ ApplicationBinariesLocation = Device. The default is Device. To improve application performance, 
set this to CF (CompactFlash).

■ ApplicationDataLocation = Device. The default is Device. It is recommended that you always 
install the data files on the device.

After you have edited the setup.ini file, follow the instructions for installing the Siebel Handheld 
application on the client.
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Setting the Siebel Handheld Application 
Restart Parameter
Because of the limited memory on handheld devices, users may find that the performance of the 
application degrades during the course of a handheld session. This is more likely to occur if the user 
is making many customer visits and carrying out transactions that involve intensive processing. To 
minimize the effects of these occurrences, the application can be restarted to release application 
memory that is not actively being used. The memory that becomes available allows for better 
performance in the next handheld session.

The application prompts the user to periodically restart the application. A dialog box appears with 
the message �For optimal application performance it is advised that you Restart your Siebel 
application by selecting File > Restart.� The user can restart the application or ignore the message. 

The application prompts the user after a specified number of visits, which is indicated by the number 
of times the user taps the End Visit button. The frequency with which this message appears is set 
with the PressureThreshold parameter in the setup.ini file. The default is:

PressureThreshold = 29

The message is triggered when the user taps the End Visit button N + 1 times, where N is the number 
specified by the parameter. For example, using the default value of 29, the message appears after 
the 30th time (29 + 1) that the user taps the End Visit button.

If the user restarts the application after the message appears, the application resets a counter to 0. 
If the user ignores the message and does not restart the application, the counter is not reset and, 
therefore, the message does not reappear.

Changing the SyncURL on Siebel 
Handheld Devices
Once the Siebel Handheld application is installed, the SycnURL cannot be changed. If you need to 
change the SyncURL, contact Siebel Technical Support.
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Installing the Siebel Handheld 
Application from External Media
You may create an image of the Handheld Installer that can be loaded onto external media such as 
a CompactFlash card. When you create a stand-alone installer platform, a Cabinet file (CAB) is 
created in a location that you specify. The CAB file name should be siebel.pocketpc_arm.CAB. You 
can copy the CAB file to a CompactFlash card, insert the card into the handheld device, and single-
click on the file to install the Siebel Handheld application on the device.

NOTE: When installing the application on the device, the end user is asked if he or she wants to 
install the application in the default directory. Regardless of the user's answer, the application is 
always installed in the directory specified by the setup.ini file. Therefore, the only way to change the 
directory the application is installed in is to modify the parameters in the ApplicationLocation section 
of the setup.ini file.

Creating a Stand-Alone Installer
Users who synchronize in DSS mode may not have a PC, and so may not be able to create a 
partnership and synchronize using Microsoft ActiveSync. You can install the application for each user 
through a standard partnership, or you can configure a stand-alone installer as shown in the 
following pages.

During the installation, the InstallShield Wizard screen prompts you by asking, Would you like to 
deploy a CAB file to enable rapid installation for additional devices? You can configure a stand-alone 
installer by selecting Yes.

You are prompted to select a language for the application and to specify a location for the CAB file. 
The installer creates the CAB file in the location you specify.

The CAB file is a self-extracting file that includes all the files needed to install the Siebel Handheld 
application on the handheld device. When you single-click the file, the CAB file installs the 
application.

Distributing Siebel Handheld Application 
Patches
The Siebel Handheld patch delivery mechanism, PatchAgent, is a tool that automates the deployment 
of patches to handheld devices as part of the synchronization process. It allows administrators to 
distribute patches to end users with minimal involvement by the users.

During synchronization the PatchAgent executable is called, and if it detects a handheld patch, it 
automatically installs the patch on the handheld device. In order for PatchAgent to detect and deploy 
the patch, the patch files must be created and placed in the directory where PatchAgent expects to 
find the files.
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Deploying Patches to the Handheld Application with 
Direct Server Sync
In order to set up patch deployment for Direct Server Sync users, you need to patch the Siebel server 
and patch one handheld client which serves as the �model� from which patch files are pulled. Then 
the patch files are then packaged and placed in the location on the server where PatchAgent expects 
to find the files. The next time the end user synchronizes with Siebel server, the patch is installed 
onto his or her device. 

For more information on how the patch process works with synchronization, see �Downloading 
Patches to the Handheld Device� on page 91.

To set up patch deployment

1 On Siebel server, verify that the following directories exist. If they do not, create the directories.

■ C:\patch\AppBinDir

■ C:\patch\WinDir

NOTE: You may specify a drive other than C:. However, the directory names must be specified 
as shown.

2 Apply the patch to Siebel server.

3 Apply the patch to one handheld client.

4 Contact Siebel Technical Support to obtain the list of files to copy from the handheld directory 
(My Device\Program Files\Siebel Handheld) to the Siebel server directory (C:\patch\AppBinDir).

5 Contact Siebel Technical Support to obtain the list of files to copy from the handheld directory 
(My Device\Windows) to the Siebel server directory (C:\patch\WinDir).

6 From the DOS prompt, change directory to Siebel Root\SWEApp\BIN.

7 Execute the following command to stage the patch files and the patchlist.txt in the correct 
location on the server:

C:\Siebel Root\SWEApp\BIN>createpatchlist /s c:\patch /t c:\Siebel 
Root\sweapp\cepatch

/s � source directory. The directory where the patch files were moved.

/t � target directory. The directory where PatchAgent checks for the patch files.

NOTE: You may specify a drive other than C:. However, the location of the source and target 
directories must be specified exactly as shown.

After the patch files have been moved and the patch list created, the following message appears: 
�Patch List has been successfully created in Siebel Root\SWEApp\cepatch files transferred 
successfully.�

The patch files are now ready to be deployed to Direct Server Sync end users. 
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Deploying Handheld Application Patches with 
Companion Sync
In order to set up patch deployment for Companion Sync users, you need to create a �model� of a 
patched Siebel Mobile Web Client and a patched handheld client. Then you pull the designated patch 
files and place them in the correct directory on the end user�s Mobile Web Client. You may use Siebel 
Anywhere to create upgrade kits to automate this process of distributing patch files to your end 
user's Mobile Web Client. The next time the end user uses Companion Sync to synchronize their 
handheld device with the Siebel Mobile Web Client, the patch is installed on the device. 

For more information on how the patch process works with synchronization, see �Downloading 
Patches to the Handheld Device� on page 91.

To set up patch deployment

1 On Siebel server, verify that the following directories exist. If they do not, create the directories.

■ C:\patch\AppBinDir

■ C:\patch\WinDir

2 Apply the patch to Siebel server.

3 Apply the patch to Siebel Mobile Web Client.

This Mobile Web Client serves as the model from which the patch files can be pulled.

4 Apply the patch to one handheld client.

This handheld client serves as the model from which the patch files can be pulled.

5 Contact Siebel Technical Support to obtain the list of files to copy from the model handheld 
directory (My Device\Program Files\Siebel Handheld) to the Siebel server directory 
(C:\patch\AppBinDir).

6 Contact Siebel Technical Support to obtain the list of files to copy from the model handheld 
directory (My Device\Windows) to the Siebel server directory (C:\patch\WinDir).

7 From the DOS prompt, change directory to C:\Siebel Root\SWEApp\BIN.

8 Execute the following command to move the patch files to the correct location and generate a 
patchlist.txt file:

C:\Siebel Root\SWEApp\BIN>createpatchlist /s c:\patch /t c:\Siebel 
Root\sweapp\cepatch_xxx (where xxx is the language [enu, esn, and so on])

/s � source directory. The directory where the patch files were moved.

/t � target directory. The directory where PatchAgent checks for the patch files.

NOTE: You may specify a drive other than C:. However, the location of the source and target 
directories must be specified exactly as shown.

After the patch files have been moved and the patch list created, the following message appears: 
�Patch List has been successfully created in Siebel Root\SWEApp\cepatch_xxx files transferred 
successfully.�
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9 Create the following directory on the end user�s Mobile Web Client: Siebel 
Root\client\cepatch_xxx (where xxx is the language [enu, esn, and so on]), and push the files 
from the \Siebel Root\SWEApp\cepatch_xxx directory on Siebel server to the Siebel 
Root\client\cepatch_xxx on the Mobile Web Client.

NOTE: Siebel Anywhere upgrade kits can be used to carry out this step.

Creating Handheld Application Upgrade Kits to 
Remotely Deploy Patch Files 
NOTE: This step is optional. Additionally, you must have a license for Siebel Anywhere to remotely 
distribute patches to end users.

You may use Siebel Anywhere upgrade kits to remotely distribute self-extracting zip files to your end 
users� PCs. You can use self-extracting zip files to create new directories and immediately extract 
files into the directories. Create one upgrade kit for each of the following:

■ Create the Siebel Mobile Web Client upgrade kit (Siebel Client Revisions). 

Create a single, self-extracting zip file that includes the upgraded .exe and .dll files in the Siebel 
Root\client\BIN directory on the model Mobile Web Client. Contact Siebel Technical Support to 
obtain the list of files to include. Configure the zip file to self-extract in the Siebel Root\client\BIN 
directory on the end user�s Mobile Web Client.

■ Create the Siebel Handheld upgrade kit (Siebel Client Revisions).

Create a self-extracting zip file that includes the files in the Siebel Root\SWEApp\cepatch 
directory on the server. Configure the zip file to self-extract in the \client\cepatch directory on 
the end user�s Mobile Web Client.

■ Create any other upgrade kits as needed (for example, the Siebel Customer Repository File).

Refer to Siebel Anywhere Administration Guide for information on creating upgrade kits.

NOTE: If there are read-only files on the Mobile Web Client, the end user may need to change the 
file attributes to read-write before receiving and installing the upgrade kits. Contact Siebel Technical 
Support for the list of files whose attributes need to be changed. You may use Siebel Anywhere to 
distribute a batch script that makes this change.

Downloading Patches to the Handheld Device
Patches are downloaded as part of the synchronization process. Once the patch is staged, the patch 
is downloaded the next time the end user synchronizes the handheld with Siebel server. The end user 
synchronizes as he normally would using Direct Server Sync or Companion Sync. First, any 
transactions are uploaded from the handheld device. Then:

■ If a patch needs to be applied to the handheld, the synchronization process terminates, and the 
patch process is started, which downloads the patch.
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■ If no patch needs to be applied, the synchronization process continues until the process is 
complete.

After a successful patch installation, Siebel Handheld Sync will launch automatically and continue the 
extraction. 

If the patch files are not successfully downloaded, the end user is prompted to restart the patch 
process. The end user must locate and launch patchagent.exe manually. Then, once the patch is 
successfully installed, the end user is prompted to complete the synchronization.
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7  Synchronization Conflict 
Handling and Recovery with 
Handheld
This chapter includes the following topics:

■ �Preventing Synchronization Transaction Conflicts with Siebel Handheld� on page 93

■ �Recovering Error Data in Siebel Handheld� on page 98

Preventing Synchronization Transaction 
Conflicts with Siebel Handheld
When multiple end users synchronize with a remote database, transaction conflicts may occur which 
can result in data loss. The Extended Pick and Extended Insert functionality minimizes 
synchronization conflicts. If transaction conflicts are unavoidable, then Siebel Handheld Journaling 
captures the transaction information so that the data can be recovered. The combination of Extended 
Pick, Extended Insert, and journaling eliminates the potential for data loss.

There are two features that minimize synchronization transaction conflicts.

■ Extended Pick processing

■ Extended Insert processing

The next several sections describe these features in detail.

Extended Pick Processing in Siebel Handheld
The handheld is used to capture and record transactions entered by the handheld user. During 
synchronization, these transactions are processed on the server. A situation may arise in which a 
transaction fails when it is applied to the Siebel server (through Direct Server Sync) or Siebel Mobile 
Web Client (through Companion Sync)�both of which are referred to as �server.� For example, a 
Siebel Handheld user creates a professional call activity for one of his contacts. However, since he 
last synchronized with the server, the contact involved in this transaction was deleted from the server 
database. When he tries to synchronize his handheld, the server does not find his contact, and the 
call activity for the contact cannot be inserted into the server database. To generalize this example, 
any transaction that involves data selected through picklists or pick applets fails on the server if that 
pick data is not present at the time of synchronization.

With many handheld users synchronizing with Siebel server and modifying data at different times, 
this scenario is not uncommon.
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The following describes how a pick transaction is recorded on the handheld device and processed on 
the server during synchronization. Assume that the handheld user wants to create a new call activity 
for the contact. In order to do this, the user inserts a new record in the Professional Call screen and 
�picks� the desired contact. When the contact is selected on the handheld, the Row Id of the contact 
(Contact Id) is recorded. However, on the handheld, the application does not record any of the pick 
map fields associated with the contact; only the Contact Id is recorded. When the user synchronizes 
his handheld, that Contact Id is used to locate the contact record in the server database. The Contact 
Id is then used to retrieve all of the fields used in the pick map for the Contact Id (Last Name, First 
Name, Middle Initial, Address, City, State, Zip Code, and so on).

In order to minimize pick processing failures, the handheld must record the pick row Id and all of 
the pick map data that is required for a successful transaction. This data must be recorded at the 
time of the pick, so that it can be passed to the server for processing. This enhanced functionality is 
called Extended Pick processing. Now, when the user synchronizes, the transaction is processed on 
the server as follows:

■ The synchronization process first looks for the pick record on the server database. For example, 
to add an activity it looks for the contact and, if it finds the contact, it retrieves the necessary 
data and adds the activity. This is the default behavior. 

■ If the server does not find the pick map record in the database and extended pick processing is 
enabled, it retrieves the pick record Id and pick map data from the handheld transaction and 
applies the data directly to the server.

Enabling Extended Pick Processing in Siebel Handheld
You can enable Extended Pick processing through the Application Administration screen in the Mobile 
Web Client. The parameter is as follows:

DefaultHandheldSyncPickMode

This parameter, when enabled, applies globally throughout the application. When enabled, every 
handheld pick transaction is subject to pick processing.

To enable extended pick processing

1 From the application-level menu, choose Navigate > Site Map > Administration-Mobile > 
Application Administration.
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2 Click the Settings view tab, then Query on the following value:

DefaultHandheldSyncPickMode

If there is no such record, a new record with that value should be created. See Table 20 for the 
values to enter. 

■ Business component user property.

The user property is defined on specific business components. The syntax for setting Extended 
Pick on a business component and the parameter values (Table 21) follow:

HandheldSyncPickMode=Fieldname|Mode

You may apply Extended Pick processing to multiple fields in a single business component, using 
the following syntax:

HandheldSyncPickMode=Fieldname1|Mode1, Fieldname2|Mode2

The setting on the business component takes precedence over the setting defined in the Settings 
view. For example, you can use the business component setting to nullify the global application 
of Extended Pick. See �Extended Insert Processing in Siebel Handheld� on page 96 for an example. 
Conversely, you can enable Extended Pick processing on specific business components if the 
setting in the Settings view has disabled the functionality.

Table 22 shows the combined effect of the settings in the Application-Mobile > Settings View and on 
a business component.

■ The DefaultHandheldSyncPickMode setting is omitted from application settings. 

Table 20. Business Component User Property Parameters

Business Component User 
Property Mode Value Description

DefaultHandheldSyncPickMode NoFail Turns Extended Pick processing ON.

FailOnError Turns Extended Pick processing OFF 
This is the default behavior if the 
parameter is not specified in the 
Settings view.

Table 21. Business Component User Property Parameters

Business Component 
User Property Parameter Value Description

HandheldSyncPickMode Fieldname � Specify the field name as defined in 
Siebel Tools.

Mode NoFail Turns Extended Pick processing ON.

FailOnError Turns Extended Pick processing OFF.
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■ If there is no setting on a particular business component, the setting defined in the Settings view 
applies.

■ If there is no setting defined in the Settings view, or on the business component, the default 
behavior is for Extended Pick to be turned OFF.

Extended Insert Processing in Siebel Handheld
When the server executes an insert transaction and the insert fails, there are two ways the insert 
failure can be handled:

■ A record is logged that indicates the insert failed, and synchronization continues. This is the 
default insert behavior. The Conflict Administration screen can be used to recover the data.

■ The insert failure is logged, including details of the failure, and synchronization is interrupted. 
This is the extended insert behavior. Extended insert behavior guarantees that, should an insert 
fail, data loss does not occur since synchronization is stopped until the circumstances causing 
the failure are resolved.

NOTE: If Extended Insert processing takes place, synchronization is interrupted. The 
synchronization process continues to fail until the problem is resolved. End users must contact their 
system administrators to recover from the failure. The recovery effort may involve modifying 
transactions queued for processing, modifying data on the server, or reentering transactions through 
the Siebel Handheld application.

Enabling Extended Insert Processing
You can, optionally, have a setting with the following setting name: 

DefaultHandheldInsertMode.

This parameter, when enabled, applies globally throughout the application. When enabled, every 
failed insert interrupts synchronization.

You can enable Extended Insert processing through the Settings view in the Administration-Mobile 
screen.

Table 22. Combined Effect of Extended Pick Settings

Business Component Setting

DefaultHandheldSyncPickMode=

Application Settings Value

DefaultHandheldSyncPickMode=

NoFail FailOnError Omitted 

NoFail NoFail NoFail NoFail

FailOnError FailOnError FailOnError FailOnError

Omitted NoFail FailOnError FailOnError
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Table 23 shows the settings for this parameter.

■ Business component user property.

The user property is defined on specific business components. The setting in the business 
component takes precedence over the setting defined in the Settings view. Table 24 shows the 
syntax for setting the Extended Insert on a business component and the parameter values.

HandheldInsertFailMode=Mode

Table 25 shows the combined effect of the setting in the Settings view and the setting on a business 
component.

■ The business component setting always takes precedence over the settings defined in the 
Administration-Mobile > Settings view. 

■ If there is no setting on a particular business component, the Applications Settings value applies.

■ If there is no setting in either the Settings view or on the business component, the default 
behavior is for Extended Insert to be disabled.

Table 23. Extended Insert Processing Parameter Setting

 Parameter
Mode 
Value Description

DefaultHandheldInsertMode NoFail Disables Extended Insert processing. 

FailOnError Enables Extended Insert processing.

Table 24. Business Component User Property Parameter

Business Component 
User Property Parameter Value Description

HandheldInsertFailMode Mode NoFail Disables Extended Insert processing.

FailOnErr
or

Enables Extended Insert processing.

Table 25. Combined Effect of Extended Insert Settings

Business Component 
Setting

HandheldInsertFailMode=

Application Settings Value

DefaultHandheldInsertMode=

NoFail FailOnError Omitted

NoFail NoFail NoFail NoFail
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Recovering Error Data in Siebel 
Handheld 
Synchronization errors are captured to the database, and can be accessed through the Conflict 
Administration screens. This mechanism is always enabled.

To access error data

1 From the application-level menu, choose Navigate > Site Map > Administration-Mobile > Conflict 
Administration. 

2 Click the Error Details view tab.

FailOnError FailOnError FailOnError FailOnError

No Setting on Business 
Component

NoFail FailOnError NoFail

Table 25. Combined Effect of Extended Insert Settings

Business Component 
Setting

HandheldInsertFailMode=

Application Settings Value

DefaultHandheldInsertMode=
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Application
This chapter includes the following topics:

■ �Preparing To Upgrade From a Previous Siebel Handheld Release� on page 99

■ �Installing on the Siebel Handheld Application� on page 99

■ �Reinstalling the Siebel Handheld Application� on page 102

■ �Uninstalling the Siebel Handheld Application� on page 103

■ �Preparing the Siebel Handheld Application for Barcode Scanning� on page 103

Preparing To Upgrade From a Previous 
Siebel Handheld Release
Siebel Handheld 7.7 does not support upgrades from previous releases of Siebel Handheld 
applications. To upgrade your existing application and to migrate your data and settings to Siebel 
7.7 use the following process. 

■ Back up the handheld device by synchronizing to your database. See, �Synchronizing Data on the 
Siebel Handheld Device� on page 115.

■ Uninstall your Siebel Handheld application. See, �Uninstalling the Siebel Handheld Application� on 
page 103.

■ Then install the new version of your Siebel Handheld application. See �Installing on the Siebel 
Handheld Application� on page 99.

Installing on the Siebel Handheld 
Application
There are two ways to install software onto any Windows-powered handheld device. The first is to 
create a partnership between a desktop or laptop PC and the handheld device using Microsoft 
ActiveSync. The second is to install the application from type of external media. See �Reinstalling the 
Siebel Handheld Application� on page 102 for more information.

NOTE: It is important to remember that end users must synchronize their handheld devices to 
download the application configuration and populate the database before they can use the 
application. Therefore, an administrator may install the application for an end user, but the 
synchronization must occur using the end user�s name and password.
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Installing Handheld for Companion Sync Users
Before you install and use Companion Sync (CS) with the Siebel Handheld application, you must first 
install the Siebel Mobile client on your PC. The Mobile Client Installer copies the Companion Sync 
files to your personal computer. 

NOTE: Users can only use Companion Sync to synchronize their Siebel Handheld application to a 
personal computer that already has the Siebel Mobile client installed. 

To install the Siebel Handheld application and Siebel Handheld Sync using CS

1 Using Microsoft ActiveSync, establish a partnership between the handheld device and the 
personal computer.

2 On the PC, network, or DVD, locate the folder where the Siebel Handheld Application folder is 
installed. In this folder, double-click setup.exe.

3 Choose the language you want to use for the installation and click OK.

The Welcome Screen appears. 

4 Click Next.

The Synchronization Options screen appears. 

5 Choose the Companion Sync option and click Next.

6 Select the desired language of the Siebel Handheld application and click Next.

A window appears showing the setup status, followed by several DOS windows, and the Add/
Remove Programs dialog box.

7 At the Installing Applications dialog box, click Yes to install in the default directory.

NOTE: The default directory in the Applications dialog is the directory specified by the system 
administrator in a setup file. So that the application works correctly, the Siebel Installer installs 
the application in the default directory. Therefore, even if you specify a different location for the 
application, the application is installed in the default location.

The Siebel Handheld application is installed on the handheld device. During the installation, the 
Installing Applications dialog box displays a progress bar.

It may take several minutes to install on the handheld device. When the application has been 
downloaded to the handheld device, the Application Downloading Complete dialog box appears 
on the PC. 

8 Click OK.

A message appears informing you that setup has finished installing the Siebel Handheld 
application on your computer.

9 Click Finish.

The Siebel Handheld icon appears in the Start > Programs screen on the handheld device.
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After installing the Siebel Handheld application and Siebel Handheld Sync, you must perform an 
initial synchronization before you can use the application. If you are installing the application for the 
first time on the device, synchronize the Siebel Remote database with Siebel Server, then 
synchronize the Siebel Handheld and Siebel Remote databases. See �Synchronizing Data on the Siebel 
Handheld Device� on page 115 for the procedure for synchronizing your data.

See Chapter 5, �Data Filtering,� for more information on using Companion Sync and setting filters.

Installing Handheld for Direct Server Sync Users
Most DSS users do not have access to a PC for creating a partnership with their handheld device. In 
this case, the administrator has to create partnerships with each user's device and install the 
application. Siebel Handheld applications can be installed in DSS mode using the Siebel Installer as 
described in this section.

To install the Siebel Handheld application using DSS

1 Using Microsoft ActiveSync, establish a partnership between the handheld device and the PC.

2 On the PC network or DVD-ROM, locate the folder where the Siebel Handheld Application folder 
is installed, then double-click setup.exe.

The installation process begins.

3 From the Choose Setup Language window, choose the language you want to use for the 
installation and click OK.

4 At the Synchronization Options screen, choose the Direct Server Sync option and then click Next.

The next screen displays and asks, �Would you like to deploy a CAB file to enable rapid 
installation for additional devices?�

NOTE: If you want to create a stand-alone installer, choose Yes, and then click Next. See 
�Reinstalling the Siebel Handheld Application� on page 102 for details.

5 To install the application on the device, click Next.

6 Select the desired language of the Siebel Handheld Application, and click Next.

A window appears showing the setup status, followed by several DOS windows.
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7 The Add/Remove Programs dialog appears. This is followed by the Installing Applications dialog 
that asks if you want to install in the default directory. Click Yes to install the Siebel Handheld 
application on the handheld device.

NOTE: The default directory in the Applications dialog is the directory specified by the system 
administrator in a setup file. So that the application works correctly, the Siebel Installer installs 
the application in the default directory. Therefore, even if you specify a different location for the 
application, the application is installed in the default location.

The Siebel Handheld installation automatically installs SSCE Service Pack 1 and overwrites 
existing files on your system. A message may appear asking if you want to replace existing files. 
Respond by tapping �Yes to All.�

During the installation, the Installing Applications dialog box displays a progress bar. It may take 
several minutes to install on the handheld device. When the application has been downloaded to 
the handheld device, the Application Downloading Complete dialog box displays on the PC.

8 Click OK.

A window appears informing you that setup has finished installing the Siebel Handheld 
application on your computer.

9 Click Finish.

The Siebel Handheld and Siebel Handheld Sync icons appear in the Startup screen on the handheld 
device.

After installing the Siebel Handheld application and Siebel Handheld Sync, you must perform an 
initial synchronization before the application can be used. Refer to �Synchronizing Data on the Siebel 
Handheld Device� on page 115 for the procedure for synchronizing your data.

See Chapter 5, �Data Filtering,� for more information on using Direct Server Sync and setting filters.

Reinstalling the Siebel Handheld 
Application
Follow the steps below to reinstall or upgrade your Siebel Handheld application.

To reinstall or upgrade the Siebel Handheld application

1 Before you reinstall the current application, you must first uninstall the current application on 
your device. See �Uninstalling the Siebel Handheld Application� on page 103 for more information.

2 Once you have uninstalled the application, you may then reinstall the application or install the 
newer version. See �Installing on the Siebel Handheld Application� on page 99, and follow the 
instructions for installing the Siebel Handheld application.

3 Synchronize your Siebel Handheld application. See �Synchronizing Data on the Siebel Handheld 
Device� on page 115 and follow the instructions for synchronizing your data.

NOTE: If you are using Companion Sync to synchronize your data, synchronize the Siebel 
Handheld database with the Siebel Remote database.
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Uninstalling the Siebel Handheld 
Application
Uninstalling the application deletes the database files as well as the application files.

CAUTION: Before you uninstall your application, you must synchronize your database to save any 
changes to your data since the last synchronization. If you do not synchronize before uninstalling, 
these changes will be lost. See �Synchronizing Data on the Siebel Handheld Device� on page 115 and 
follow the instructions for synchronizing your data.

To uninstall the Siebel Handheld application

1 Select Start > Settings.

2 Select the System tab and tap Remove Programs.

3 From Remove Programs, select the Siebel Handheld application and tap Remove.

NOTE: A dialog box appears saying that a file cannot be deleted. This occurs because a file may 
still reside in memory. Ignore this message and tap OK to delete all application and database 
files. No additional steps are required to remove the application and database files.

Preparing the Siebel Handheld 
Application for Barcode Scanning
If you are going to scan barcodes when performing a cycle count, you need to associate the scan 
trigger with a button on the handheld device. 

This assumes that you have already installed the drivers for the scanner you are using with your 
handheld device. For latest information on supported scanners, please refer to System Requirements 
and Supported Platforms on Siebel SupportWeb. 

To associate the scan trigger with a button on the handheld device

1 Select Start > Settings.

The Personal Settings tab appears.

2 Tap the Buttons Icon.

A table listing the assigned programs is displayed. For example, Button 1 is assigned to Calendar, 
and so on.

3 Select the button to which you want to associate the trigger. For example, Button 1.

4 Tap the Button assignment drop-down list. 

5 Select SocketTrigger from list of programs.

NOTE: You cannot use Button 5 (assigned to Record) as the device button to trigger the scan.
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9 Working with Siebel Handheld 
Applications
This chapter includes the following topics:

■ �Components of the Siebel Handheld Interface� on page 105

■ �Navigating the Siebel Handheld Interface� on page 108

■ �Navigating a List of Records in the Siebel Handheld Application� on page 109

■ �Entering Data with the Siebel Handheld Application� on page 110

■ �Finding and Querying Data in the Siebel Handheld Application� on page 110

■ �Printing with the Siebel Handheld Application� on page 112

■ �Exporting Data with the Siebel Handheld Application� on page 112

■ �Calendar and Calendar Views in the Siebel Handheld Application� on page 113

■ �Setting User Preferences in the Siebel Handheld Application� on page 113

■ �Backing Up and Restoring Data with the Siebel Handheld Client� on page 114

■ �Synchronizing Data on the Siebel Handheld Device� on page 115

■ �Synchronization Troubleshooting with the Siebel Handheld Client� on page 119

■ �Improving Siebel Handheld Application Performance� on page 120

Components of the Siebel Handheld 
Interface
The components of the handheld interface include the Screens menu, Show drop-down list, 
application-level menu, Queries drop-down list, toolbar, and status bar.
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Figure 3 shows the components of the Siebel Handheld application. 

Screens Menu
The screens menu is the first level of navigation in the Siebel Handheld application. When you launch 
the Siebel Handheld application for the first time, this tab is labeled Screens unless you have 
configured a start up view to appear. When you tap the screens menu, a drop-down list of all 
available screens appears. Tap the desired screen in the list to navigate to it. 

For information about configuring a start up view, see �Setting User Preferences in the Siebel Handheld 
Application� on page 113. 

Show Drop-Down List
The Show drop-down list is the second level of navigation in the Siebel Handheld application. This is 
where you choose views for the selected screen.

Application-Level Menu
The application�level menu consists of the File, Edit, View, and Help menus. Tap a menu to select a 
menu option. The options that are available in each menu vary depending on the task you are 
performing.

Figure 3. Siebel Handheld Screen Components
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Queries Drop-Down List
Up to two predefined queries (PDQs) are displayed in the Queries drop-down list. The list displays 
the query chosen when you synchronized (or the default filter if you did not change the Set Filters 
selection) and the All Records query, if it is defined. For more information, see Chapter 5, �Data 
Filtering.�

Siebel Toolbar
The Siebel toolbar has buttons for frequently used functionality like record navigation and querying. 
You can configure your toolbar and specify which buttons are displayed. See �Configuring User 
Interface Elements in Siebel Handheld� on page 24. 

■ Tap the New Record button to add a new record to the active list or form.

■ Tap the Back button to navigate to the previous view.

■ Tap the Forward button to navigate to the view you were in before you selected the Back button.

■ Tap the Record Navigation buttons to move through records in a form or a list.

■ Tap the New Query button to begin a new query in a form or a list.

■ Tap the Execute Query button to run the query you just created.

■ Tap the Maximize Minimize Applet button to expand the active applet so that it is the only applet 
displayed and takes up the entire screen display. This allows you to see more columns or more 
rows of data at one time. Tap again and the screen displays two applets.

Customizing the Toolbar
You can customize which buttons appear on your toolbar by selecting View > Customize Toolbar from 
the application menu.

To add and remove buttons from the toolbar, drag and drop the desired buttons between the Choose 
Toolbar Buttons dialog box and the toolbar.

Minimize Button
The Minimize button appears in the upper right corner of your window. When you tap the Minimize 
button, the application minimizes, but does not close. To reopen the minimized application, from the 
Start menu, tap the Siebel Handheld icon. To close (exit) the application, choose File > Exit.

Do not confuse the Minimize button that appears in the upper right corner with the Maximize 
Minimize Applet button that appears on the Toolbar.

Status Bar
The status bar appears at the bottom of the application window. It provides information about the 
current view. 
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Navigating the Siebel Handheld 
Interface
Navigating the Siebel Handheld application is achieved through the screens menu, the Show drop-
down list, drilling down, drilling across, toolbar buttons, and toggling.

Screens Menu
The screens menu provides the first level of navigation. Here you select the screen you want to work 
in. For more information about the screens menu, see �Components of the Siebel Handheld Interface� 
on page 105.

Show Drop-Down List
The Show drop-down list is the second level of navigation. After you have selected a screen from the 
screens menu, select a view from the Show drop-down list. Views in the Show drop-down list are 
specific to each screen.

Toggling Between Applets
A maximum of two applets can be displayed at one time in a Siebel Handheld application. In 
situations where there are more than two applets configured and a Toggle button has been 
configured, you may tap the Toggle button on the applet. Or you may select View > Toggle from the 
menu to toggle between applets.

Expandable Fields
Due to the limited screen size on the handheld, it is not always easy to view the data in a field without 
scrolling or resizing the field width. Therefore, some fields that could contain large amounts of text 
are expandable�that is, the data can be viewed in a text box. An ellipsis (...) appears in the field to 
indicate that the field is expandable. When you tap the ellipsis, a text box opens showing the data 
in that field. When you step off the field, the text box closes.

In form applets, an ellipsis is always visible in those fields that are expandable. However, in list 
applets, due to space constraints, the ellipsis is not always visible in expandable fields. When you 
tap on an expandable field in a list applet, the ellipsis appears. Once the ellipsis appears, you tap 
the ellipsis to open the text box.

URLs in Applet Fields
Tapping on a field that contains a URL value launches the URL in Microsoft Internet Explorer.
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Navigating a List of Records in the Siebel 
Handheld Application
Within the view you select from the Show drop-down list, you can view detailed information on a 
record. When records are displayed in a list, you can drill down or drill across the record to get 
additional details.

Drilling down occurs when you tap a hyperlink in a record and are taken to another view within the 
current screen. For example, if you are in the Accounts screen, and tap the Account Name hyperlink, 
you navigate to the details for that account. You do not leave the Accounts screen; you just move 
deeper into it.

NOTE: Hyperlinks are indicated by blue underlined text as long as they are set up this way in User 
Preferences. For more information see �Setting User Preferences in the Siebel Handheld Application� 
on page 113.

Drilling across a record occurs when you tap a hyperlink in a record and are taken to another view 
in a different screen. For example, tapping a hyperlink in the Accounts column of a contact record in 
the Contacts screen takes you to the record for that account in the Accounts screen.

Dynamic drilldown occurs when you tap a hyperlink in a record and are taken to another screen or 
just another view. Where you navigate to depends on the content in the drilldown field. 

History Arrows
To navigate back to views you have recently displayed, tap the Back button. After you have used the 
Back button, you can use the Forward button to navigate back to your original screen and view.

NOTE: The History arrows only allow you to navigate between views. These arrows do not allow you 
to recover data that may have been entered or deleted in another view.

Record Navigation Buttons
Use the Record Navigation buttons to move back and forth though a set of records. The navigation 
buttons are described in Table 26. 

Table 26. Record Navigation Buttons

Button Description

Navigates back to the previous record in the list or form.

Navigates forward to the next record in the list or form.

Navigates back a view based on the navigation history. You can define 
which views are part of the history. If a view is set to not be recorded 
as part of the history, the back button won't go back to that view.
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Entering Data with the Siebel Handheld 
Application
There are several different methods for entering data in the Siebel Handheld application. Tap the up 
arrow next to the Input Panel button to select a method. See the user guide for your device for 
information on using the different input methods.

Working with Columns in the Handheld Client
Data is displayed in lists and forms in your Siebel Handheld application. You can organize and work 
within it in a number of ways to better suit your needs.

There are several ways in which to organize columns in a list. You can:

■ Sort data by up to three columns

■ Resize columns

■ Change the order in which the columns appear

■ Show and hide columns

■ Lock columns for horizontal scrolling

You can sort records in a list by tapping in the column header of the column in which you want to 
sort the records. If the green column sort indicator points up, the column is sorted in ascending 
order. If it points down, the column is sorted in descending order.

If you need to sort by more than one column, you can open the Sort Order dialog box to sort up to 
three columns at one time. Open the Sort Order dialog box by choosing from the application-level 
menu.

Resize columns by tapping and dragging the divider between the column headings until the column 
is the desired size.

You can change the order of columns using the Columns Displayed dialog box. Open the Columns 
Displayed dialog box by choosing 

Show and hide columns using the Columns Displayed dialog box. In the Available columns list, select 
the items you want to show and tap the arrow to move the selected items to the Selected columns 
list. To hide columns, select the items and tap the arrow to move the selected items to the Available 
columns list.

Lock or unlock columns by tapping and holding the column header.

Finding and Querying Data in the Siebel 
Handheld Application
You can search for data using the Find or Query functionality in your Siebel Handheld application.
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About Find in Handheld
Use Find to do a simple search for a record. You can access Find by choosing Edit > Find View > 
Find... from the application-level menu. This launches the Find dialog box, in which you can enter 
your search criteria. The asterisk wildcard function (*) can be used in the search criteria. Figure 4 
shows an example of the Find dialog window with the following fields: Look In, Last Name, Type, Last 
Call Date, Primary Specialty, and Rep Specialty.

NOTE: There may be a slight variation in your version of Siebel software, and the Find dialog box 
may not look exactly as shown here. 

About Queries in Handheld
Use Query to locate a number of records containing a specific set of criteria. There are a number of 
ways in which to perform query tasks in your Siebel Handheld application.

Creating a Query
To begin a query, you can choose  from the application-level menu, or you can tap the New Query 
button on the toolbar. Both provide you with a blank form or list where you can enter your query 
criteria, depending on where you are in the application when you invoke the command. The asterisk 
wild card function (*) can be used in the search criteria.

Executing a Query
After you have created the query, you can execute it by choosing  from the application-level menu 
or by tapping the Execute Query button in the toolbar.

Refining a Query
You can refine your current query by choosing from the application-level menu.

Figure 4. Find Dialog Box
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Printing with the Siebel Handheld 
Application
You may print from any view in the Siebel Handheld application that has been configured to support 
printing. When you print from the handheld, a document that has been configured for the view is 
printed. You can print directly to a printer, or, if you are not connected to a printer at the time, you 
can queue your print jobs and wait until you have access to a printer to print your documents.

NOTE: When you print from a view, you are not necessarily printing what is visible on the screen at 
the time. Every field on the screen may not be relevant for the document. The document may contain 
only a portion of what is in the view, and it may also contain data that is not viewable at the time. 
A separate applet, which often cannot be viewed in the user interface, is configured specifically for 
printing.

The print templates used to generate the printed are installed during the time of setup.

For a list of supported printers, see the system requirements and supported platforms documentation 
for your application, see System Requirements and Supported Platforms on Siebel SupportWeb.

Print from the Siebel Handheld application by choosing File > Print. If you are connected to a printer, 
the print job runs. If you are not connected to a printer, the print job is sent to a print queue. View 
the print queue by choosing File > Print Queue.

Exporting Data with the Siebel Handheld 
Application
You may export data from any view in your application in HTML format or as tab delimited text and 
save it to a file. This file can be viewed in applications such as Microsoft Pocket Word, Microsoft 
Pocket Excel, and Internet Explorer.

To export data, select File > Export... to open the Export dialog box.

In the Export dialog box, you may specify the following:

■ Format. Specify either HTML or Tab delimited text file. 

■ Export. Select Only active applet to export only the data in the active applet. Select All applets 
in view to export the data in all visible applets. 

■ Output file name. By default, the file is saved in the temp directory with the filename �output.� 
You may tap Browse to specify a different location or filename.

■ Paste Output to Clipboard. Select the checkbox to save the data to the clipboard.
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■ Open file. Select the checkbox to automatically open the file. When you tap OK in the Export 
dialog box, the data is exported to the specified file, and the file is automatically opened.

NOTE: You must specify a valid output format for the application. See Table 27 for the correct 
formats to specify for the supported applications.

Calendar and Calendar Views in the 
Siebel Handheld Application
To view your calendar, choose Calendar from the screens menu.

You can view your calendar in a monthly, a weekly, or a daily format. To navigate within the calendar, 
select the calendar view you want to see from the Show drop-down list.

Customizing the Calendar
You can customize aspects of your calendar from the User Preferences view. For more information, 
see �Setting User Preferences in the Siebel Handheld Application� on page 113.

Setting User Preferences in the Siebel 
Handheld Application
You can customize aspects of your Siebel Handheld application from the User Preferences dialog box. 
Access the User Preferences dialog box by choosing from the application-level menu.

In the User Preferences dialog box you can:

■ Set a default startup screen.

■ Set number of maximum history threads to be saved.

■ Set the maximum percentage of the display area that the parent applet can take up.

■ Change font size.

Table 27. Export Data Options

To export data to Do the following

Microsoft Word Set Format to �Tab delimited text file.�

Microsoft Excel Select the �And paste output to clipboard� check box. 
The Output format may be set either to HTML or �Tab 
delimited text file.� Paste the data from the clipboard 
into an Excel spreadsheet.

Microsoft Internet 
Explorer

Set Format to HTML.
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■ Customize list spacing, column width settings, and grid lines.

■ Customize your calendar�s default view, start time, time slot interval, and default appointment 
duration.

■ Specify screen aesthetics such as alternating colors for rows and showing drilldown sources as 
hyperlinks.

Backing Up and Restoring Data with the 
Siebel Handheld Client
It is recommended that you back up your data to an external device�for example, a CompactFlash 
card or a Secure ID card. If the handheld device is damaged, the backup may not be retrievable. If 
you store your backups in RAM, depending on the size of your application and data extract, you may 
decrease the amount of memory available for the application, and your application performance may 
suffer.

Automatic Backup After Synchronization
The automatic backup feature must be enabled in the application by your System Administrator. If 
the backup feature is enabled, a backup is automatically created at the end of every synchronization. 
This way, you have an up-to-date snapshot of the database. You must never synchronize your data 
to the handheld device and then restore the database using an older copy of the database. If you 
do, the next time you synchronize, the application tries to rewrite changed transactions. This can 
cause data integrity problems. Therefore, when the database backup feature is enabled, a database 
backup occurs automatically at the end of each synchronization. Keep in mind that this makes the 
overall time to synchronize somewhat longer. The size of the database and the speed of the 
CompactFlash card also affect the time it takes to complete synchronization.

Backing Up Data
The following procedure describes how to back up the database on the handheld device.

To back up the database

1 From the application-level menu, choose File > Backup.

NOTE: If the Backup menu item is disabled, contact your system administrator to have backup 
enabled in your application.

A dialog box appears, telling you that backing up the data will restart the application and prompts 
you to confirm that you want to continue.
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2 Tap Yes to start the backup.

A status dialog box appears indicating that the backup is in progress and may take a few minutes. 
The Handheld configuration files and data is copied to the backup location specified in the 
setup.ini file. Typically, the backup location is a CF or SD card. In some cases, the location is a 
directory in memory.

A dialog box appears telling you whether the backup succeeded and asks if you want to return 
to the application.

3 Tap Yes to return to the application.

NOTE: If the backup fails, consult your system administrator.

Restoring Data from a Backup
In order to restore the application to its previous state, the user should contact the system 
administrator. Any work performed on the handheld device since the last backup will be lost.

To restore the database

1 Remove the external flash card from the damaged device and place it in a new handheld device 
where the application has been installed.

2 Navigate to the \Program Files\Siebel Handheld folder.

3 Start the restore by tapping the BackupUtility file twice.

A dialog box appears, asking you to confirm that you want to restore the device from a previous 
backup.

4 Tap Yes.

A status dialog box appears, indicating that the restore is in progress. The backup utility restores 
the files to the state when the backup was performed. A dialog box appears telling you if the 
restore was successful. If successful, it asks you to confirm that you want to restart the Siebel 
Handheld application.

5 Tap Yes to start using the application.

Synchronizing Data on the Siebel 
Handheld Device
You must synchronize the data on your handheld device:

■ After you install or upgrade the Siebel Handheld application.

■ Before uninstalling the Siebel Handheld application.

■ On a regular basis to keep your data synchronized with Siebel Server and Siebel Mobile Web 
Client.
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The sections that follow describe how to synchronize using Companion Sync (CS), Direct Server Sync 
(DSS) and Direct Server Sync via Proxy (DSSvP), and provide some troubleshooting tips.

Using Siebel Handheld Synchronization with the 
Handheld Client
Siebel Handheld Synchronization differs depending on whether users synchronize through 
Companion Sync or Direct Server Sync. The following procedures show how to launch and use 
Handheld Synchronization for each method.

NOTE: A given user can only synchronize using one method. For example, it is not possible to install 
a Siebel Handheld application that a particular user will synchronize both to the Siebel Mobile Web 
Client database through Companion Sync and also to the Siebel Server database directly through 
Direct Server Sync.

Using Companion Synchronization with the Handheld 
Client
End users that synchronize their data using Companion Sync must follow a three-step process to 
synchronize their handheld, remote, and server databases. Immediately before and after every 
Siebel Remote sync, you must perform a Companion Sync. This process can be time consuming for 
the end user and difficult for the administrator to enforce. 

Integrated Sync eliminates the need for you to initiate three separate sync sessions for each Siebel 
Remote sync. Integrated Sync is a one-button process that automatically initiates each of the 
following synchronization steps:

1 Handheld Upload and Processing�Handheld transactions are uploaded to the companion PC and 
processed.

2 Siebel Remote Synchronization�The Siebel Mobile Client is synchronized with Siebel server. 
Transactions on the mobile client database are uploaded to Siebel server, and changes to Siebel 
server are downloaded to the mobile client database.

NOTE: If there is a handheld patch staged on the server, synchronization terminates and the patch 
is installed. After the patch installation is completed, the handheld user is prompted to synchronize 
again (using either Integrated Sync or Companion Sync) to complete the data extraction and 
download (that is, Step 3). It is critical that the handheld user synchronize a second time after the 
patch installation is completed. If he fails to do so, he is not able to start the Siebel Handheld 
application.

3 Handheld Data Extract and Download�Data is extracted from the mobile client database to the 
handheld device database.

You may use Companion Sync to synchronize your handheld with Siebel Mobile Client as many times 
as you wish between Integrated Sync sessions. However, it is recommended that you conduct 
Integrated Sync sessions frequently so that the Siebel Remote synchronization process does not take 
long periods of time to complete and update conflicts are minimized.
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Synchronizing the Handheld Client for Companion Sync 
Users
When you synchronize, you have the option of either doing an Integrated Sync or Companion Sync. 
To do an Integrated Sync, select Perform Remote Sync when the Siebel Handheld Sync dialog box 
appears.

NOTE: You must close your Siebel Handheld application before synchronizing your application.

To perform Companion Sync

1 From the companion PC, establish a Microsoft ActiveSync connection to the handheld device. 

2 From the device, verify that the Siebel Handheld application is closed.

NOTE: On the Pocket PC 2003 operating system, the Minimize button (the button with the �X� 
in the top right corner of the application) minimizes but does not close the application. To close 
out the Handheld application in preparation for synchronization, you must use the File > Exit 
command.

3 From the companion PC, choose Start > Programs > Siebel Handheld Sync.

The Siebel Handheld Sync dialog box appears.

a Enter your user name and password.

b By default, Perform Remote Sync is selected. To perform an Integrated Sync, accept the default 
setting.

If you want to do Companion Sync only, then unselect the Perform Remote Sync box.

Selecting Bypass Set Filters skips the step of selecting the filters and immediately starts the 
synchronization process. If you select Bypass Set Filters, then the filters that you selected 
the last time you synchronized are used. If this is the first time you are synchronizing, then 
the default filters are used.

4 Tap Login.

5 Tap Set Filters.

The Filters dialog box appears.

6 From the Filter list box, select the screen for which you want to choose a filter.

7 From the Choose drop-down box, select the filter you want to associate with the screen you 
selected in Step 6.

NOTE: Tap Default Filters to restore the filter selection to the default setting.

8 Tap OK and tap Start to begin synchronization.

a The Siebel Handheld Sync dialog box appears. If �Perform Remote Sync� was selected, this is 
followed by the Siebel Remote dialog box. When synchronization has successfully completed, the 
Finished dialog box appears.
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b If a handheld patch needs to be installed, the synchronization process is interrupted and the 
patch is installed. After the patch is installed, you must restart Siebel Handheld Sync to complete 
the data extract process. If you fail to do this, you cannot start your application.

c The Finished dialog box appears indicating that the synchronization has successfully completed.

9 Tap OK to exit Siebel Handheld Sync.

NOTE: If synchronization errors occur, an error dialog box appears.

Using Direct Server Synchronization with the Handheld 
Client
There are two methods for synchronizing between the handheld device and the Siebel application 
server:

■ Direct Server Sync (DSS) provides synchronization between the Siebel Handheld application and 
the Siebel application server.

■ Direct Server Sync via Proxy (DSSvP) provides synchronization between the Siebel Handheld 
application and the Siebel application server, using the desktop or companion PC to provide the 
network connection between the handheld device and the server.

NOTE: You must close your Siebel Handheld application before you synchronize with the Siebel 
application server.

To synchronize with the Siebel application server

1 If you are synchronizing using DSS, create a direct network connection through a modem or a 
direct LAN connection.

If you are synchronizing using DSSvP, establish an ActiveSync connection between the handheld 
device and the PC.

2 From the device, verify that the Siebel Handheld application is closed.

3 From the device, choose Start > Programs > Siebel Handheld Sync.

The Siebel Handheld Sync dialog box appears.

4 Enter your user name and password.

Selecting Bypass Set Filters skips the step of selecting the filters and immediately starts the 
synchronization process. If you select Bypass Set Filters, then the filters that you selected the 
last time you synchronized are used. If this is the first time you are synchronizing, then the 
default filters are used. 

5 Tap Login.

The Siebel Handheld Sync dialog box appears.

6 Tap Set Filters.

The Filters dialog box appears.
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7 From the Filter list box, select the screen for which you want to choose a filter.

8 From the Choose drop-down box, select the filter you want to associate with the screen you 
selected in Step 6.

NOTE: Tap Default Filters to restore the filter selection to the default setting.

9 Tap OK, and then tap Start to begin synchronization.

NOTE: If a handheld patch needs to be installed, the synchronization process is interrupted and 
the patch is installed. After the patch is installed, you must restart Siebel Handheld Sync to 
complete the data extract process. If you fail to do this, you cannot start your application.

The Finished dialog box appears indicating the synchronization has successfully completed.

10 Tap OK to exit Siebel Handheld Sync.

NOTE: If synchronization errors occur, an error dialog box appears.

Synchronization Troubleshooting with 
the Siebel Handheld Client
This section lists potential error messages that are associated with synchronization. In addition, this 
section explains how to fix transaction errors.

General Synchronization Errors
There are a number of different errors that can occur when synchronization does not complete 
successfully, for example: 

■ Faulty wire connection

■ Server crash

■ Insufficient memory

■ Login error

When these errors occur, the user should exit Siebel Handheld Sync and launch the application again.

NOTE: When you restart Siebel Handheld Sync, you may see an error message that says that 
another instance of syncmanager.exe is running. You are asked whether you want to terminate the 
first instance or not, and you should choose Yes.

Transaction Conflicts
Transaction conflicts are minimized when customers adhere to the standard configuration practices 
outlined in this document. However, even when proper configuration practices are followed, conflicts 
can occur for a variety of reasons. For example, if a field value is updated on both the handheld client 
and the server between synchronization events, a transaction update conflict occurs. In this 
instance, the user is presented with an error dialog after synchronization has completed.
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A transaction consists of one or more smaller transactions called mini-transactions. For example, if 
you update several fields in a record, the update to the record counts as a single transaction, and 
each update to a field is a mini-transaction. The Siebel Handheld application behaves in the same 
way as the Siebel Web application in that if any part of the transaction fails, the entire transaction 
fails. Assume, for example, that you update four fields in a record. If, during synchronization, three 
fields update correctly and one field fails to be updated, none of the fields in the record is updated.

Improving Siebel Handheld Application 
Performance
If you find that the performance of the Siebel Handheld application is very slow or begins to degrade, 
the following can help to improve the application performance:

■ Verify that your device meets the minimum memory requirements. See System Requirements 
and Supported Platforms on Siebel SupportWeb.

■ When you run the Siebel Handheld application, it is recommended that you do not run any other 
applications. By doing so, you maximize the amount of memory that is available to run the 
application.

■ Increase the amount of memory that is allocated for running applications.

■ Installing the binaries to a CompactFlash card. For more information, see �Setting up Siebel 
Handheld Application Installation on a CompactFlash Card� on page 86.

To increase application memory

1 From the Start menu, select Settings.

2 Select the System tab and tap Memory.

3 Move the slider bar so that more memory is allocated to Program Memory, then tap OK.
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10 Using Siebel Medical Handheld
This chapter includes the following topics:

■ �About Using Siebel Medical Handheld� on page 121

■ �Managing Accounts in Siebel Medical Handheld� on page 122

■ �Working with Contacts in Siebel Medical Handheld� on page 129

■ �Working with Sales Methods in Siebel Medical Handheld� on page 133

■ �Developing Opportunities in Siebel Medical Handheld� on page 133

■ �Managing Activities in Medical Handheld� on page 137

■ �Developing Quotes in Medical Handheld� on page 141

■ �Managing Orders in Medical Handheld� on page 145

■ �Tracking Expenses in Medical Handheld� on page 147

■ �Creating General Activities in Siebel Medical Handheld� on page 149

■ �Managing MedEd Events in Medical Handheld� on page 151

■ �Managing Consigned Inventory with Siebel Medical Handheld� on page 153

■ �Managing and Performing Cycle Counts with Medical Handheld� on page 155

■ �Moving Inventory with Medical Handheld� on page 161

■ �Analyzing Inventory with Medical Handheld� on page 166

About Using Siebel Medical Handheld
Siebel Medical Handheld provides medical field representatives with tools and information to 
effectively execute sales related tasks at point of contact. Given the fragmented and highly 
diversified nature of the medical device industry, the main point of contact for an account can be 
either a sales representative or service representative. Siebel Medical Handheld is designed to allow 
sales and service professionals to have one view of the customer enabling key tasks such as 
managing information on contacts and accounts, tracking opportunities, performing cycle counts, 
and tracking consigned inventory.

This chapter is designed to show you how to use Siebel Medical Handheld. Business scenarios 
accompany each major topic and illustrate key tasks you can perform using Medical Handheld. Your 
company might follow a different sequence according to its business requirements. 

Using Siebel Medical Handheld, field sales representatives and field service engineers can manage 
accounts and contacts, manage activities associated with these accounts and contacts, view medical 
education events and invite contacts to these events, track opportunities, generate orders and 
quotes, view products, and manage consignment inventory.
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Managing Accounts in Siebel Medical 
Handheld
An account is any healthcare business that generates sales for your company or potentially could 
generate business. Typical examples of accounts include hospitals, clinics, HMOs, wholesalers, group 
purchasing organizations (GPOs), and pharmacies. An account can also be any organization with 
which multiple contacts are associated, such as a group practice or an assisted-living facility.

Siebel Medical Handheld allows you to manage and track information on accounts. 

The following topics related to accounts and account management are included in this section:

■ �Creating Accounts in Medical Handheld� on page 122

■ �Affiliating Contacts with Accounts in Medical Handheld� on page 125

■ �Specifying the Best Time to Call on an Account in Medical Handheld� on page 125

■ �Viewing Sales Data in Medical Handheld� on page 126

■ �Logging and Tracking Service Requests in Medical Handheld� on page 126

■ �Entering Private Notes for Accounts in Medical Handheld� on page 127

■ �Entering Shared Notes for Accounts in Medical Handheld� on page 128

■ �Associating Activities with Accounts in Medical Handheld� on page 128

■ �Tracking Opportunities with Accounts in Medical Handheld� on page 129

Scenario for Managing Accounts in Medical Handheld
This scenario gives one example of how you can use Siebel Medical Handheld to manage accounts. 
You might use Siebel Medical Handheld differently, depending on your business model. 

A radiologist in a hospital is interested in a company�s new MRI machine. The sales representative 
sets up a time for a sales call later in the week. 

During the sales call, the sales representative asks a number of questions to determine the account 
structure of the radiologist�s business to help the representative determine how to best fill her needs. 
The sales representative learns that the prospect�s business has a total of four locations, and that 
sales and service are billed through the main office, although each location receives a billing 
statement.

After the sales representative meets with the radiologist, she uses Siebel Medical Handheld to edit 
information on the account.

Creating Accounts in Medical Handheld
When you identify a possible lead, the lead can be added as an account. You can then begin to add 
and track information about the account.
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Multiple employees can be assigned, as a team, to an account. Any employee assigned to the team 
can update the account's information. A user who adds an account is automatically designated as 
the primary account team member. However, he or she can also be added to an account team created 
by another user, such as a manager. 

To create an account

1 Navigate to the Accounts screen.

The My Accounts list appears.

2 Tap the New Record button.

3 In the Name field tap the ellipsis (...), then enter a name for the account, then select More Info.

4 In the More Info view, complete the necessary fields.

Some fields are explained in the following table: 

To add account addresses

1 Navigate to the Accounts screen.

2 In the My Accounts list, select the account record.

3 From the Show drop-down list, choose Addresses.

4 In the Account Addresses view, tap the Addresses list to select it, and then tap the New Record 
button.

Field Comments

Name Required. Name of the account. 

Account Type Required. Name of the account. For example, 
Hospital, Pharmacy, Practice, Clinic, and so on).

Site Physical location of the account.

Status Customer designated status of the account. (For 
example, active, suspended, inactive, new and 
so on).

Main Phone # Phone number for the account.
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5 Complete the fields for the address, and tap the Primary field to display a check mark if this is 
the primary address for the account.

Some fields are explained in the following table:

To add additional account information

1 Navigate to the Accounts screen.

2 In the My Accounts list, select the desired account.

3 From the Show drop-down list, select More Info.

4 Complete the fields to add additional information.

Some fields in the More Info form are described in the following table: 

Field Comments

Primary Check flag defining whether address is the 
primary address for the account.

Address Line 1 Required. Typically, street address, floor or 
suite. 

City A required field.

State Required. In two letter format. For example, CA, 
NY, and so on.

Field Comments

Site Physical location of the account. 

Route The route number as decided by your company. This is a 
predefined list of values, set up by your administrator. Values 
appear as a drop-down list.

Account Type A predefined list of values. For example, Planning Group.

Mkt Potential You may designate this field to indicate its potential for sales. 
A predefined list of values includes High, Medium, and Low.

Account Team Displays the primary sales representative for the sales team 
assigned to the account. 

Status You designate the current status of an account with this field. 
For example, Suspended, Qualified, or Active.
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Affiliating Contacts with Accounts in Medical Handheld
A contact is a doctor, surgeon, hospital administrator, nurse, or someone else associated with a 
hospital, clinic, and so on. Accounts can be, for instance, hospitals, pharmacies, HMOs, clinics, or 
group practices. As you continue to work closely with a prospective account, professional contacts 
associated with the account become important. Contacts can belong to multiple accounts, but only 
one of them can be the primary account.

To affiliate a contact with an account

1 Navigate to the Accounts screen. 

The My Accounts list appears.

2 In the My Accounts list, select the account to which the contact will be added.

3 From the Show drop-down list, select Affiliations.

4 Tap the Affiliations list to select it, then tap the New Record button.

5 Tap in the Last Name field of the new record. 

The Pick Contact picklist appears. 

6 Choose a contact, and tap OK.

7 In the Affiliations list, tap the Direct field to make it active, then check the box to indicate 
whether the contact is a direct affiliation. 

Specifying the Best Time to Call on an Account in 
Medical Handheld
You enter Best Times to Call an account in the Accounts screen. Using the Best Times to Call view, 
you can enter the best times to call an account based on a selected address. 

To specify the best time to call on an account

1 Navigate to the Accounts screen and select an account from the My Accounts list. 

2 From the Show drop-down list, choose Best Times to Call. 

3 Tap the Best Times to Call list, then tap the New Record button. 
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4 Enter the necessary data. 

The fields in the Best Times to Call list are described in the following table:

Viewing Sales Data in Medical Handheld
Sales data can be analyzed to measure market potential, target customers, align sales territories, 
and track market shifts. Sales data is typically syndicated information that is loaded periodically by 
the Siebel administrator. 

You can review this information using the Sales Data view. 

To view sales data

1 Navigate to the Accounts screen, and select an account from the Accounts list.

2 From the Show drop-down list, select Sales Data.

3 Review the data in the list on a product-by-product basis.

Logging and Tracking Service Requests in Medical 
Handheld
You log new service requests and track the status of service requests for each account on the 
Accounts screen.

To enter a new service request

1 Navigate to the Accounts screen and select an account from the My Accounts list. 

2 From the Show drop-down list, choose Service Requests. 

3 Tap the Service Requests list, then tap Log New SR. 

The Service Request detail view appears.

Field Comments

Start Day A required field. Tap in this field, then choose desired day from 
a drop-down list. 

Start Time A required field. Tap in this field, then choose the desired time 
from a pop-up window.

End Time A required field. Tap in this field, then choose the desired time 
from a pop-up window.

Comments Tap the ellipsis (...) then enter any comments.
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4 Choose the severity of the service request from the Severity drop-down list, then fill in the 
remaining fields. 

Some fields are described in the following table:

Entering Private Notes for Accounts in Medical Handheld
You enter Private Notes from the Accounts screen. Private Notes are those which can only be seen 
by you. 

To enter private notes

1 Navigate to the Accounts screen and select an account from the My Accounts list. 

2 From the Show drop-down list, choose Private Notes.

3 Tap the Private Notes view, then tap the New Record button.

The Date Created field is automatically populated.

4 Tap the ellipsis (...) and enter the text for your note, then tap out of the field to close the note. 

Field Comments

SR # System generated value.

Summary Tap the ellipsis (...) to enter a summary of the service request.

Status Chose from a list of values.

Sub-Status Chose from a list of values.

Priority Choose a value from 1 to 4, with 1 representing the highest 
priority.

Area Choose a service request area, such as Emergency Repair or 
Complaint.

Sub-Area Choose a service request sub-area, such as Product 
Information or Finance Complaint.

Asset # Enter asset, serial, or product ID number.

Symptom Pick a symptom code, such as New Part Defective or OS 
Problem.

Resolution Choose the appropriate resolution, such as Upgrade Part or 
Documentation Error.

Rate List List of current rates for service items.

Price List List of current prices.

Cust Descript Tap the ellipsis (...) to enter a customer description of the 
service request.
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Entering Shared Notes for Accounts in Medical Handheld
You enter notes to be shared across your team from the Accounts screen. Shared notes are shared 
with all employees that are part of a given account. 

To create shared notes

1 Navigate to the Accounts screen and select an account from the My Accounts list. 

2 From the Show drop-down list, choose Shared Notes.

3 Tap the Shared Notes view, and then tap the New Record button.

The Date Created field, and the Created By field are automatically populated.

4 Tap the ellipsis (...), enter the text for your note, and then tap out of the field to close the note.

Associating Activities with Accounts in Medical 
Handheld
An activity is a task or event that is generally, but not always, performed for a contact, account, or 
opportunity. You will likely have many meetings, calls, presentations, and other activities 
surrounding an account. 

Activities provide a place to enter and track this information. If the activity entered has a time 
associated with it, it will appear on the Activities and Calendar screens.

To associate activities with accounts

1 Navigate to the Accounts screen.

2 In the My Accounts list, select the account with which the activity will be associated.

3 From the Show drop-down list, select Activities.

4 In the Account Activities view, tap the Activities list to select it, and then tap the New Record 
button.

5 In the new row, complete the necessary fields.

The Type field defaults to Other. The fields are described in the following table:

Field Comments

Type A required field. From the drop-down list, choose an activity 
type, such as Call or Maintenance.

Description Enter a description of the activity, such as Hospital Visit or 
Quarterly Maintenance.

Status Enter the status of the activity, such as In Progress or 
Unscheduled.
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6 Tap the default activity Type hyperlink to display the Activities screen�s More Info view.

7 In the More Info form, add and edit details about the activity. 

For more information, see �Creating Activities in Medical Handheld� on page 138.

Tracking Opportunities with Accounts in Medical 
Handheld
Accounts are a source of business for your company. An opportunity is a potential revenue-
generating event and is another type of information that you can use to manage your accounts within 
Medical Handheld.

For more information on opportunities, see �Developing Opportunities in Siebel Medical Handheld� on 
page 133. 

To add an opportunity to an account

1 Navigate to the Accounts screen.

The My Accounts list appears.

2 In the My Accounts list, select the account to which the opportunity will be associated.

3 From the Show drop-down list, choose Opportunities.

4 In the Account Opportunities view, tap the Opportunities list to select it, and then tap the New 
Record button.

5 In the Opportunities list, complete the necessary fields for the new record.

The Account field is automatically populated with the name of the selected account. Sales stage 
selections are based on the sales methods used by your organization.

Working with Contacts in Siebel Medical 
Handheld
A contact is typically a physician, nurse, hospital administrator, or lab technician, and so on. 
purchasing officer, nurse, physician, or hospital administrator. In a more general sense, a contact is 
any individual a medical device company deems significant to their business process.

Priority Enter a value from 1 to 4, with 1 representing the highest 
priority.

Due Enter a date for the activity to be completed.

Field Comments
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Sales representatives use Medical Handheld to add and update contact profile information which may 
include adding new contacts, tracking affiliations between contacts and accounts, transcribing 
relevant notes, and tracking sales data.

This section describes how to manage contact information using all of the views accessible from the 
drop-down list in the Contacts screen. 

The following topics related to opportunities are included in this section:

■ �Adding Contacts in Medical Handheld� on page 130.

■ �Associating Accounts to Contacts with Medical Handheld� on page 131

■ �Associating Contacts with Opportunities in Medical Handheld� on page 131

■ �Adding Private or Shared Notes About a Contact in Medical Handheld� on page 133

■ �Adding Private or Shared Notes About a Contact in Medical Handheld� on page 133

■ �Adding Private or Shared Notes About a Contact in Medical Handheld� on page 133

Scenario for Managing Contacts in Medical Handheld
This scenario gives one example how you can use Siebel Medical Handheld to manage contacts. You 
might use Siebel Medical Handheld differently, depending on your business model. 

At a trade show, a sales representative exchanges business cards with the people she meets. Instead 
of waiting until she returns to her office, the sales representative uses Siebel Medical Handheld to 
enter essential contact information. When she returns to her office, she identifies individuals that 
might be possible sources for leads.

As the sales representative works with each contact, the possibility of doing business�an 
opportunity�may arise. If so, she can then create an opportunity and associate contacts and 
activities with it to track important milestones and key players for closing the deal.

Adding Contacts in Medical Handheld
Using the Contacts screen and the My Contacts view, you can add contacts and update contact 
information directly in Medical Handheld. 

To add contacts

1 Navigate to the Contacts screen.

2 From the Show drop-down list, select My Contacts, or Personal Contacts.

■ My Contacts: Use this list for contacts that you might or might not share with the rest of your 
organization.

■ Personal Contacts: Use this list for contacts that are not shared with the rest of your 
organization.

3 Tap the New Record button, then fill the Last Name and First Name fields.
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4 From the Show drop-down list, choose More Info, and then complete additional fields, as needed.

The following table describes some fields in the Contact form.

Associating Accounts to Contacts with Medical 
Handheld
A contact can be associated to several accounts. For example, a surgeon can be affiliated to a group 
practice and several hospitals. You can keep track of all the accounts your contact is affiliated to in 
the Contact Affiliations view.

To associate an account to a contact

1 Navigate to the Contacts screen.

The My Contacts list appears.

2 In the My Contacts list, select the contact to whom the opportunity will be associated.

3 From the Show drop-down list, choose Affiliations.

4 Tap in the Affiliations list, then tap the New Record button.

The Pick Account list appears.

5 Select an Account, and Tap OK.

Associating Contacts with Opportunities in Medical 
Handheld
A contact may be a source of revenue for your company. Potential revenue-generating events are 
called Opportunities. You will want to associate a contact with an existing opportunity to track 
information about both the opportunity and the contact. For more information, see �Creating 
Opportunities in Medical Handheld� on page 134.

Field Comments

Job Title A text field where you key in the job title of the contact.

Contact Method A drop-down list where you can chose the preferred contact method.

Site Physical location of the account.

Comments Tap this field, then enter comments. Comments entered are visible 
depending on the type of contact define. For instance, if you�re creating
a contact in the My Contacts list, the comments entered for that contact
will be visible by other members of your team.
Siebel Medical Handheld Guide Version 7.7 ■ 131



Using Siebel Medical Handheld ■  Working with Contacts in Siebel Medical Handheld
To associate a contact with an existing opportunity

1 Navigate to the Contacts screen.

The My Contacts list appears.

2 In the My Contacts list, select the contact with whom the opportunity will be associated.

3 From the Show drop-down list, choose Opportunities.

4 Tap in the Opportunities list, then tap the New Record button.

The Add Opportunities list appears.

5 In the Add Opportunities list, select the opportunity to associate with the contact, and then tap 
OK.

To associate a contact to a new opportunity

1 Navigate to the Contacts screen.

The My Contacts list appears.

2 In the My Contacts list, select the contact with whom you will associate the new opportunity.

3 From the Show drop-down list, choose Opportunities.

4 Tap in the Opportunities list, then tap the New Record button.

The Add Opportunities list appears. 

5 Tap New, then enter the necessary fields. 

The fields are described in the following table: 

Field Comments

Name The name of the product.

Account This field will be automatically populated with the account 
to which you are associating the opportunity. 

Revenue Tap the ellipsis to enter currency type, amount, and 
exchange date.

Probability From the drop down-list in this field, you can chose a 
probability figure.

Close Date After tapping the calender button in this field, choose a 
close date for the chosen opportunity from the pop-up 
window.

Sales Stage From the drop-down list in this field, choose the present 
stage of the sale.

Primary The account owner, or primary contact for the account in 
your organization.
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Adding Private or Shared Notes About a Contact in 
Medical Handheld
Using the Private Notes and Shared Notes views, you can create and update notes on contacts. 
Private notes are visible only to the creator of the note; shared notes are available to other sales 
representatives calling on the contact.

To add notes about contacts

1 Navigate to the Contacts screen, and select a contact from the My Contacts list.

2 From the Show drop-down list, select one of the following:

■ Private Notes. Limits access to the note to the person creating it.

■ Shared Notes. Allows all account team members to access the note.

3 Tap the New Record button, then in the note field, enter your note data.

To enlarge the Note field, tap the ellipsis (...).

Working with Sales Methods in Siebel 
Medical Handheld
A sales method is a formalized approach or methodology used during the sales process. A sales 
method can encompass all activities associated with the sales process, from prospecting to 
forecasting to closing deals. This approach allows sales representatives to use the most appropriate 
method for opportunities. 

The application administrator will create and implement the sales stages your company uses, and 
then establish values in your Siebel application that represent these methods and stages. A 
recommended business practice is to designate a default sales method in your Siebel application. 
This practice allows a sales method to be associated with each opportunity and aids in charting and 
reporting accuracy.

Sales methods can differ within a company. For instance, a sales method for managing a complex 
multimillion dollar opportunity may include 15 stages, while a sales method for a simple low-dollar 
opportunity may require only four stages.

For more information about creating or implementing sales stages, see Applications Administration 
Guide.

Developing Opportunities in Siebel 
Medical Handheld
An opportunity is defined as a potential revenue-generating event. An opportunity is usually 
associated with an account and one or more contacts, products, activities, and quotes.

Examples of opportunities are:
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■ At a trade show, a company representative expresses interest in purchasing a product.

■ When called by a telesales representative, a contact indicates interest in contracting 
maintenance services.

■ In a conversation with an existing client, the client expresses an interest in upgrading to the 
newest product model.

■ While on a regularly scheduled visit, a Sales Rep finds out that one of the MRI machines has 
broken down and convinces his contact in that hospital to take a look at his company�s MRI 
machine.

■ In a conversation with a doctor regarding a newly launched drug-coated stent, the doctor 
expresses interest.

The following topics related to opportunities are included in this section:

■ �Creating Opportunities in Medical Handheld� on page 134.

■ �Working with Sales Methods in Siebel Medical Handheld� on page 133.

■ �Associating a Contact with an Opportunity in Medical Handheld� on page 136.

■ �Associating a Product with an Opportunity in Medical Handheld� on page 136.

■ �About Opportunity Quotes� on page 137.

Scenario for Developing Opportunities in Siebel Medical 
Handheld
This scenario gives one example of how you can use Siebel Medical Handheld to develop sales 
opportunities. You might use Siebel Medical Handheld differently, depending on your business model. 

A sales representative is involved in revenue-generating and customer contact activities at her 
company. At a trade show she meets a prospective customer who could be a lead for a new business 
opportunity. Using her Medical Handheld application, the sales representative discovers that the 
company is listed in Siebel Medical as an account, but the person she met is not listed as a contact 
associated with the account.

After adding this person as a contact, the sales representative creates the opportunity. Next, the 
sales representative schedules meetings, records the associated activities, and associates other 
important contacts with the opportunity.

As the sales process continues, the sales representative gathers and updates information about the 
account, its contacts, and the opportunity. As the relationship grows, the sales representative can 
add, view, and share information and key knowledge with other members of the sales team.

Creating Opportunities in Medical Handheld
Each time you identify an opportunity, you should create a new record. You create new opportunity 
records in the Opportunity screen.
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To create an opportunity

1 Navigate to the Opportunities screen, and from the Show drop-down list, choose My 
Opportunities.

The My Opportunities list appears.

2 Tap the New Record button, and complete the necessary fields.

3 Some of the fields are explained in the following table.

Field Comments

Name Required. A value that identifies the opportunity.

Account Allows you to associate an opportunity with an account. 

Description A text area for additional information about the opportunity.

Site A default value that populates automatically when you associate the 
opportunity with a specific account and location.

Primary Displays the primary Sales Team member for the opportunity. 

Revenue Allows you to enter the currency amount of the opportunity. This field 
defaults to zero.

Probability % Allows you to enter the percentage of confidence you have that the deal wil
close with the specified revenue on the specified close date. Probability 
automatically updates based on the Sales Method and Sales Stage selected

Expected Value Displays a currency value that is calculated based on the potential revenue
field multiplied by the value in the probability field. A lower percent in the 
probability field reduces the expected value that will be included in your 
revenue forecast.

Close Date Required. Allows you to enter the expected date on which the opportunity wil
close. The default date is the same as the Created Date. It is important to 
modify the date, if the opportunity will close on a different date, since this 
date is used in revenue forecasting.

Lead Quality A list of values established by your company that allows you to rank the 
quality of the lead. Default values include 1-Excellent, 2-Very High, 3-High,
4-Fair, 5-Poor.

Sales Method A list of values established by your company that list the sales 
methodologies. For more information, see �Working with Sales Methods in 
Siebel Medical Handheld� on page 133.

Sales Stage A list of values established by your company that lists the sales stages 
associated with the sales method you selected. 
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Associating a Contact with an Opportunity in Medical 
Handheld
As you work with an opportunity, you will want to maintain information about the contacts associated 
with the opportunity. 

The Opportunities screen�s Contacts view allows you to associate and review contact-related 
information for an opportunity.

To associate a contact with an opportunity

1 Navigate to the Opportunities screen, and from the Show drop-down list choose My 
Opportunities.

2 In the My Opportunities list, select the opportunity with which you want to associate a contact.

3 From the Show drop-down list, choose Contacts.

4 Tap the Contacts list to select it, and then tap the New Record button.

5 In the Add Contacts dialog box, select the contact or contacts you wish to add, and then tap OK.

NOTE: You can also associate new contacts with opportunities.

Associating a Product with an Opportunity in Medical 
Handheld
Specific products can be associated with an opportunity. For example, if a customer is interested in 
purchasing a new product model, this information can be entered in the Products view.

After the information is entered, you can tap the product to find additional information such as 
product features and prices.

To associate a product with an opportunity

1 Navigate to the Opportunities screen. 

The My Opportunities list appears.

2 In the My Opportunities list, select the opportunity with which you want to associate a product.

3 From the Show drop-down list, choose Products.
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4 In the Opportunity Products view, tap the Products list to select it, and then tap the New Record 
button.

Some fields in the Products list are described in the following table:

5 In the new row, tap in the Products field, then chose the desired product from the Pick Product 
picklist, and tap OK.

6 Tap the quantity field, the enter the desired number, the enter the price of the unit in the Net 
Price field.

The Extended Price field will be automatically filled in. 

7 Fill in the Delivery Date field.

8 Leave the Auto Quote field checked if you wish this association to be accessible to Auto Quote.

About Opportunity Quotes
The Opportunity Quotes view displays quotes that have been generated for a specific opportunity. 
After adding products to an opportunity in the Opportunity Products view, you can navigate to the 
Opportunity Quotes view to initiate Auto Quote functionality or to manually create a quote. For more 
information, see �Creating Quotes in Medical Handheld� on page 141.

Managing Activities in Medical Handheld
An organization�s records should accurately reflect the amount of work required and performed to 
maintain customer satisfaction. This practice avoids duplication of effort if a different or an additional 
team member has to get involved. It also keeps everyone up to date as to exactly what activities 
have occurred and when they have occurred.

Activities are various tasks or events that are performed for contacts, accounts, and opportunities. 
Activities that are given start times are automatically entered on the activities screen and your 
calendar. 

Field Comments

Product Tap in this field to receive a list of values from which you will 
chose the desired product.

Part Number This field is automatically filled based on your choice for the 
Product field.

Net Price Manually enter the unit price. 

Extended Price This price will be automatically calculated based on the figure 
you enter in the Quantity field.

Auto Quote By default this field is checked to indicate that you want to 
make this record available for auto quotes. Uncheck it if you 
want to make the record unavailable.
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The following activity management procedures are included in this section:

■ �Creating Activities in Medical Handheld� on page 138

■ �Delegating Activities in Medical Handheld� on page 138

■ �Associating Contacts with Activities in Medical Handheld� on page 139

■ �Adding General Activities Using the Calendar in Medical Handheld� on page 139

Scenario for Managing Activities
This scenario gives one example of how you can use Siebel Medical Handheld to manage activities. 
You might use Siebel Medical Handheld differently, depending on your business model. 

While working away from his desk, a sales manager receives a call from a customer who wants to 
visit the sales manager�s company for an executive summary meeting. The customer also wants the 
sales team to perform a product demonstration. The sales manager schedules the meeting using his 
handheld. After his next synchronization, the meeting appears on calendars of his team members. 
The sales manager delegates the tasks required to prepare for the meeting, such as preparing 
presentation slides, reserving a conference room, and configuring the demo system. These activities 
appear in the sales manager�s Activities screen and calendar for the customer�s account.

As the sales manager and his team members complete the activities, the activities are marked as 
done, providing key status information about the opportunity.

Creating Activities in Medical Handheld
Throughout the day, you have new tasks to accomplish and activities to monitor. These activities are 
part of your business. By keeping track of these activity records on your handheld, you make sure 
your team members know about these tasks, and you create a valuable history of your past 
interactions with customers.

To create a new activity

1 Navigate to the Activities screen.

The My Activities list appears.

2 Tap the New Record button, and in the new row, complete the necessary fields.

A default value is provided in the activity Type field.

3 Tap the hyperlink value in the Type field, and in the More Info form, complete the fields.

Delegating Activities in Medical Handheld
If you work as part of a sales team or are the manager, an important part of managing your activities 
includes managing other people�s activities. When an activity needs to be performed by someone 
else, you can reassign or delegate it to an employee.
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To delegate an activity

1 Navigate to the Activities screen.

The My Activities list appears.

2 In the My Activities list, find the activity that needs to be delegated.

3 From the Show drop-down list, select Employees.

4 In the Activity Employees view, tap the Employees list to select it, and then tap the New Record 
button.

The Add Employees list appears.

5 In the Add Employees list, select the employees to whom the activity will be assigned, and tap 
OK.

To make an employee the primary for the activity, tap the Primary field to display a check mark.

Associating Contacts with Activities in Medical 
Handheld
When you add an activity to your calendar, you might also want to have a record of contacts who will 
be participating in the activity. 

To associate a contact with an activity

1 Navigate to the Activities screen.

2 In the My Activities list, select the activity with which a contact will be associated.

3 From the Show drop-down list, select Contacts.

4 In the Activity Contacts view, tap the Contacts list to select it, and then tap the New Record 
button.

5 In the Add Contacts picklist, select the contacts and then tap OK.

Adding General Activities Using the Calendar in Medical 
Handheld
General activities and appointments must have the Planned Start and Duration fields populated in 
order to be displayed in the correct time slot on the Daily Calendar view.

To add a general activity in the Calendar view

1 Navigate to the Calendar screen.

2 From the Show drop-down list, select Daily, Weekly, or Monthly.

3 For My Weekly or My Monthly, select the day on which you want to schedule a general activity.
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4 Tap the New Record button.

You may also tap an open time slot within the Daily view.

5 In the new record, complete the necessary fields for the appointment or task.

Some fields are described in the following table:

To specify contact participants

1 Navigate to the Calendar screen and locate the day the task or appointment occurs.

2 Tap the task or appointment hyperlink to display the Calendar form.

3 From the Show drop-down list, select Contact Participants.

4 In the Calendar Contacts view, tap the Contacts list to select it, and then tap the New Record 
button. 

5 In the Add Contacts dialog box, select contacts and tap OK.

To specify employee participants

1 Navigate to the Calendar screen and locate the day the task or appointment occurs.

2 Tap the task or appointment hyperlink to display the Calendar form.

If the appointment or task repeats over time, you will be asked to indicate if changes to the 
appointment should be applied to the specific occurrence, or to all occurrences. 

3 From the Show drop-down list, select Employee Participants.

4 In the Calendar Employees view, tap the Employees list to select it, and then tap the New Record 
button.

Field Comments

Type The type of activity. Activity types might be call, email-outbound, 
demonstration, and so on.

Planned 
Start

This date-time field defaults to the time selected when you created the new 
appointment.

Duration When the duration is updated, the planned completion time is automatically 
adjusted.

Account Complete this field if the activity is related to a particular account. 

Repeat Tap the check box to display a check mark if the appointment or task is 
recurring.

Siebel Handheld Calendar does not support modification of single instances of 
recurring activities. For example, if you delete or modify an appointment 
scheduled to recur daily for 10 days, the entire series will be deleted.

Until This field allows you to indicate the end date of a repeating appointment.
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5 In the Add Employees dialog box, select employees, and then tap OK.

Developing Quotes in Medical Handheld
When the customer is ready to purchase a product or service, you can develop a quote using Medical 
Handheld that includes specific prices for products and services with related payment terms. 

The following quote management procedures are included in this section:

■ �Creating Quotes in Medical Handheld� on page 141

■ �Using Auto Quote in Medical Handheld� on page 142

■ �Adding Quote Items in Medical Handheld� on page 144

■ �Printing Quotes in Medical Handheld� on page 145

■ �Managing Orders in Medical Handheld� on page 145

Scenario for Developing Quotes
This scenario gives one example of how you can use Siebel Medical Handheld to develop quotes. You 
might use Siebel Medical Handheld differently, depending on your business model. 

A mobile sales representative relies on quotes to create formal offers to clients for a variety of 
products and services that her company provides. Using Medical Handheld she can produce accurate 
offers at the customer site, with up-to-date product and pricing information. When details and pricing 
are finalized, the sales representative can print the quote and deliver it promptly to the customer.

Creating Quotes in Medical Handheld
Quotes includes effective dates, price lists, and discounts used in pricing products and services. 
Before any of this information can be added to a quote, however, the quote must be created with 
basic information.

To create a quote

1 Navigate to the Opportunities screen.

2 In the My Opportunities list, select the opportunity for which the quote will be generated.

3 From the Show drop-down list, select Quotes.

4 In the Opportunity Quotes view, tap the Quotes list to select it, and then tap the New Record 
button.

The new quote is automatically assigned a record identifier, a revision number, the default status 
of In Progress, and a created date.

5 In the Name field, enter a name for the quote.

When you tab to an adjacent field, the quote name becomes a hyperlink.
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6 Tap the hyperlink in the Name field to display the More Info form where you can add quote 
details.

Using Auto Quote in Medical Handheld
If you are working with an opportunity for which the products and solutions have already been 
specified in the Opportunity Products view, there is a faster method to generate a quote. You can use 
the Auto Quote button.

When Auto Quote generates a quote from an opportunity, quote line items are created for each 
product under the opportunity that has the Auto Quote flag checked. The Quote Item fields are 
populated from the corresponding Opportunity Product�s fields, as shown in Table 28.

In addition, information from the generated quote�s Quote # field is copied to the Opportunity 
Products� Quote # field. The Part Number field of the generated Quote Item is determined by the 
quote item's product. 

Table 29 shows the quote record fields that are automatically populated when Auto Quote is used to 
create a quote.

Table 28. Quote Item Fields Populated by Opportunity Product Fields

Opportunity Product Fields Quote Item Fields

Product Product

Product Quantity Extended Quantity Requested

Table 29. Quote Fields Populated with Auto Quote

Field Value

Quote # System generated

Revision 1

Name Quote number, unless the user provides another value

Opportunity The opportunity from which the quote is automatically generated.

Account The account for the opportunity

Account Site The location of the account associated with the opportunity

Status In Progress

Active Checked

Currency The currency code for the opportunity

Price List The price list associated with the opportunity�s account

Sales Rep User ID
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To create a quote using Auto Quote

1 Navigate to the Opportunities screen.

2 In the My Opportunities list, select the opportunity for which the quote will be generated.

3 From the Show drop-down list, select Quotes.

4 In the Opportunity Quotes view, tap Auto Quote.

Some of the fields are described in the following table:

5 Edit fields as necessary, and then tap the hyperlink in the quote Name field.

6 In the Quote detail form, enter additional information about the quote.

Some fields in the Quote detail form are described in the following table:

Effective Current date

Through Current date plus 30 days (30 days is determined by the 
QUOTE_EXPIRATION_PERIOD list of values.)

Field Comments

Quote # Read only. A unique, system generated identifier.

Revision Read only. Automatically generated value which reflects 
the revision state of the record.

Name Read only. An automatically generated hyperlink. Tap this 
field and the More Info view of the quote will appear, along 
with the opportunity for which the quote is being 
generated.

Status A drop-down list which enables you to choose the status 
of the quote, for instance, Closed, Accepted, Expired, and 
so on.

Price List Tap this field to access a picklist of preconfigured price 
lists.

Field Comments

Opportunity A hyperlink with the name of the opportunity. Tap this 
hyperlink to see details in the Opportunity detail view.

Account The account under which the opportunity is drawn.

Price List The name of the price list chosen in the Auto Quote view.

Table 29. Quote Fields Populated with Auto Quote

Field Value
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7 From the Show drop-down list, choose My Quote to review the quote. 

Adding Quote Items in Medical Handheld
Using the Quotes screen, you can add line items to quotes that you are developing. If the Auto Quote 
method is used, products associated with opportunities appear automatically as line items with any 
applicable discounts.

Line items can be used to:

■ Add new products as line items

■ Apply manual price adjustments to the line items using the Toggle button

To add line items

1 Navigate to the Opportunities screen.

2 In the My Opportunities list, select the opportunity with which the quote is associated.

3 From the Show drop-down list, select Quotes.

4 In the Opportunity Quotes view, locate the quote in the list, and tap the Name hyperlink.

The quote detail form appears.

5 From the Show drop-down list, select Quote Items.

6 In the Quote Line Items view, tap the Line Items list, and then tap the New Record button.

7 In the Line Items list, complete the required fields.

Quote Line Item price fields are automatically populated based on the product's price in the 
parent quote's price list.

Tap the Toggle button to display a form that you can use to add Item discounts and other 
adjustments.

To delete line items

1 Navigate to the Quotes screen.

Discount Tap for a list of values from which you can chose the 
discount percentage you�ll be giving the opportunity.

Sales Rep The name of the user.

Effective Chose from a calendar view to set the effective date for 
the quote.

Through Current date plus 30 days (30 days is determined by the 
QUOTE_EXPIRATION_PERIOD list of values.)

Field Comments
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2 In the My Quotes list, select the quote containing the line item that will be deleted, and choose 
Quote Items from the Show drop-down list.

3 In the Quotes Line Items view, select the quote item in the list.

4 From the Edit Menu, select Delete Record. 

NOTE: Quote revisions are not supported Siebel Handheld.

Printing Quotes in Medical Handheld
Once the customer has expressed significant interest, it is often appropriate to present a hard copy 
quote. 

To print a quote 

1 Navigate to the Quotes screen.

2 In the My Quotes list, select the quote containing the line items that will be printed.

3 From the Show drop-down list, select Quote Items.

4 Align the infrared ports on the handheld device and the printer.

5 In the parent Quotes form, tap the Print button.

Managing Orders in Medical Handheld
After you have completed the initial quote, and the customer has agreed to the products and prices 
you have presented, you create a sales order.

The following order management procedures are included in this section:

■ �Creating Orders in Medical Handheld� on page 145

■ �Adding Order Line Items in Medical Handheld� on page 146

■ �Entering Terms and Totals in Medical Handheld� on page 147

Creating Orders in Medical Handheld
You can create orders from quotes manually or by using the Auto Order button. 

To create an Auto Order from your quote

1 Navigate to the Quotes screen.

2 In the My Quotes list, select the quote from which an order will be generated.

3 From the Show drop-down list, select Orders.
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4 In the Quotes list, select the quote, and then in the Orders list tap AutoOrder.

A new record appears in the Orders list, with the order date, number, type, status and so on, 
filled in. 

5 In the Orders list, tap the Order # hyperlink.

6 Tap the Orders Line Items list to select it, and then tap the New Record button.

7 A new row appears in the Line Items list.

8 Tap the Select button in the Products field, and then in the Pick Products dialog box, select the 
product to add as a line item.

To manually create an order

1 Navigate to Orders screen.

The My Sales Orders list appears.

2 Tap the New Record button, then complete the necessary fields.

From the Show drop-down list, choose More Info to display a form where you can add more 
details.

Adding Order Line Items in Medical Handheld
Once the initial sales order is created, you can complete the line items that make up the order.

1 Navigate to the Orders screen.

The My Sales Orders appears.

2 In the My Sales Orders list, select the order to which line items will be added.

3 From the Show drop-down list, select Line Items.

4 In the Order Line Item view, tap the Line Items list to select it, and then tap the New Record 
button.

A new blank record appears.

5 Tap in the Product field. 

The Pick Product list appears.

6 Tap the Product field and chose a product from the list of values.

The remaining fields will be automatically populated based product choice. 
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7 Complete any remaining fields for the line item, and repeat these steps to add additional line 
items.

Repeat the steps to add additional line items.

The Totals field automatically updates with the Quantity Requested total, and the Order record 
Item Total and Total fields get updated based on the sum of the Line Item Start Price and Net 
Price fields, respectively.

Entering Terms and Totals in Medical Handheld
After completing the line items, navigate to the Order Terms view to enter shipping and payment 
information for the order.

To add terms and totals

1 Navigate to the Orders screen.

2 In the My Sales Orders list, select the order.

3 From the Show drop-down list, select Order Terms.

4 In the Order Terms view, tap the Terms form to select it, then complete the necessary fields in 
the Terms form.

The fields are described in the following table:

NOTE: The basic Medical Handheld configuration does not include detailed shipping and billing fields. 
These fields are based on different business components and can be configured as required. 

Tracking Expenses in Medical Handheld
You can track expenses and create expense reports using Medical Handheld.

The following expense management procedure is included in this section:

�Creating an Expense Report in Medical Handheld� on page 148

�Submitting an Expense Report in Medical Handheld� on page 149

Field Comments

Payment Terms Tap in the field, the select the payment term 
period from a pop-up list. 

Ship Carrier Tap in the field, then select a shipping carrier from 
a drop down list. 

Shipping Instructions Tap the ellipsis (...), then manually enter any 
shipping instructions.
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Creating an Expense Report in Medical Handheld
You can create expense reports in Medical Handheld, then upload them to your server at the time of 
sync. 

To create an expense report

1 Navigate to the Expenses screen.

The My Expense Reports list appears.

2 In the Expense Reports list, tap the New Record button, complete the Period and Name field, and 
then choose More Info from the Show drop-down list. 

Some fields in the Expense Reports list are described in the following table:

To add detailed line items

1 Navigate to the Expenses screen. 

2 In the My Expense Reports list, locate the expense report record.

3 From the Show drop-down list, select Expense Items.

4 In the Expense Report Line Items view, tap the Line Items list, and then tap the New Record 
button. 

Field Comments

Expense Report # Read only. An automatically generated, unique identifier.

Name Required. Enter a name for the expense report.

Class A predefined list of values which indicate classes your 
company deems appropriate for expense reports. Such as, 
Holiday, or internal.

Status If you create the expense report with the Handheld 
device, this field will be prepopulated with the value of In 
Progress. You may tap in the field to adjust the value to 
express the current state of the expense report.

Submit To Read only. A predefined association set up by the system 
administrator. When you create a new expense report, the 
Submit To field is automatically populated with the login 
of manager to whom you report.

Reimbursable Tap this checkbox to indicate whether the expense is 
reimbursable.
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5 In the new row, complete the necessary fields for the line item.

You can not enter Line Items whose Start or End Date is outside of the Expense Report period. 

NOTE: Medical Handheld Expense Reports functionality does not currently support the Mileage 
expense type or detailed Hotel expense tax itemization. If these expense types are required, you 
must enter these items using the desktop Siebel Medical application. 

6 Repeat the steps to add line items. 

Submitting an Expense Report in Medical Handheld
After creating an expense report, you�ll then need to submit it for approval. 

To submit an expense report

1 Navigate to the Expenses screen.

The My Expense Reports screen appears.

2 Select the desired expense report, then tap the Status field, and select submitted from the drop-
down list. 

The next time you sync to your enterprise system, the expense report will be submitted.

Creating General Activities in Siebel 
Medical Handheld
Sales representatives use general activities to manage time and schedule demands and to keep their 
manager informed of their workload. A general activity in Medical Handheld is used to track noncall 
tasks such as to-do items, personal events, and correspondence.

In a typical scenario, a sales manager for a medical device company uses the Activities screen to 
create and track the activities on which she plans to spend her time during the next month. After 
scheduling a contact call with a customer, she uses the Calendar to review scheduled activities for 
the upcoming weeks.

This section provides procedures for adding activities from the Activities and Calendar views. The 
following activity management procedures are included in this section:

■ �Adding General Activities From The Activities View in Medical Handheld� on page 150

■ �Adding General Activities From the Calendar View in Medical Handheld� on page 150
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Adding General Activities From The Activities View in 
Medical Handheld
All activities with valid dates and times appear in the Medical Handheld Calendar views as well as in 
the Activities views. The Calendar views provide a visual representation of each user�s scheduled 
activities. 

NOTE: The Planned Start and Duration fields in general activities and appointments must contain 
entries in order for the appointments and activities to appear in the correct time period in the Daily 
Calendar view. While the Planned Start field is visible in the Activities screen�s My Activities view, 
this field is not visible in the Contacts screen�s Activities and Accounts > Activities views. The Planned 
Start field can be exposed during application configuration.

To add a general activity from the Activities view

1 Navigate to the Activities screen.

The My Activities list appears.

2 Tap the New Record button, then complete the necessary fields. 

NOTE: Select More Info from the Show drop-down list to edit additional fields for each record.

Some of the fields are described in the following table:

Adding General Activities From the Calendar View in 
Medical Handheld
General activities and appointments must have the Planned Start and Duration fields populated in 
order to be displayed in the correct time slot on the Daily Calendar view.

To add a general activity in the Calendar view

1 Navigate to the Calendar screen.

2 From the Show drop-down list, select Daily, Weekly, or Monthly.

Field Comments

Type The type of activity. The values displayed in this drop-down list depend on the 
value of the Activity field. For example, the activity types that you can select 
for a contact call are different from those that you can select for a general 
activity. 

Duration Select a time from 15 to 120 minutes from the drop-down list.

Account Tapping in this field takes you to a pop-up list with account names.

Repeat Checking this box allows you to specify the frequency and end date of a 
recurring activity.
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3 For My Weekly or My Monthly, select the day and time on which you want to schedule a general 
activity.

4 Tap the New Record button, then complete the necessary fields.

Some of the fields are described in the following table:

5 To specify contact participants:

a From the Show drop-down list, select Contact Participants.

b Tap the New Record button.

c In the Add Contacts dialog box, select participants and then tap OK.

6 To specify employee participants:

a From the Show drop-down list, select Employee Participants.

b Tap the New Record button.

The Participants list appears.

c Select participants, and then tap OK.

Managing MedEd Events in Medical 
Handheld
This section describes how a medical device company can use Medical Handheld to plan a medical 
education (MedEd) event. A MedEd event refers to a promotional or educational event attended by 
physicians and medical professionals. An event functions as a forum for exchanging information on 
a particular disease, illness, therapeutic class, or product. A medical education event can be as 
simple as a lunch-and-learn in a physician's office or as complex as a seminar series or national sales 
meeting. 

Sales representatives in the field can use Medical Handheld to view and create MedEd events and 
invite contacts to MedEd events. The following MedEd Event management procedures are included 
in this section:

■ Creating a MedEd Event in Medical Handheld on page 152

■ Inviting Professionals to MedEd Events Using Medical Handheld on page 152

Field Comments

Type The type of activity. The values displayed in this drop-down depend on the 
kind of activity. 

Description Tap on the ellipsis to add comments or clarification to the activity.

Type Choose a general activity type from the drop-down list.

Until The end date of a repeating appointment. If you do not select a value, 12 
more appointments will be scheduled. 
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Creating a MedEd Event in Medical Handheld
You can create MedEd events directly in Medical Handheld. 

To create a MedEd event

1 Navigate to the MedEd screen.

The My Med Ed events list appears.

2 Tap the New Record button, then complete the necessary fields. 

Some of the fields are described in the following table:

Inviting Professionals to MedEd Events Using Medical 
Handheld
When you have scheduled a MedEd event and have decided what sessions will be offered, you can 
invite health care professionals to attend. 

To invite a contact to a MedEd event

1 Navigate to the MedEd screen.

The My Med Events screen appears.

2 From the Show drop-down list, select Invitees.

Field Comments

Name Enter a name for the event in this field.

Event ID The Event ID field is automatically populated.

Objective A text field in which you can enter a description of the event objective.

Start Date Date and time that the event starts. Set the time fields before selecting a 
calendar day. 

End Date Date and time that the event ends. Set the time fields before selecting a 
calendar day. 

Budget The amount of money budgeted for the event.

Location A text field where you can enter the location of the event.

Event Status Indicates whether the event is active, cancelled, completed, in progress, 
inactive, or planned. 

CME Credit Number of CME (Continued Medical Education) credits that can be earned at 
the event. 

Type The category of medical education event being offered. 
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3 Tap the New Record button, then in the new row, complete the fields.

Some of the fields are described in the following table:

Managing Consigned Inventory with 
Siebel Medical Handheld
Medical products companies tend to manage many different products with very complex 
characteristics and variations. Some of these products are low volume with high costs while others 
are high volume with low costs. The margin and turn-over rate can also vary widely across these 
different products. Different products in a company's portfolio may be tracked differently; within the 
portfolio some products may be serialized, labeled by lot number, or merely labeled by part number. 
Additionally, some products have a prescribed expiration date based on product testing data that a 
company submits to the FDA or other regulatory body as part of regulatory submission, while other 
product do not. An expired product cannot be reworked for reuse, but rather must be discarded and 
recognized as a loss. 

There are 3 task groups for managing cycle count activity and performing cycle counts:

■ Performing Cycle Count. You perform cycle count tasks in the Cycle Count views.

■ Analyzing Inventory. You analyze inventory tasks in the Inventory views.

■ Moving Inventory. You move inventory tasks in the Inventory and Move views.

About Barcode Scanning in Siebel Medical Handheld
The Siebel Medical Handheld application is able to parse HIBIC, UCC/EAN and Combined UCC/EAN 
barcodes. For information on setting up barcode scanning in your handheld device, see 
�Administering Barcode Settings for Siebel Medical Handheld� on page 44. 

While in scan mode, the application automatically performs the following tasks:

■ Scan barcodes.

■ Parse data from barcodes. For example: Lot number, Serial Number, Expiration Date. 

■ Validate Data. Notify sales representatives whether product counted is Short Dated or Expired; 
as well as notify sales representatives if there are any errors in double-counting.

Field Comments

Last Name The contact or invitee. Select from the Pick Contact list. The First Name field 
is automatically populated based on this choice.

Invitee Status Indicates whether the invitee has confirmed attendance, is on a wait list, and 
so on. Pending is the default value.

Role Describes the selected contact�s role at the session. A drop-down list allows 
you to designate the contact�s role in the session.
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The function buttons on the Scan Barcodes view are described in the Table 30.

The fields in the Scan Barcodes list are described in Table 31.

Table 30. Scan Barcodes View Fields

Field Comments

Stop Tap this button to disable barcode scanning. After tapping Stop, you 
will be navigated to the Cycle Count Detail View.

Clear Tap this button to clear all the fields in the form, and undo any cycle 
count or product detail record that has be created on that scan. 

Move Tap this button to be navigated to the Part Move View, where a Part 
Move record will be populated with the current data. For information 
on part moves, see �Moving Products While Performing a Cycle Count� 
on page 160.

Table 31. Scan Barcodes list Fields

Field Comments

Product The name of the product that has been scanned.

Part # Part number for the product. This number could be the 
manufacturer�s number, the HIBC number or the UCC/EAN number.

Lot # Lot number to which the product asset belongs. This needs to be set 
up in the Assets table or included in the Barcode if the product is 
tracked by lot number or is a unique product that has a lot number 
included in its unique expression.

Serial # Serial number for the product. This needs to be set up in the Assets 
table or included in the Barcode if the product is serialized or is a 
unique product that has a serial number included in its unique 
expression.

Asset # Asset number for the product asset.

Use By Expiration date for product asset.

Days Calculated field. Calculates number of days until expiration.

State Calculated field. Calculates whether the product asset is good, 
shortdated or expired.
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Managing and Performing Cycle Counts 
with Medical Handheld
You can view information on all your cycle counts. Because contact information for the inventory 
location on which you are doing your cycle count can be found on the same view, you can use this 
information to schedule the cycle count. 

Scenario for Performing a Cycle Count
This scenario is one example of how you can use Siebel Medical Handheld for performing part 
movements. You might use Siebel Medical Handheld differently, depending on your business model. 

A Sales representative for a medical device company synchronizes with a Siebel client at the start of 
the day to get the latest information downloaded to her handheld device. She navigates to the My 
Pending Cycle Counts view to see all cycle counts that have been assigned to her. She sees one that 
is due two weeks from the present, and uses the information on inventory location to call the contact 
and schedule an appointment. While on the phone, she taps the Schedule button to navigate to the 
Calendar views to create an appointment for a cycle count. She then updates the status of cycle 
count status to Scheduled. 

On site, she outfits her handheld device with a compatible in hand scan card, navigates to the My 
Pending Cycle Counts view, selects the cycle count to perform and taps Start which navigates to the 
Cycle Count Detail View. She taps Scan to enable the barcode scanner and display the Scan Barcodes 
pop-up window. She then aligns the barcode scanner with the part number barcode on the first 
package and presses the device button to initiate screening.

For information on supported scanners, see System Requirements and Supported Platforms on Siebel 
SupportWeb.

The following cycle count tasks are included in this section:

■ �Viewing, Scheduling and Accessing Cycle Counts in Medical Handheld� on page 156

■ �To schedule a cycle count� on page 157

■ �Starting a Cycle Count� on page 157

■ �Performing a Cycle Count Using Barcode Scanning� on page 158

■ �Counting Products by Electronically Entering Product and Asset Records� on page 159

■ �Moving Products While Performing a Cycle Count� on page 160

■ �Completing Cycle Counts� on page 161
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Viewing, Scheduling and Accessing Cycle Counts in 
Medical Handheld
Users can review all pending cycle counts assigned to them. For information on how administrators 
can set assign cycle counts, see �Assigning Cycle Counts for Medical Handheld� on page 65. Users can 
determine critical information on these cycle counts to help them prioritize their activities. They can 
view information on inventory location, due date, and status for each of their cycle counts. Using 
information on the Medical Handheld, users can navigate to the Calendar view to schedule their cycle 
counts.

To view pending cycle count assignments

1 Navigate to Cycle Count.

The My Pending Cycle Counts list appears, with a form listing pertinent details of the site. The 
fields in the My Pending Cycle Counts list are described in the following table:

To access cycle count records

1 Navigate to Cycle Count.

The My Pending Cycle Counts list appears sorted in ascending order by due date. 

Field Comments

CC# This field is populated by a hyperlinked number which indicates the 
cycle count number. Tap this hyperlink to gain access to the 
individual cycle counts in the queue, which are displayed in the Cycle 
Count Detail view. 

Inv Location This field displays the location where the cycle count will take place.

Due Date The date and time the cycle count is to be completed.

Status This field displays the status of the pending cycle count. You set this 
field to reflect current status of cycle count. The choices are: Open, 
Assigned, Scheduled, In Progress, Done, and Closed.

Start Date Updated when a user taps the Start button while initiating the cycle 
count.

End Date The date the cycle count ended. The field is updated when a user 
taps Count Complete at the end of a cycle count.

Account The name of the inventory location, where the inventory will be 
counted, for instance a laboratory, administration office, or 
warehouse, and so on.

Owner The employee to which the cycle count is assigned.
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2 From the My Pending Cycle Counts list, tap the appropriate cycle count hyperlink in the CC# field.

The Cycle Count Detail view appears, along with a detailed list of products at that site. The fields 
in the Cycle Count Detail view are described in the following table: 

The fields in the Product Detail list are blank upon initiating a cycle count. Some of the fields are 
described in the following table:

To schedule a cycle count

1 Navigate to Cycle Count.

The My Pending Cycle Counts list appears sorted in ascending order by due date. 

2 Select the desired cycle count record.

3 In the Cycle Count Detail view, tap the Schedule button.

The Weekly Calendar view appears.

4 Create an appointment in the Calendar view for the cycle count.

For information on working with Calendar views, see �Adding General Activities Using the Calendar 
in Medical Handheld� on page 139.

Starting a Cycle Count
Once you are ready to perform a cycle count, you can initiate a count from the Pending Cycle Count 
view. Starting a cycle count would automatically changes the status of the cycle count to Started and 
navigates you to the Cycle Count Detail view, where you can start counting products.

Field Comments

Location The physical location where the inventory will take 
place, such a hospital or lab. This field is a read only.

Account The name of the account where the inventory is billed. 
This field is read only.

Comments You can enter comments associated with the account in 
this field.

Field Comments

Product A hyperlink, listing the product name, which links to the 
product detail view. 

Part # Part number as assigned to the item.

Description Description of the item. Tap the ellipsis (...), and then 
enter a description.
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To start a cycle count

1 Navigate to Cycle Count.

The My Pending Cycle Counts list appears sorted in ascending order by due date. 

2 Select the desired cycle count record, then tap Start.

The Cycle Count Detail View appears.

Performing a Cycle Count Using Barcode Scanning
After initiating a cycle count, you are now able to count products in the Cycle Count Detail view. 
There are two ways to perform the count. You can count products using barcode scanning, if your 
device is outfitted with a supported scanner, or you can electronically enter product and asset records 
in the Cycle Count Detail view. For information on supported scanners, see System Requirements 
and Supported Platforms on Siebel SupportWeb.

To count products using barcode scanning

1 In the Cycle Count Detail view, tap the Scan button.

The Scan Barcodes Form appears. The fields in the Scan Barcodes form are described in the 
following table:

2 Align the device scanner to the barcode and hit the device button to initiate scan.

An audio beep will confirm the scan. Data from the barcode is parsed into appropriate fields on 
the Scan Barcodes Form. 

Field Comments

Product Name of the product.

Part # Product part number.

Lot # Lot number of the product asset being scanned.

Serial # Serial number of the product asset being scanned.

Asset # Asset number of the asset being scanned. Auto-generated if 
there is no data on Asset number on the barcode.

Qty Quantity found on the product asset being scanned.

Use By Expiration date of the product asset being scanned.

Days Calculated field, the number of days until the product expires 
calculated based on current date.

State Calculated field. A product asset can be Good, Short-Dated, or 
Expired. A product is short dated if Days is less than Short Days 
defined for this product.
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a If the product requires only one barcode, the Days and Status field will be calculated and the 
application will provide appropriate audio and visual confirmation depending on the State as 
follows:

For expired products, the you would have to tap OK on the pop-up to acknowledge that 
product is expired. You cannot continue to the next scan without acknowledging this pop-up.

b If the product requires two barcodes, align the device scanner to the second barcode and hit the 
device button to initiate scan.

An Audio beep confirms scan. Data from barcode is parsed into appropriate fields on the Scan 
Barcodes Form. Use By Days and Status will be calculated and the application will provide 
appropriate audio and visual confirmation. See the previous step.

3 Repeat the previous steps for all products that will be counted by barcode scanning

4 Tap Stop to navigate back to Cycle Count Detail view.

Counting Products by Electronically Entering Product 
and Asset Records
When you are counting products during a cycle count, you are actually counting assets for that 
product. An asset is an instance of a product. Depending on how a product is defined in the Product 
Administration views, you may need to create new assets and associate these assets to a product 
when counting. This process is done automatically as part of the barcode scanning process. However, 
if barcode scanning is not enabled and you are counting products by electronically adding records, 
then you need to specify the product and associate assets to the product. 

To add products to a cycle count

1 Navigate to Cycle Count.

The My Pending Cycle Counts list appears sorted in ascending order by due date.

2 Select the desired Cycle Count record.

3 From the Show drop-down list, select Cycle Count Detail.

4 Tap in the Cycle Count Detail list to make it active, then tap the New Record button. 

5 Tap the arrow drop down on the Product field

The Products picklist will pop-up.

State Outcome

Good Audio beep

Short Dated Audio beep

Expired Audio beep and pop-up window
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6 Select a product from the Products pick applet and tap OK button. 

Repeat the procedure for as many products as required.

To associate an existing asset to a product

1 Tap in the Cycle Count Detail list to make it active. 

2 Select the product with which you would like to associate the asset.

3 Tap the Product hyperlink.

The Product Detail View appears.

4 Tap in the Product Detail list, then tap the New Record button. 

5 Tap the arrow in the Lot # field.

The Assets picklist appears.

6 Choose the desired asset, the tap OK.

7 Tap the Back button to navigate to the Cycle Count Detail view

To associate a new asset to a product

1 Tap in the Cycle Count Detail list to make it active. 

2 Select the product with which you would like to associate the asset.

3 Click the Product hyperlink.

The Product Detail View appears.

4 Tap in the Product Detail view, then tap the New Record button. 

5 Tap the arrow for Lot#, Serial#, or Asset# field.

The Assets picklist appears. 

6 Tap New from the Assets picklist.

7 Enter required information for the asset

NOTE: Asset# is auto-generated and Unique ID is read-only. If the product is defined to be 
serialized in the Product Administration views, Qty will also be read-only.

8 Tap OK

Repeat the previous steps if you need to create new assets and associate with this product.

9 Tap the Back button to navigate to the Cycle Count Detail view.

Moving Products While Performing a Cycle Count
You can choose to move a product while performing a cycle count. See �Moving Inventory with Medical 
Handheld� on page 161. 
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Completing Cycle Counts
After counting products, you can review the products and assets you counted. You can then complete 
the cycle count to make sure that inventory information on the server is updated with information 
from your cycle count when you synchronized the handheld. 

To complete a cycle count

1 On the Cycle Count Detail View, Tap Count Complete.

NOTE: Note: If you performed a part move that required approval, you will be navigated to the 
Move Approvals view. To capture a signature for an approval-required move, see �Capturing 
Signatures for Approval-Required Moves� on page 165.

Moving Inventory with Medical 
Handheld
You can move products that are expired or short-dated from any source location to any destination 
location. You can decide to move products while performing a count (for example, an expired 
product) or after a count (for example, a short-dated product that you believe would have a higher 
probability of being used in another inventory location). You may also decide to move inventory to 
another sales representative�s trunk (for example, swap inventory).

Scenario for Performing Part Movements
This topic gives one example of how you can use Siebel Medical Handheld for performing part 
movements. You might use Siebel Medical Handheld differently, depending on your business model. 

A medical devices sales representative is in the middle of a cycle count. While scanning a product, 
she is notified by a beep and dialog box that the product just scanned is expired. She taps OK in the 
dialog box, and sets aside the product as something she will need to take out of that inventory 
location. To record this, she taps Move while still in the Barcode Scan pop-up view. This brings her 
to the Part Move view which lists the product and asset she is moving. Most fields in this view will 
be prepopulated, so she inspects those fields, then taps Accept. A dialog box appears notifying her 
that the move will not be committed until she completes her count. She taps OK, then taps the back 
button to get back to the Scan Barcodes view. She taps Stop to disable scanning and taps Count 
Complete to complete her cycle count. This move requires an approval so she is navigated directly 
to the Move Approvals view. Additionally, there were a couple of products that were short dated, and 
she would like to discuss them with her contact. After discussing, she and the contact agree that 
these short dated products are better off being moved so she navigates to the Inventory Assets view, 
selects the asset she wants to move, and taps the Move button. This again brings her to the Part 
Move form, she inspects the data, is confident it is accurate, and taps Accept.

Because this inventory location is set up to require approval when products are being moved out of 
the location, she needs to capture a signature for this move. After tapping accept, she is navigated 
directly to Inventory Move Approvals view, where the signature can be captured.
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You can initiate a move from a number of views on the handheld. You can decide to move an expired 
product as part of the cycle count process. Or you can decide to move product as a stand-alone 
process.

You can perform the following tasks with inventory:

■ �Moving Inventory while Performing the Count� on page 162

■ �Moving Assets while Analyzing Inventory� on page 163

■ �Moving Products as a Stand-Alone Process� on page 164

Moving Inventory while Performing the Count
You can choose to move a product while performing a cycle count. If you scan an expired product, 
you can choose to set it aside and record the part move before you scan the next product. This can 
also be done while performing a count by electronic addition of product and assets

To move a product from the Scan Barcodes view while scanning products during a 
count

1 While in the Scan Barcodes view, tap Move.

NOTE: After scanning expired product, an Expired Product pop-up will appear. Acknowledge this 
message by tapping OK on the pop-up.

The following table explains some of the fields:

2 Review and update information as needed.

Field Description Pre-Default Value

Type Transaction Type Stock Transfer

From Source Inventory Location Inventory location on which the cycle count 
is being performed.

To Destination inventory location Representatives� inventory trunk, if 
defined.

Product Product being moved. Product name of the product that was 
scanned.

Qty Quantity Read-only depending on how the product is 
defined in Product Administration view.

Requires 
Approval

Check flag indicating whether 
part move requires a 
signature approval.

Read-only.
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3 Tap Accept to accept the part move, or Cancel to void the transaction.

NOTE: Upon tapping Accept for a move that requires approval, an Error dialogue box will appear 
specifying: �The Part Move could not be committed due to a cycle count in progress at the Source 
Location. Your request has been saved and will be processed when the Cycle Count has been 
completed at the Source Location.�

4 Tap OK to acknowledge and navigate back to the Part Move view.

5 Tap the Back button to go back to the Scan Barcodes view.

To move a product from Cycle Count Detail view while performing a count by 
electronically entering products and assets

1 After electronically adding an asset, navigate to the Product Detail View.

For information on adding an asset, see �To add products to a cycle count� on page 159.

2 Select the asset you want to move and tap Move.

The Part Move form appears with product, asset, and inventory information prepopulated.

3 Review and update information as needed.

4 Tap Accept to accept the part move or Cancel to void the transaction.

NOTE: Upon tapping Accept for a move that requires approval, an Error dialogue box will appear 
specifying: �The Part Move could not be committed due to a cycle count in progress at the Source 
Location. Your request has been saved and will be processed when the Cycle Count has been 
completed at the Source Location.�

5 Tap OK to acknowledge, and navigate back to the Part Move view.

6 Tap the Back button to go back to the Product Detail View.

Moving Assets while Analyzing Inventory
While discussing the results of your cycle count with your contact, you may decide to move some 
short-dated products to another inventory location where they have a higher probability of being 
used. You can initiate this move from the Inventory Assets view or from the Move Transactions view.

To move a product from Inventory Assets view

1 Navigate to the Inventory screen, then select Assets from the Show drop-down list. 

2 In the Assets list, select asset record.
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3 Tap Move.

Part Move form appears with product, asset, and inventory information prepopulated as 
described in the following table:

4 Tap Accept to accept the part move or Cancel to void the transaction.

NOTE: Tapping Accept would commit the transaction. If this move requires an approval from 
your contact at the inventory location, you will be automatically navigated to the Move Approvals 
view. To move more inventory, tap Back button to navigate back to Inventory Assets view and 
repeat the previous steps. 

Moving Products as a Stand-Alone Process
You can also move inventory as a stand-alone process. 

To move inventory from the Move Transactions view

1 Navigate to Move, then from the Show drop-down list, choose Inv Transactions.

2 Tap Move.

The Part Move Form appears with product, asset, and inventory information prepopulated as 
described in the following table:

Field Description Pre-Default Value

Type Transaction Type Stock Transfer.

From Source Inventory Location Inventory location on which the cycle count 
is being performed.

To Destination inventory location Representative�s inventory trunk, if 
defined.

Product Product being moved. Product name of the product that was 
scanned.

Qty Quantity Read-only depending on how the product is 
defined in Product Administration view.

Requires 
Approval

Check flag indicating whether 
part move requires a 
signature approval.

Read-only.

Field Description Pre-Default Value

Type Transaction Type Stock Transfer

From Source Inventory Location None. Required.

To Destination inventory location None. Required.
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3 Tap in the Detail view, then update the From, To, and Product fields.

4 Tap in the Assets list to make it active, and then tap the New Record button. 

5 Tap the Lot#, Serial#, or Asset# drop-down control for the new record created.

The Pick Asset list appears.

6 Select an asset record, then tap OK.

7 Tap Accept to accept the part move or Cancel to void the transaction

NOTE: Tapping Accept commits the transaction. If this move requires an approval from your 
contact at the inventory location, you will be automatically navigated to the Move Approvals view. 
To move more inventory, tap the Back button to navigate back to Move Transactions view and 
repeat the steps above.

Capturing Signatures for Approval-Required Moves
You can capture signatures directly on the handheld for moves that require approval. This approval 
can be enforced at the inventory location level or at the product level by your System Administrator. 
For more information, see �Moving Inventory with Medical Handheld� on page 161. If a move requires 
approval, you will be automatically navigated to the Inventory > Move Approvals view.

To capture a signature for an approval-required move:

1 On the Inventory Move Approval view, tap in the Move Approval List to make it active.

NOTE: Make sure that the Pick field has a check for all move transactions that you want to 
capture signatures for.

2 Tap Sign.

The Signature Capture pop-up appears.

3 Capture the signature from the contact, then tap Accept.

Product Product being moved None. Required.

Qty Quantity 0. Read-only depending on how the product 
is defined in Product Administration views.

Requires 
Approval

Check flag indicating whether 
part move requires a 
signature approval.

Read-only.

Field Description Pre-Default Value
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Analyzing Inventory with Medical 
Handheld
Analyzing inventory is critical task in managing consigned inventory. You can view all assets that are 
in that inventory location and determine which short-dated assets would have a higher probability 
of being used in another inventory location. You can also view detailed inventory and usage 
information on consigned inventory for that inventory location and assess whether the customer is 
complying with its contractual commitment of minimum level of inventory. Lastly, you can view 
detailed inventory and usage for all products and product classes or groups in a hierarchical format.

Scenario for Analyzing Inventory Results
This scenario is one example of how you can use Siebel Medical Handheld to analyze inventory. You 
might use Siebel Medical Handheld differently, depending on your business model. 

After completing a cycle count, a medical representative taps Count Complete on her handheld 
device. The application navigates her to the Inventory Detail view where she can review the count 
and usage results at different levels in the product hierarchy. She then taps Consignment to examine 
the customer's adherence to the contract.   Based on the usage summary and the consignment data, 
she determines that she should discuss adjusting consignment levels with the doctor or contact that 
site. 

When analyzing inventory, you can perform the following tasks:

■ �Viewing Hierarchical Results for Inventory and Usage� on page 166

■ �Viewing Results for Consigned Inventory� on page 168

■ �Viewing Assets in an Inventory Location� on page 169

Viewing Hierarchical Results for Inventory and Usage
You can view detailed inventory and usage information on products, product classes, and product 
groups for an inventory location. Medical Handheld tracks this relationship using a product hierarchy 
approach. You can view results for all products in the product hierarchy through explorer type views 
that let you go down and up various levels in the product hierarchy.

About Product Hierarchies
A product hierarchy is a grouping of products. It is a way to track relationships between products, 
product groups, or product classes. A product hierarchy is similar to a family tree on which you have 
root parent product, parents and child products, and leaf-level products. Your company can track 
many product hierarchies for a certain inventory location. 

Your administrator defines this product hierarchy as part of the product administration process. Your 
administrator also defines which products are being tracked for an inventory location and up to what 
level of the product hierarchy will be tracked on the handheld. 
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About Usage Calculations
Sales representatives can use the Medical Handheld to analyze usage behavior on consigned 
inventory. They can compare Average Usage (Field called 'Use' in the Inventory Detail views) and 
Historical Average Usage (Field called 'Avg' in the Inventory Detail views). Average Usage is the 
quantity used over a pre-defined number of days based on the last two cycle counts performed. The 
Historical Average Usage is the quantity used over a pre-defined number of days based on all cycle 
counts ever performed for that product. By comparing these two calculations, you  will be able to 
determine whether there are any significant changes to usage behavior for a certain product. You 
can use this information to identify cross-sell and up-sell opportunities. 

For details on how Usage is calculated, please refer to �Administering Siebel Medical Handheld� on 
page 53.

NOTE: Usage is calculated when Sales Representatives tap 'Count Complete' button as they 
complete a cycle count. It will only be calculated for products that are counted during that cycle 
count. Also, Usage numbers will not be calculated during the first time that a cycle count is performed 
on an inventory location. Usage calculations need a reference cycle count, since it is the first cycle 
count, the application will not be able to calculate meaningful numbers. 

To access hierarchical inventory and usage results

1 Navigate to Inventory.

The Inventory Locations screen appears.

2 Select the inventory location from the Inventory list. 

3 From the Show drop-down list, select Inventory Detail.

NOTE: You can also be automatically navigated to the Inventory Details view after completing a 
cycle count.

4 Tap Roll up.

NOTE: Tapping Roll up ensures that inventory and usage is calculated using the latest cycle count 
results and aggregates these values up through the product hierarchy

5 Tap on the Inventory list, and tap the any product record's hyperlink.

The Product Hierarchy view appears. The top list applet shows top-level products. The bottom 
applet lists all child products for product that is selected on the top list applet. The following table 
lists the information which is available for the top and bottom lists applets.

Field Comments

Product Name of the product.

Part # Product part number.

Min Contracted minimum level of inventory required for that product 
in the inventory location. This is the minimum inventory that 
this customer agreed in return for pricing benefits.

Level Flag to identify whether this product is consigned to the 
inventory location. 
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6 Select a different product in the top list applet to show it's child product information in a 
subordinate list.

7 Navigate down the product hierarchy to show next level parent and child product information. 
See �To navigate product hierarchy� on page 168 for more information.

To navigate product hierarchy

1 In the Product Hierarchy view, tap Down.

Both lists refresh to show second-level parent and child products. 

2 Continue to tap Down to navigate down the product hierarchy until you reach leaf-level products, 
or do the following:

■ Tap Up to navigate up the product hierarchy.

■ Tap the Back button to go back to the Inventory Detail view.

Viewing Results for Consigned Inventory
You can keep track of compliance to contractual commitments and detailed inventory and usage 
information for consigned inventory at an inventory location. 

To view results for consigned inventory:

1 Navigate to Inventory.

The Inventory Locations screen appears.

2 Select the inventory location from the Inventory Locations list. 

3 From the drop-down list, select Inventory Detail.

NOTE: You can also be automatically navigated to the Inventory Details view after completing a 
cycle count.

Qty Current level of inventory.

Delta Calculated. Difference between Min and Qty. If negative, this is 
the amount less then the minimum level required.

Use Calculated. Average Usage. Average Usage is the average 
quantity used within a pre-defined number of days based on last 
two cycle counts. Please refer to About Usage Calculations for 
details.

Avg Calculated. Historical Average Usage. Historical Average Usage 
is the average quantity used within a pre-defined number of 
days based on all cycle counts performed for that product.

Field Comments
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4 Tap the Consignment button.

The Consignment Detail view appears. The top form applet shows information on the inventory 
location and last roll up date. The bottom applet lists all products that are consigned at that 
inventory location regardless of their place in the product hierarchy. The following table lists the 
information which is provided for all consigned products:

5 Tap the Back button to navigate to the Inventory Detail view.

Viewing Assets in an Inventory Location
You can determine which products and assets are located in an inventory location. For each asset, 
you will be able to determine critical information to manage the inventory, such as expiration date 
and status.

To view assets in an inventory location

1 Navigate to Inventory.

The Inventory Locations screen appears.

Field Comments

Product Name of the product.

Part # Product part number.

Min Contracted minimum level of inventory required for that product 
in the inventory location. This is the minimum inventory that 
this customer agreed in return for pricing benefits.

Qty Current level of inventory

Delta Calculated. Difference between Min and Qty. If negative, this is 
the amount less than the minimum level required.

Use Calculated. Average quantity used per day based on last two 
cycle counts.

Avg Calculated. Historical average quantity used per day based on 
all cycle counts.
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2 Select an inventory location, and then select Assets from the Show drop-down list. 

The Inventory Assets view appears. The top applet shows information on the inventory location. 
The bottom applet provides detailed information for all assets located in that inventory location, 
as follows:

NOTE: You can also move products from the Inventory Assets view. To do this, see �Moving Assets 
while Analyzing Inventory� on page 163. 

Field Comments

Product Name of Product.

Part # Product part number.

Lot # Lot number of product asset being scanned.

Serial # Serial number of the product asset being scanned.

State Calculated field. A product asset can be Good, Short-
Dated, or Expired. A product is short dated if Days is 
less than the Short Days defined for this product. 

Qty Quantity found on the product asset being scanned.

Days Left Calculated field, the number of days until the product 
expires calculated based on current date.

Use By Expiration date of the product asset being scanned.
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A Troubleshooting
This appendix addresses some of the common issues faced while deploying Siebel Handheld. The 
appendix presents troubleshooting tips in three areas:

■ Installation

■ Performance

■ Log Files

The audience for this appendix is Siebel database administrators, system administrators, and 
application administrators.

�Installation� on page 171

�Synchronization� on page 172

�Log Files� on page 173

�SQLTrace� on page 175

�End User Error Messages� on page 176

�Web Server Timeout Errors� on page 176

�Performance� on page 176

�Siebel Services� on page 179

Installation
Siebel Handheld supports a specific and limited set of devices, handheld OS, desktop OS, server OS, 
server databases, and languages. This range of devices and platform support varies widely across 
the range of Siebel Handheld releases and must be carefully checked to confirm support. See System 
Requirements and Supported Platforms on Siebel SupportWeb for your Siebel application for 
information on supported Handheld OS, desktop OS, server OS, and server databases.

Client Installation, Backup, and Restore
If you run into problems while installing the Siebel Handheld application on client devices from a 
desktop PC, refer to the following checklist. Most installation problems are covered by this checklist.

■ Is the device certified and supported? Refer to the system requirements and supported platforms 
documentation for the Siebel Handheld application.

■ Confirm that the device has 64 MB of RAM with the majority of it available for the Siebel Handheld 
application.
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■ Is an ActiveSync connection running (green icon)? If not, check your computer to make sure that 
the serial or USB port is activated and functioning correctly.

■ If previous versions of Siebel Handheld were installed on the device, did you uninstall the 
application? See �Uninstalling the Siebel Handheld Application� on page 103.

Siebel Handheld binaries may also be installed to a CompactFlash card to conserve (RAM) memory. 
The application will still be loaded into memory when it executes. To install on the CompactFlash 
card, set the ApplicationBinariesLocation and ApplicationDataLocation parameters in the setup.ini 
file. See �Setting up Siebel Handheld Application Installation on a CompactFlash Card� on page 86.

Siebel Handheld (application only - no data) may also be backed up to a CompactFlash card to aid 
in deployments. Using the built-in backup utility that comes with Compaq (QUtilities) and HP Jornada 
(HP Backup) devices, a backup image may be created which can then be restored onto other devices. 
The initial backup image should be made of a device that has not done an initial synchronization. An 
initial synchronization will still be required by each user to receive the configuration and data.

It is also possible to back up Siebel Handheld on a PC using the Backup/Restore feature within 
ActiveSync.

Synchronization
Synchronization problems can be caused by incorrect settings in the Siebel Handheld setup.ini or .cfg 
files. Be sure that application names, data sources, and SRFs are correct.

Make sure to set the URL setting (DSSURL) in the client setup.ini for direct server synchronization 
installations. Be sure to list the views (DefaultViews) in the application .cfg file. Also, do not forget 
to grant the user visibility to these views in the Application Administration > Responsibilities view.

NOTE: Check the log files and confirm the accuracy of the generated connect string.

Companion Sync Checklist
Use the following checklist to troubleshoot problems you encounter using Companion Sync.

■ Is the latest version of ActiveSync (v.3.5 or later) installed and running?

■ Is ActiveSync connected (green icon)?

■ Do you have the correct data source defined in the handheld .cfg file?

■ If you have problems logging in, check to make sure that you can use the same credentials to 
log into the desktop client.

■ Remember to keep a 1:1 ratio of users to devices. Only a single user may log in to sync each 
device. Failure to do so causes data corruption.

Direct Server Sync Checklist
Use the following checklist to troubleshoot problems you encounter using Direct Server Sync.
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■ Did you install all client and server components successfully?

■ Is there a PDA OM running on the Siebel Server?

■ Did you bounce the IIS, SWE, and Siebel Server after installation?

■ Do you have network access to the URL for DSS? Can you ping the IIS server from inside and, if 
applicable, from outside the firewall?

■ Can you successfully run a SWE command?

■ Do you have the correct DSS URL defined in the setup.ini file?

■ Is the network connection working from the device? Try Pocket Internet Explorer.

■ If you have problems logging in, check to make sure that you can use the same credentials to 
log into the desktop client.

■ Remember to keep a 1:1 ratio of users to devices. Only a single user may log in to sync each 
device. Failure to do so causes data corruption.

Re-synchronizing Problems
Generally if, for whatever reason, synchronization is terminated, the end user is prompted with a 
message and the synchronization process ends. In this situation the synchronization session is 
allowed to close. However, if the connection with the server is unintentionally broken, the session 
may not have a chance to close before the connection is broken. Therefore, if the end user tries to 
immediately synchronize again, he may get an error message and may not be able to synchronize. 
Should this occur, the end user should wait for a period of time (generally, 15 minutes) to allow the 
session to time out and terminate. Once the session terminates, the end user should be able to 
synchronize again.

Log Files
This section discusses issues related to log files.

Direct Server Sync Log Files
To assist Siebel Technical Support, collect the following files when logging a Siebel Handheld service 
request. The following files are found on the machine where Siebel Server is installed:

■ All server sync user files in the Siebel Root\siebsrvr\hhsync\application directory\user id\node id 
directory.

■ Server NT application event log extract.

■ Server NT system event log extract.
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■ All files in the Siebel Root\siebsrvr\log directory including CompName_task.log.

where CompName is the name of an application server component, and task is a Siebel task 
number.  Each sync session is assigned a new Siebel task, so there will be many of these.  An 
example "CompName" value is "SalesCE_enu" (note that language is part of the component 
name itself). 

■ All files from all subdirectories under the Siebel Root\siebsrvr\logarchive directory.

■ Server perfmon log files (showing memory, network, disk performance), if available.

The following files are found on the machine where the Web Server (that is, IIS) is installed:

■ SWE log files from Siebel Root\eappweb\log (all files).

■ IIS server NT application event log extract.

■ IIS server system event log extract.

■ IIS server perfmon log files (showing memory, network, disk performance), if available.

Companion Sync Log Files
To assist Siebel Technical Support, collect the following log files when logging a Siebel Handheld 
service request. The following files are found on the companion PC where Siebel Mobile Web Client 
is installed:

■ Client Siebel Handheld Sync log file: \log\syncmanager_log.txt.

■ All files in the Siebel Root\client\hhsync\application directory\user id\node id directory.

■ NT application event log extract.

■ NT system event log extract.

■ All files in the Siebel Root\client\log directory.

■ Perfmon log files (showing memory, network, disk performance), if available.

Handheld Device Logs
The following log files are found in the /Program Files/Siebel Handheld directory on the handheld 
device:

■ dbimport_log.txt�This file is a log of the database objects that were imported during 
synchronization. The file is located in the \Program Files\Siebel Handheld directory on the 
handheld client.

■ sql_stmt_log.txt�This file logs all SQL statements generated by the application. You must set 
a parameter in the setup.ini file to turn this log on. The log file is located in the \Program 
Files\Siebel Handheld directory on the handheld client. See �Deployment of Siebel Handheld� on 
page 75 for more information about setting the parameter.
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■ ssa_errors_log.txt�This file is a log of all system error messages. You must set a parameter 
in the setup.ini file to turn this log on. The log file is located in the \Program Files\Siebel Handheld 
directory on the handheld client. See �Deployment of Siebel Handheld� on page 75 for more 
information about setting the parameter.

■ syncmanager_log.txt�This file contains all of the messages displayed on the Sync Manager 
dialog box as well as some basic information about synchronization, such as data source and 
connect string. You can set the logging level for this file using the SyncLogReportingLevel 
parameter in the setup.ini file.

For Direct Server Sync deployments, the file is located in the \Program Files\Siebel Handheld 
directory on the handheld client. For Companion Sync deployments, the file is located in the 
Siebel Root\client\log on the companion PC.

Logging Handheld Synchronization Errors

Siebel Handheld Sync logs all the strings that the user sees in the sync message window as well as 
many informational messages that do not get displayed in the UI. These informational messages are 
used to help track down where an error occurred. Siebel Handheld Sync determines which messages 
get logged based on a value stored in the registry under the key SyncLogReportingLevel. The values 
range from 0 to 4; 0 logs all error messages and strings that the user sees, and 4 logs all data that 
Siebel Handheld Sync sends and receives.

If Siebel Handheld Sync fails for some reason, check the syncmanager_log.txt file immediately after 
the failure. If you need more detail, increase the logging level and run Siebel Handheld Sync again. 
Use the LoggingLevels parameter in the setup.ini file to change the logging level. Furthermore, each 
time a user synchronizes, the syncmanager_log.txt file is overwritten with the new data.

SQLTrace
Use SQLTrace for diagnostic purposes if you encounter serious configuration errors or performance 
problems and cannot otherwise diagnose the problem. The problem may quickly become apparent 
in the log entries from SQL tracing.

To enable SQL tracing

1 Log into srvrmgr from a  (m:\siebel\bin\w32ud) prompt. 

2 Run: change evtloglvl ObjMgrSqlLog=4 for comp [OMName], where [OMName] = the OM name 
(for example, <ApplicationName>CEObjMgr_enu). 

3 Log enties are written to <OMName>ObjMgr_enu as described in �Log Files� on page 173.

NOTE: SQL tracing only logs SQL statements for one user at time. SqlTrace is applied to the first 
user who synchronizes after tracing is enabled.

CAUTION: When SQL tracing is enabled, synchronization is severely and adversely affected. 
Therefore, it is recommended that you turn SQL tracing on for a limited time to diagnose a 
specific problem, then turn SQL tracing off.
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End User Error Messages
End users may encounter error messages when they synchronize their data. For more information 
on these messages, see �Synchronization Troubleshooting with the Siebel Handheld Client� on 
page 119.

Web Server Timeout Errors
If synchronization times are long due to the size of the database file or the speed of the network 
connection, your end users may encounter Web server timeout errors and synchronization failures. 
First try to resolve this problem by reducing the size of your extract and configuring your server 
performance. If after doing this, your end users continue to experience timeout errors, then increase 
the timeout parameter on IIS for the default Web Server.

Follow the procedure for your platform to change the timeout parameter.

To change the timeout parameter on Windows 2000 

1 From the Start menu, select Programs > Administrative Tools > Internet Services Manager.

2 From the Internet Information Services window, select the local machine, right-click on the 
Default Web Site, and select Properties from the pop-up list.

3 From the Web Site Properties window, select the Web Site tab.

4 Under the Connections heading, locate the Connection Timeout property and increase the 
number of seconds.

5 Click OK.

To change the timeout parameter on Windows NT

1 From the Start menu, select Programs > Windows NT 4.0 Option Pack > Microsoft Personal Web 
Server >Internet Service Manager. 

2 Under Internet Information Server, right-click on the Default Web Site and select Properties from 
the pop-up list.

3 From the Web Site Properties window, select the Web Site tab.

4 Under the Connections heading, locate the Connection Timeout property and increase the 
number of seconds.

5 Click OK.

Performance
This section discusses ways you can optimize your client performance, server performance, and 
network performance.
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Client Performance
Client performance is affected primarily by the device capability (minimum 206 MHz processor and 
64 MB RAM), configuration, and the quantity of data loaded onto the device. In general, screen-to-
screen and view-to-view navigation times of 3 to 4 seconds or less should be considered normal. 

It is strongly recommended that customers follow these general guidelines to optimize the 
performance of their handheld applications:

■ Keep configuration under 30 views.

■ Keep RML file size under 1.75 MB.

■ Keep database files (dbfile.txt) under 2 MB. 

Use filters as outlined in the Siebel 2000 Handheld Synchronization Technical Note.

■ Keep the number of records for each business component under 2,500.

■ Avoid installing other applications on the device at the same time.

■ Users should synchronize their data frequently.

Additional configuration information can be found in the Siebel Technical Note 405, Siebel Handheld 
Synchronization.

The Professional Services Mobile eBusiness Competency group has a Siebel Handheld Quickstart 
program that is mandatory for all new Siebel Handheld customers to assess their configuration and 
deployment.

The Siebel Handheld client will benefit from periodic closing and restarting the application to release 
memory consumed by the handheld operating system. Use File > Exit in the menu to exit from the 
Siebel Handheld application.

If an external VGA driver is or has been loaded on the device in the past and is no longer needed, 
be sure to unload it, because it is known to have significant performance impacts on handheld 
devices.

Server Performance
Server performance affects the performance and scalability of Direct Server Sync processes. 
Customers should engage Expert Services to do a Scalability Review. The following guidelines are 
general in nature and pertain to the Siebel Handheld sync components running on a Siebel Server:

■ Use Performance Monitor to track memory and processor performance on the Siebel server.

■ Make sure that the Servers (IIS, GW, OM and DB) are on the same high speed LAN segment.

■ Siebel Handheld Sync components will stress Siebel Server and database performance because 
of the intensive interactions during large concurrent synchronizations.

■ Estimate that 64 MB is used per Siebmtsh.exe instance.

■ To calculate the theoretical maximum concurrent users:

■ Numusers=Server_Memory*threads_per_process_ratio/64 MB.
Siebel Medical Handheld Guide Version 7.7 ■ 177



Troubleshooting ■  Performance
■ Optimize the Threads per Process Ratio (Max Tasks/Max MT Servers) per Technical Note 405, 
Siebel Handheld Synchronization. 

■ Set Max Tasks=Max. number of concurrent users (for example, 150).

■ Set MinMTServers=MaxMTServers (for example, 30 for 5:1 ratio, if this is determined to be 
appropriate).

To optimize and tune a Siebel DB server:

■ Use Performance Monitor to track memory and processor performance on the DB server.

■ Turn on SQL tracing and search for long-running SQL calls.

■ Estimate 64 MB of RAM for each concurrent user.

■ Consider creating indexes to tune the queries (only performed with the assistance of Siebel 
Expert Services).

■ Consider using a RAID 0+1 disk array with an expanded number of spindles to optimize database 
performance.

NOTE: Make sure that DB Server settings are set to recommended values. Timeouts should be set 
at the Siebel Server. Be careful that the timeout is set longer than the longest SQL query.

Network Performance
The condition of the network affects Direct Server Sync performance and scalability. In general, a 
low-latency, high-bandwidth network is preferred with dedicated rather than shared network 
connections. The following are general network considerations:

■ Make sure there is adequate bandwidth throughout the entire round-trip of network packets and 
estimate where bottlenecks will occur due to high concurrent load. For example, if 50 users are 
concurrently synchronizing 1 MB each, 50 MB of data must pass through the network. If this data 
is passing through a single leased 56 KB per second line, then this data will minimally take 
500,000 KB/56 KB/sec=8928 seconds=148 minutes. In reality, a 56 KB per second line will offer 
only 30-40 KB per second average throughput, which causes further bandwidth constraints. 
Check the total available bandwidth of network providers (private or public ISP).

■ Verify that you have low latency lines with ping round trips of less than 1 second (1000 ms) with 
no dropped packets.

■ Verify if roundtrips occur with less than 10 hops.

■ Check the actual throughput of network connections by performing simple file transfers with no 
Siebel software.

■ Nonvalidated VPN software from third parties accounts for 30 to 60 percent of additional packet 
overhead because of the encryption.

Network problems can usually be resolved by working with network providers to size network 
connections and optimize network routing. Consider the use of burst networks, quality of service 
contracts, private networks, and dedicated modem banks directly into a high-speed LAN 
environment. Noisy phone lines in some countries may benefit from the use of an external modem 
card from Xircom or Pretec instead of the built-in modem on the HP Jornada 720.
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Siebel Services
You may wish to consult experts who have experience designing and configuring handheld 
applications, and who are knowledgeable about optimizing the performance of the applications.

Siebel Professional Services
To make deployment planning and implementation successful, Siebel Handheld customers are 
encouraged to engage the Siebel Mobile eBusiness Competency group. The Siebel Professional 
Services team has developed a Siebel Handheld Quickstart solution which defines the strategy, 
approach, and roadmap for successful Siebel Handheld deployments. Working directly with 
experienced handheld experts from the Mobile eBusiness Competency, customers can develop a 
complete deployment strategy, approach, and roadmap to facilitate their handheld implementation 
in a short time period.

Siebel Expert Services
All Siebel Systems customers should work with Siebel Expert Services to conduct detailed 
configuration and hardware sizing reviews. This helps customers make sure they have implemented 
the most effective and efficient solutions possible. Siebel Handheld customers benefit by making sure 
Siebel Handheld applications are configured according to best practices and that server environments 
are properly designed.
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B Business Components and 
Classes
Siebel Handheld Client supports a subset of the business components and classes supported by the 
Siebel Web Client application. This appendix lists the supported business components, business 
component classes, and applet classes.

�Supported Business Components for Siebel Handheld� on page 181

�Business Component Classes� on page 182

�Applet Classes� on page 183

Supported Business Components for 
Siebel Handheld
Table 32 lists the supported Business Components for Siebel Medical Handheld.

Table 32.  Siebel Medical Handheld Business Components

Supported Business Components

Account Contact Affiliation

Account Note

Account Private Note

Asset Mgmt - Asset

CUT Address

CUT Address Inter Table - CE

Contact Account Affiliation

Cycle Counting

FS Bucket

FS Cycle Counting Serial Parts

FS InvLoc Product

FS Inventory Location

FS Inventory Transaction

FS Transaction Assets

HH LS Medical CC Barcode Display
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Business Component Classes
Table 33 lists the supported Business Component classes for Siebel Medical Handheld. 

CAUTION: It is not recommended that you configure your own business components. Instead, use 
only the following classes. 

HH LS Medical Virtual Bucket

LS Medical Cycle Counting Execution

LS Medical Signature

Pharma ME Event

Pharma ME Event Professional 
Invitee

Pharma Professional Note

Pharma Professional Private Note

Retail Outlet Best Call Time

Table 33. Siebel Medical Business Component Classes 

Supported Applet Classes

CSSBCMedCyclCnt

CSSBCLSBucket

CSSBCMedCyclCntSerialPart

CSSBCLSCYCInvLoc

CSSBCLSInvTxn

CSSBCLSInvTxnAsset

CSSBCMedBarcodeDisplay

CSSBCMedCyclCntExecution

Table 32.  Siebel Medical Handheld Business Components

Supported Business Components
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Applet Classes
You may create additional screens and views for your Siebel Handheld application. Any new screens 
and views must be based on classes and Business Components that are supported for the Medical 
Handheld application. Refer to Table 34 for the supported applet classes.

Table 34. Siebel Medical Handheld Applet Classes 

Supported Applet Classes

CSSFrameListLSAsset

CSSFrameListLSInvLoc

CSSFrameListLSInvTxn

CSSFrameListLSProdDetail

CSSFrameListLSProdHrchy

CSSFrameListMedCCAsset

CSSFrameListMedCycCntDetail

CSSFrameListMedCyclCnt

CSSFrameListPMSign

CSSFrameLSInvLoc

CSSFrameLSPartMove

CSSFrameMedCycCntScan
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This appendix documents the handheld-specific user properties and methods for the Siebel Medical 
Handheld application.

User Properties for Medical Handheld

Table 35. User Properties for Medical Handheld

Business 
Component

User 
Property

Default 
Value Description

FS Inventory 
Location

User 
Properties for 
header and 
footer

N If set to Y, will allow you to customize 
Signature Header and Footer in the 
Signature Capture Popup box. After 
setting this User Property to Y, you 
can then edit the values of  
SignatureFooterField and 
SignatureHeaderField user property 
of the control Sign button in the 
Applet HH LS Medical Part Move 
Approval List Applet.

Lot Tracking 
Product Types

Lot Tracking 
Product Types

,Sample, 
Equipment, 
Device,

Comma deliniated list of the 
Language Independent Codes (LIC) 
of the types of products that can be 
tracked by lots. There must be 
leading and trailing commas in the 
value field.
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Global User Properties
The following user properties apply to all business components.

FS Inventory 
Location

Synchronize 
Rollup Data

N When the value is Y, handheld 
transactions are logged when the 
user clicks Rollup in the Inventory 
Detail view. Note that these 
transactions update the bucket 
records directly and no inventory 
transactions are generated.

Any Additional 
Barcode 
Fields

Allows you to display additional fields 
in Product Detail applet. For 
example, if you want to configure the 
Asset Number field in the Asset 
Management business component as 
a barcode field, you would add the 
user property to the Asset 
Management business component, 
then add the required data in the 
Barcode Adminstration screen. For 
more information, see �Administering 
Barcode Settings for Siebel Medical 
Handheld� on page 44.

Table 36. User Properties

Name Description

HandheldSyncPickMode User property on a field of a business component. When set to 
NoFail, turns Extended Pick processing ON. See �Extended Pick 
Processing in Siebel Handheld� on page 93 for more information.

HandheldSyncInsertMode User property on a business component. When set to FailOnError, 
enables Extended Insert processing. See �Extended Insert 
Processing in Siebel Handheld� on page 96 for more information.

Table 35. User Properties for Medical Handheld

Business 
Component

User 
Property

Default 
Value Description
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This chapter describes the print tagging language that is used to create print templates for your 
handheld device.

The audience for this appendix is Siebel application developers.

�Overview of Siebel Handheld Print Tagging Language� on page 187

�Using Variables in Print Templates� on page 203

�Using Variables in Print Templates� on page 203

Overview of Siebel Handheld Print 
Tagging Language
You can create the print template file in any text editor.

■ Tags are enclosed in angle brackets and identified with the keyword TAG, followed by a colon.

For example: <TAG: ....>

■ Parameters are specified with a keyword, followed by an equals sign. Arguments are in 
uppercase, surrounded by quotation marks.

For example, Font = "FONT FACE"

■ Values are in uppercase and lowercase, surrounded by quotation marks. 

For example: Font = "Helvetica"

■ Tags may appear in any order in the file. The only required tag is the Title tag.

■ Variables within a print template must be uniquely named. Variable names must be one-word 
strings and spaces are not allowed.

The following tags are used to specify the format of the print output, which applets are included, and 
the query that is executed:

■ Applet�Specifies which applets are used in the document.

■ Comment�Adds comments that do not appear in the final document.

■ Divider�Adds visual lines to visually separate different parts of the document.

■ Footer�Adds information such as page numbers, date, and time.

■ Format�Specifies characteristics such as font, boldface, italics, and underline.

■ Header�Adds information such as page numbers, date, and time.
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■ Page Break�Specifies a break in the text, forcing the text that follows to appear on the next 
page.

■ Picture�Adds graphic images to the document.

■ Title�Specifies a name for the template that appears in the print job list.

In addition, you may add static text in the print template.

The following print tags allow you to calculate additional information and add it to your reports:

■ GetTotal�Calculates the total for a column of data.

■ GetField�Gets the value of a field.

■ GetCount�Calculates the number of records.

You can also calculate dates and times using the GetDate and GetTime tags, and you can retrieve 
the value of the registry using GetRegistry.

All of this information is stored in variables that you specify. In addition, you can assign any value 
to a variable using the SetVariable tag. You can present this information in your report using the Cell 
and EndofLine tags to create tables of information. See �Using Variables in Print Templates� on 
page 203 for an example of how variables can be used to present information in print templates.

Applet

Description
Specifies the applet to be printed.

Usage
Any data that appears in your document must be generated from the applets in the view. Therefore, 
you must create applets that will produce the data required for your document.

Use the Applet tag to specify any number of list or form applets within the template and to locate 
the applet in your document. In the form view, a maximum of two fields per row are supported.

Syntax
<TAG:Applet Name="APPLET NAME" Query="QUERY STRING" Caption="CAPTION" 
Headerdivider="HEADERDIVIDER" Recorddivider="RECORDDIVIDER" Wrap="WRAP">

Parameter Description

TAG:Applet (Required) Applet tag indicator.

APPLET NAME (Required) Applet name as defined in Siebel Tools.
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Example
<TAG:Applet Name="Order List" Headerdivider="TRUE">

Cell

Description
Prints the string stored in STRING or VARIABLE NAME at the specified location on the current line.

Usage
Use the Cell tag to create cells of data in a row in a table. Use it with the EndOfLine tag. If the data 
exceeds the width of the cell specified by Startat and Endat, it wraps to the next line.

QUERY STRING (Optional) Specifies the query string directly set to the business component 
supporting the document.

If the query string is not specified, the currently active query string in the view 
is applied to expose the relevant records.

CAPTION (Optional) Specifies whether the captions in the form applets are suppressed.

Valid values are TRUE (default) and FALSE. This parameter does not apply to 
list applets. Column headings in list applets are always enabled.

HEADERDIVIDER (Optional) Specifies whether a divider is printed below the column heading in 
list applets.

Valid values are TRUE and FALSE (default). This parameter does not apply to 
form applets.

RECORDDIVIDER (Optional) Specifies whether a horizontal divider is printed between records in 
list applets.

Valid values are TRUE and FALSE (default). This parameter does not apply to 
form applets.

WRAP (Optional) Specifies whether text field values are word wrapped. 

Valid values are TRUE and FALSE (default). This parameter does not apply to 
numeric fields.

Parameter Description
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Syntax
<TAG:Cell Startat="START" Endat="END" Name="STRING" Variable="VARIABLE NAME" 
Align=ALIGNMENT"

Example
<TAG:Divider Weight="3" Startat="20" Endat="80">
<TAG:Cell Startat="0" Endat="50" name="TOTAL:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvv1total" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="TOTAL Defective:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvDefectiveTotal" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="TOTAL Good:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvGoodTotal" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="Defective Count:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvvDefectiveCount" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="50" name="Good Count:" Align="RIGHT">

Parameter Description

TAG:Cell (Required) Required tag indicator.

START (Required) Specifies the starting point of the cell, expressed as a percentage 
of the printable page width. For example, if 
START =10, then the cell starts at the point that is 10% from the left edge 
of the printable width.

END (Required) Specifies the end point of the cell, expressed as a percentage of 
the printable page width. For example, if END=50, then the cell ends at the 
point that is 50% from the left edge of the printable width.

STRING (Optional) String value. If Variable is not specified, then String is a required 
parameter. 

VARIABLE NAME (Optional) Name of variable where the value is stored. If String is not 
specified, then Variable is a required parameter.

ALIGNMENT (Optional) Specifies the alignment of the string.

Valid values are LEFT (default), CENTER, and RIGHT.
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<TAG:Cell Startat="50" Endat="100" Variable="vvvGoodCount" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell Startat="50" Endat="100" Variable="vvv3reg">
<TAG:EndOfLine>
<TAG:Cell Startat="50" Endat="100" Variable="vvv5str">
<TAG:EndOfLine>
<TAG:Cell Startat="0" Endat="30" Variable="vvv4date">
<TAG:Cell Startat="30" Endat="70" Variable="vvv4longdate">
<TAG:Cell Startat="70" Endat="100" Variable="vvv8time">
<TAG:EndOfLine>

Comment

Description
Adds code comments to the print template.

Usage
Use to add explanatory notes or documentation to explain and maintain the print template. Comment 
tags are ignored during printing and do not appear in the printed document.

Syntax
<REM: COMMENT>

Example
<REM: Quotation Print Template. This template includes four applets.>

Divider

Description
Renders a horizontal line across the width of the page.

Parameter Description

REM (Required) Comment tag indicator.

COMMENT (Optional) Comment text.
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Usage
Use to visually separate the different sections of your document. The Divider tag can be used 
between other tags; therefore, you may add a line between two applets. However, you cannot embed 
a Divider within an applet.

Syntax
<TAG:Divider Weight="WEIGHT" Startat="START" Endat="END">\

Example
<TAG:Divider Weight="2" Startat="20" Endat="80">

EndOfLine

Description
Specifies the end of a row and advances to the next line.

Usage
Use to create rows of data in a table. Used with the Cell tag.

Syntax
<TAG:EndOfLine>

Example
<TAG:Cell Startat="0" Endat="50" Name="TOTAL:" Align="RIGHT">
<TAG:Cell Startat="50" Endat="100" Variable="vvv1total" Align="RIGHT">
<TAG:EndOfLine>

Parameter Description

TAG:Divider (Required) Divider tag indicator.

WEIGHT (Optional) Specifies line thickness.

Valid values are 1�5. The default value is 1, which produces a line 0.2 mm 
wide. Increasing the value by 1 increases the width by 0.2 mm. A 5 produces 
a line that is 1 mm wide.

START (Optional) Percentage that specifies the starting point of the line. The default 
is 0%, the farthest left point.

END (Optional) Percentage that specifies the end point of the line. The default is 
100%, the farthest right point.
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Footer

Description
Adds footer information such as page numbers, the current date, and the current time.

Usage
You may, for example, always want the text �Thank you for your business!� to appear on the bottom 
of your receipts. If so, you may include this text in a Footer tag.

The Footer tag may be specified anywhere in the template file; however, it will always appear at the 
very bottom of your document. Only one Footer tag is applied to the document. If you have multiple 
Footer tags in the file, only the last Footer tag is used; any other Footer tags are ignored.

If you include a Footer tag in your template, then you must set the BottomMargin in setup.ini to a 
minimum of 20.

The footer has three sections, Left, Center, and Right, which are used to position the information in 
the footer.

The text in the footer is formatted in 10 point, Helvetica font. If Helvetica is not available on your 
system, the default font is used. You cannot customize text formatting of the Footer tag. The Format 
tag does not affect the formatting of the footer.

Syntax
<TAG:Footer Left="DATA" Center="DATA" Right="DATA">

Example
<TAG:Footer Left="<date>" Right="<page>"

Parameter Description

TAG:Footer (Required) Footer tag indicator.

DATA (Optional) Static text or one of the following data tags:

Data tag Description

<page> Page number

<date> Date of the printing

<time> Time of the printing
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Format

Description
Specifies the characteristics of the text�the typeface or font, whether the text is in boldface, italics, 
or underlined, and the text alignment.

Usage
The font specification specifies the characteristics of all text that follows the tag until the next Format 
tag.

The text alignment tag (Align) behaves somewhat differently. When the applet is rendered, the field 
alignment specification takes precedence over the Align parameter.

Syntax
<TAG:Format Face="FONT FACE" Size="FONT SIZE" Bold="BOLD" Italic="ITALIC" 
Underline="UNDERLINE" Align="TEXT ALIGNMENT">

Example
<TAG:Format Face="Helvetica" Size="10">

Parameter Description

TAG:Format (Required) Format tag indicator.

FONT FACE (Required) Specifies the typeface of the text.

Any typeface installed on the handheld device may be specified. There is no 
default for this parameter.

FONT SIZE (Required) Specifies the text size.

Any installed font size for an installed typeface on the handheld device may 
be specified. There is no default for this parameter.

BOLD (Optional) Specifies whether the text is in bold.

Valid values are TRUE or FALSE (default). If TRUE, text is set to bold.

ITALIC (Optional) Specifies whether the text is in italic. 

Valid values are TRUE or FALSE (default). If TRUE, text is set to italic.

UNDERLINE (Optional) Specifies whether the text is underlined.

Valid values are TRUE or FALSE (default). If TRUE, text is set to underline.

TEXT ALIGNMENT (Optional) Specifies the text alignment.

Valid values are LEFT (default), RIGHT, and CENTER.
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GetCount

Description
Calculates the number of records in the selected rows and assigns this value to a variable.

Usage
Use GetCount to calculate the number of records and print this value in your report.

Syntax
<TAG:GetCount Appletname="APPLET NAME" Query="QUERY STRING" Variable="VARIABLE 
NAME">

Example
<TAG:GetCount Appletname="CS HH Product Bucket List Applet" Query="Status|Good" 
Variable="StatusGood">

GetDate

Description
Gets the current date, offsets the date by the number of days specified in Dayoffset, and stores the 
result in a variable.

Usage
Use GetDate to print a specific date in your report.

Parameter Description

TAG:GetCount (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.

QUERY STRING (Optional) Search specification for the rows to be included in the row set. If 
not specified, the current search specification is used.

The syntax for the query string is: Field Name|Query Statement. You may 
specify one or more query strings separated by a vertical bar (|).

For example, Query="Name|LIKE 'Sieb*'"|"Location|LIKE 'H*'"

VARIABLE NAME (Required) Name of variable where the value is stored.
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Syntax
<TAG:GetDate Dayoffset="NUMBER OF DAYS" Variable="VARIABLE NAME" Logformat="DATE 
FORMAT">

Example
<TAG:GetDate Longformat="TRUE" Variable="LongDate">

GetField

Description
Gets the value of the specified column of the first row of selected rows and assigns the result to a 
variable.

Usage
Use GetField to print a value without developing a print applet. Design the query and sort strings so 
that the desired record is the first record in the selected rows. GetField only allows you to get the 
value in the first record.

Syntax
<TAG:GetField AppletName="APPLET NAME" Fieldname="FIELD NAME" Query="QUERY STRING" 
Sort="SORT STRING" Variable="VARIABLE NAME">

Parameter Description

TAG:GetDate (Required) Required tag indicator.

NUMBER OF DAYS (Optional) Number of days by which the current date is offset. For example, 
�100 subtracts 100 days from the current date; 100 adds 100 days to the 
current date. The default is 0.

VARIABLE NAME (Required) Name of variable where the value is stored.

DATE FORMAT (Optional) TRUE prints the date in long date format (for example, Monday, 
February 11, 2002). FALSE prints the short date format (for example, 2/21/
02). The default is FALSE.

Parameter Description

TAG:GetField (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.

FIELD NAME (Required) Name of the field or column.

QUERY STRING (Optional) Search specification for the rows to be included in the total. If not 
specified, the current search specification is used.
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Example
<TAG:GetField AppletName="CS HH Product Bucket List Applet" Fieldname="Quantity" 
Variable="ProdBucketListField">

GetRegistry

Description
Gets a value in the registry for Siebel Handheld and assigns it to a variable.

Usage
Use GetRegistry to print the contents of the registry key in your report.

Syntax
<TAG:GetRegistry Name="REGISTRY NAME" Variable="VARIABLE NAME">

Example
<TAG:GetRegistry Name="InstallDir" Variable="Registry">

SORT STRING (Optional) Sort specification. If not specified, the current sort specification 
is used.

The syntax is: Field Name [ASC][DESC]. The default is ASC (Ascending).

For example: Sort="Account DESC, Date". In the example, the Account field 
is sorted in descending order, then the date field is sorted in ascending order.

VARIABLE NAME (Required) Name of variable where the value is stored.

Parameter Description

TAG:GetRegistry (Required) Required tag indicator.

REGISTRY NAME (Required) Value the registry.

VARIABLE NAME (Required) Name of variable where the value is stored.

Parameter Description
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GetTime

Description
Gets the current time, offsets the time by the number of seconds specified in Secondoffset, and 
assigns the result to a variable.

Usage
Use GetTime to print a specific time in your report.

Syntax
<TAG:GetTime Secondoffset="NUMBER OF SECONDS" Variable="VARIABLE NAME">

Example
<TAG:GetTime Secondoffset="3600" Variable="Time">

GetTotal

Description
Calculates the total for the specified column for all selected rows and assigns the value to a variable.

Usage
Use GetTotal to calculate a column total and display the total in your report.

Syntax
<TAG:GetTotal AppletName="APPLET NAME" FieldName="FIELD NAME" Query="QUERY STRING" 
Variable="VARIABLE NAME">

Parameter Description

TAG:GetTime (Required) Required tag indicator.

NUMBER OF SECONDS (Optional)Number of seconds by which the current time is offset. For 
example, �100 subtracts 100 seconds from the current time; 100 adds 
100 seconds to the current time. The default is 0.

VARIABLE NAME (Required) Name of variable where the value is stored.

Parameter Description

TAG:GetTotal (Required) Required tag indicator.

APPLET NAME (Required) Name of the applet.
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Example
<TAG:GetTotal AppletName= "CS HH Product Bucket List Applet" Fieldname="Quantity" 
Variable="ProdBucketListTotal">

Header

Description
Adds header information such as page numbers, the current date, and the current time.

Usage
You may always want the current date and time to appear on your invoices. If so, you may include 
this information in a Header tag.

The Header tag may be specified anywhere in the template file; however, it always appears at the 
very top of your document. Only one Header tag is applied to the document. If you have multiple 
Header tags in the file, only the last Header tag is used; any other Header tags are ignored.

If you include a Header tag in your template, then you must set TopMargin in setup.ini to a minimum 
of 20.

The header has three sections, Left, Center, and Right, which are used to position the information in 
the header. The Left parameter aligns the text with the left margin, and the Right parameter right 
aligns the text with the right margin. The Center parameter centers the text in the header.

The text in the header is formatted in 10 point, Helvetica font. If Helvetica is not available on your 
system, the default font is used. You cannot customize text formatting of the Header tag. The Format 
tag does not affect the format of the header. 

FIELD NAME (Required) Name of the field or column. Specify a field or column with 
numeric data. If you specify a field with non-numeric data, a 0 is assigned 
to the variable.

QUERY STRING (Optional) Search specification for the rows to be included in the total. If not 
specified, the current search specification is used.

The syntax for the query string is: Field Name|Query Statement. You may 
specify one or more query strings separated by a vertical bar (|). 

For example, Query="Name|LIKE 'Sieb*'"|"Location|LIKE 'H*'"

VARIABLE NAME (Required) Name of variable where the value is stored.

Parameter Description
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Syntax
<TAG:Header Left="DATA" Center="DATA" Right="DATA"

Example
<TAG:Header Center="Company Confidential">

Page Break

Description
Forces text that follows the tag to appear on the next page.

Usage
Use this for multipage documents or forms.

Syntax
<TAG:PageBreak>

Example
<TAG:PageBreak>

Picture

Description
Specifies graphic files included in the print template.

Parameter Description

TAG:Header (Required) Header tag indicator.

DATA (Optional) Static text or one of the following data tags:

Data tag Description

<page> Page number

<date> Date of the printing

<time> Time of the printing

Parameter Description

TAG:PageBreak (Required) Page break tag indicator.
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Usage
Use to add graphic images, such as a company logo, to your documents. 

The supported file formats are BMP and JPG. 

Graphics files are located in the \Program Files\Siebel Handheld\templates directory on the handheld 
device. Specify the full path name of the file for the Name parameter.

Scaling or graphics operations, such as inverse image, are not supported.

The Alignment and Position parameters are used together to place the graphic. Alignment specifies 
the left edge, the center, or the right edge of the graphic. Position is distance, specified in 
millimeters, from the left edge of the paper. 

■ If Alignment ="Left" and Position="30", then the left edge of the graphic is set 30 millimeters 
from the left edge of the paper. 

■ If Alignment = "Center" and Position = "30", the center of the graphic is set 30 millimeters from 
the left edge of the paper.

■ If Alignment = "Right" and Position = "30", the right edge of the graphic is set 30 millimeters 
from the left edge of the paper.

If Position is not specified, it defaults to 0. Depending on the Alignment setting, the graphic is left-
aligned (Alignment = "Left"), the graphic is right-aligned (Alignment = "Right"), or the graphic is 
centered (Alignment ="Center")

Syntax
<TAG:Picture Name="FILE NAME" Alignment="ALIGNMENT" Position="POSITION">

Example
<TAG:Picture Name="\Program Files\Siebel Handheld\templates\logo.bmp" Alignment="Right" 
Position="88">

Parameter Description

TAG:Picture (Required) Picture tag indicator.

FILE NAME (Required) Specifies the full path and name of the graphics file.

ALIGNMENT (Optional) Specifies the left edge, the center, or the right edge of the graphic. 
Used with the Position parameter to specify the horizontal position of the graphic.

Valid values are LEFT (default), CENTER, and RIGHT.

POSITION (Optional) Specified in millimeters, it is the distance from the left edge of the 
paper. Used with the Alignment parameter to specify the horizontal position of the 
graphic. The default is 0.
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SetVariable

Description
Sets a value to a variable.

Usage
Use SetVariable to assign a value to a variable. You can then print the value by specifying the variable 
in the Cell tag.

Syntax
<TAG:SetVariable Name="VALUE" Variable="VARIABLE NAME>

Example
<TAG:SetVariable="100" Variable="TotalQuantity">

Static Text
You may add static text anywhere in your template by using the current Format settings. The text 
goes across the entire page width. If it exceeds the width of the page, it wraps to the next line.

Example
This quote is valid for 60 days from the date on this quotation.

Title

Description
Name used to identify the template.

Usage
The Title tag is a required tag in your print template file. 

Parameter Description

TAG:SetVariable (Required) Required tag indicator.

VALUE (Required) A value.

VARIABLE NAME (Required) Name of variable where the value is stored.
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When you print your document, this title appears in the print job list. This title does not appear on 
the document that is printed. Use static text to add the document title to your template.

Syntax
<TAG:Title Title="TITLE">

Example
<TAG:Title Title="Quotation">

Using Variables in Print Templates
The following example shows how to use variables in a print template.

<TAG:Title Title="Inventory Report">

<REM: **********Variable Assignment Examples**************>

<TAG:SetVariable name="THIS IS VARIABLE" variable="VarStr">
<TAG:GetRegistry name="InstallDir" variable="VarReg">
<TAG:GetDate dayoffset="10" variable="VarDate">
<TAG:GetDate longformat="TRUE" variable="VarLongDate">
<TAG:GetTime secondoffset="-3600" variable="VarTime">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" fieldname="Quantity" 
variable="VarTotal">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" fieldname="Quantity" 
query="Status|Good" variable="VarGoodTotal">
<TAG:GetTotal appletname="CS HH Product Bucket List Applet" fieldname="Quantity" 
query="Status|Defective" variable="VarDefectiveTotal">
<TAG:GetField appletname="CS HH Product Bucket List Applet" fieldname="Quantity" 
variable="VarQuantityField">
<TAG:GetCount appletname="CS HH Product Bucket List Applet" query="Status|Good" 
variable="VarGoodCount">
<TAG:GetCount appletname="CS HH Product Bucket List Applet" query="Status|Defective" 
variable="VarDefectiveCount">

<REM: **********Variable Assignment Examples End************>

<REM: Inventory Print Template. This template includes 3 applets. The ENU template>

<TAG:Format Face="Helvetica" Size="16" Align="Center">
[Distributor Name
Street Address
City, Country Postal Code
Phone Number   Fax Number]

Parameter Description

TAG:Title (Required) Title tag indicator.

TITLE (Required) Title text. May be between 1�255 characters.
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<TAG:Format Face="Helvetica" Size="20" Bold="TRUE" Align="Center">
Inventory Report
<TAG:Format Face="Helvetica" Size="8" >
<TAG:Applet Name="CS HH Inv Loc Print Applet" Caption="TRUE" Wrap="TRUE">
<TAG:Applet Name="CS HH Product Bucket List Applet" Line="FALSE" Headerdivider="TRUE" 
Recorddivider="FALSE" Wrap="TRUE">

<REM: *************Variable Usage Example***************>

<TAG:Divider Weight="3" startat="20" endat="80">
<TAG:Cell startat="0" endat="50" name="TOTAL:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarTotal" Align="RIGHT">
<TAG:EndOfLine>
<TAG:Cell startat="0" endat="50" name="TOTAL Defective:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarDefectiveTotal" Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="TOTAL Good:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarGoodTotal" Align="RIGHT"
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="Defective Count:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarDefectiveCount" Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="50" name="Good Count:" Align="RIGHT">
<TAG:Cell startat="50" endat="100" variable="VarGoodCount" Align="RIGHT">
<TAG:EndOfLine>

<TAG:Cell startat="50" endat="100" variable="VarReg">
<TAG:EndOfLine>

<TAG:Cell startat="50" endat="100" variable="VarStr">
<TAG:EndOfLine>

<TAG:Cell startat="0" endat="30" variable="VarDate">
<TAG:Cell startat="30" endat="70" variable="VarLongDate">
<TAG:Cell startat="70" endat="100" variable="VarTime">
<TAG:EndOfLine>

<REM: ***********Variable Usage Example End***************>

<TAG:Divider Weight="2">
<TAG:Format Face="Helvetica" Size="12" Align="LEFT">
Warehouse Signature
<TAG:Divider Weight="2">
<TAG:Format Face="Helvetica" Size="12" Align="RIGHT">

Rep Signature
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You configure printing attributes in the setup.ini file. This appendix describes the printing parameters 
for Siebel application developers and application administrators.

Overview of Siebel Handheld Print 
Configuration Settings
The administrator sets up the default printer setting in the setup.ini file located in the setup directory.

There are a number of parameters to specify printing on the handheld. The parameters specify the 
following:

■ Printer attributes (printer model, port, baud rate, and printer handshake).

■ Printing attributes (portrait or landscape orientation, print density and quality, use of 
compression techniques, and advancing continuous�feed paper).

■ Dimensions of the paper (U.S. or European standard paper sizes or custom�size paper).

■ Margin settings of the pages (left, right, top, and bottom margins).

These parameters are specified in the [Printing] section of the setup.ini file located in the setup 
directory. The file contains default settings for all the printing parameters. Review the settings in the 
file to verify that these settings will work for your printing environment. If necessary, edit the 
settings as required. You may use any text editor to edit the file.

See Appendix D for a list of the printing parameters and valid values.

The parameters are set using the following syntax:

PARAMETER_NAME = VALUE

For example: PrinterType = 1

The parameters are listed below in alphabetical order by the parameter name.

MarginBottom
Use the MarginBottom parameter to specify the dimensions of the bottom margin of your page. 
Specify the margin in millimeters using a whole number; decimal fractions are not valid. The default 
is 5 millimeters.

The data specified in the Footer tag of the print template is printed in the margin specified by 
MarginBottom. Therefore, if the print template includes a Footer tag, you must specify a wide enough 
bottom margin to accommodate the footer. MarginBottom should be set to a minimum of 20 
millimeters. For more information, see �Footer� on page 193.
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MarginLeft
Use the MarginLeft parameter to specify the width of the left margin of your page. Specify the margin 
in millimeters using a whole number; decimal fractions are not valid. The default is 5 millimeters.

MarginRight
Use the MarginRight parameter to specify the width of the right margin of your page. Specify the 
margin in millimeters using a whole number; decimal fractions are not valid. The default is 5 
millimeters.

MarginTop
Use the MarginTop parameter to specify the dimensions of the top margin of your page. Specify the 
margin in millimeters using a whole number; decimal fractions are not valid. The default is 5 
millimeters.

The data specified in the Header tag of the print template is printed in the margin specified by 
MarginTop. Therefore, if the print template includes a Header tag, you must specify a wide enough 
top margin to accommodate the footer. MarginTop should be set to a minimum of 20 millimeters. For 
more information, see �Header� on page 199.

PaperHeight
If the paper that your printer uses is not one of the supported standard sizes, then set PaperSize to 
5 (custom paper dimensions). Then, specify the height of the paper, in millimeters, using the 
PaperHeight parameter. You must use a whole number; decimal fractions are not valid. The default 
is 280 millimeters. If you specify a value of 1�4 for PaperSize, the PaperHeight parameter is ignored.

Use the PaperWidth parameter to specify the width of the paper.

PaperSize
Specify one of the standard paper sizes or specify a custom paper size. (See Table 37.) If you specify 
custom paper size (5), you must also specify the PaperWidth and PaperHeight parameters. The 
default is custom paper dimensions.
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See also PaperWidth and PaperHeight.

PaperWidth
If the paper that your printer is printing to is not one of the supported standard sizes, then set 
PaperSize to 5 (custom paper dimensions). Then, you must specify the width measurement of the 
paper, in millimeters, using the PaperWidth parameter. You must use a whole number; decimal 
fractions are not valid. The default is 5 millimeters. If you specify a value of 1�4 for PaperSize, the 
PaperWidth parameter is ignored.

Use the PaperHeight parameter to specify the length of the paper.

PrinterBaudrate
Use PrinterBaudrate to specify the speed of the data transmission for the printer. (See Table 38.)

Table 37. Paper Dimensions

Value Description

1 Letter size (8.5" x 11.5")

2 A4 (210 mm x 297 mm)

3 B5 (176 mm x 250 mm)

4 Legal size (8.5" x 14")

5 (default) Custom paper dimensions (Specify PaperWidth and PaperHeight parameters.)

Table 38. Printer Baud Rate

Value Description

0 Always use 0 for LPT or Network printer ports or for COM ports that communicate 
with the printer at 4800 baud

1 (default) 9600 baud

2 19200 baud

3 38400 baud

4 57600 baud

5 115200 baud
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PrinterCompressed
Use PrinterCompressed to specify the data compression mode. (See Table 39.) For the printers 
supported in this release, always set PrinterCompressed to 1.

PrinterDensity
Use the PrinterDensity parameter to get a lighter or darker output from the printer. Start with the 
default setting, 2, which corresponds to the printer manufacturer�s default. As you get feedback from 
the field, you may need to adjust this setting.

The valid values are 0�4 where 0 is the lightest print density, 4 is the heaviest print density, and 2 
is average print density.

PrinterDither
Use to specify the method by which different colors are represented. (See Table 40.) For the printers 
supported in this release, PrinterDither should always be set to 0.

Table 39. Data Compression

Value Description

0 No compression techniques used

1 (default) Use any known compression

Table 40. Print Dithering

Value Description

0 (default) Use color diffusion

1 Use dithering
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PrinterDraftMode
Use PrinterDraftMode to specify the quality of the printing. (See Table 41.) For the printers supported 
in this release, PrinterDraftMode should always be set to 0.

PrinterFormFeed
Use PrinterFormFeed to specify how paper advances to the next page. (See Table 42.) If using sheets 
of paper, set PrinterFormFeed to 0. 

Specify 1 or 2 for continuous�feed paper:

■ Set PrinterFormFeed to 1 if you do not need to conserve paper or if you want pages of uniform 
length. The printer scrolls to the length specified by the PageHeight parameter and trims the 
page there. 

■ Set PrinterFormFeed to 2 to conserve paper or if it does not matter if your pages are of varying 
length. In this case, the printer scrolls 25 millimeters beyond the last printed line and trims the 
page there. The scroll distance, 25 mm, is not customizable.

For both values, 1 and 2, the page length never exceeds PageHeight.

Table 41. Print Quality

Value Description

0 (default) Use the highest quality printing

1 Use a lower quality printing if available

Table 42. Printer Form Feed

Value Description

0 (default) Printer sends a form feed command to the printer at the end of each page. Use 
this setting for sheet paper.

1 Printer scrolls the page to the length specified by the PaperHeight parameter.

2 Printer scrolls the page 25 millimeters past the last printed line of the page.
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PrinterHandshake
Use PrinterHandshake to define the serial port handshake. (See Table 43.) The PrinterHandshake 
parameter applies only when the printer port is a Com1 or Com2 port. If PrinterPort is set to Com1 
or Com2, then set PrinterHandshake to 1. 

PrinterOrientation
Specify whether the paper is to be oriented vertically (portrait) or horizontally (landscape). (See 
Table 44.) Not all printers can print in landscape orientation. Therefore, you will need to check the 
specifications for your printer.

PrinterPort
Specify the port to which the printer is connected with the PrinterPort parameter. (See Table 45.)

If PrinterPort is an LPT port or a network path (2 or 9), then the PrinterBaudrate must be set to 0.

Table 43. Printer Handshake

Value Description

0 Uses Xon/Xoff

1 (default) Uses hardware control lines

2 No handshaking of serial port

Table 44. Paper Orientation

Value Description

1 (default) Portrait (vertical)

2 Landscape (horizontal)

Table 45. Printer Port

Value Description

0 Com1: serial port

1 Com2: serial port

2 LPT: parallel port

3 (default) IR Infrared port

4 Com3: serial port
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PrinterType
Specify the type of printer using the PrinterType parameter. See Table 46 for the list of supported 
printers.

Default Printing Settings
The following are the printing parameters from the setup.ini file. The values shown are the default 
settings.

[Printing]

PrinterType= 14
PrinterPort= 3 
PrinterBaudrate= 1
PrinterHandshake= 1
PrinterOrientation= 1
PrinterDensity= 2
PrinterCompressed= 1
PrinterDither= 0

5 Com4: serial port

6 Com5: serial port

7 Com6: serial port

8 Print to file OUTPUT.PRN

9 Print to network address

10 Bluetooth BlueCard solution by Wireless Solutions

11 Socket PNC Bluetooth card support

12 Bluetooth BlueCard solution by Anycom

13 Com7: serial port

14 Com8: serial port

Table 46. Printer Type

Value Description

6 Pentax PocketJet 200

14 (default) O�Neil microFlash2i and microFlash4t printers

108 O�Neil microFlash8i printer

Table 45. Printer Port

Value Description
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PrinterDraftMode= 0
PrinterFormFeed= 0
PaperSize= 5
PaperWidth= 115
PaperHeight= 280
MarginLeft= 5
MarginRight= 5
MarginTop= 5
MarginBottom= 5
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accounts

account address, adding 124
activities, associating with accounts 128
business scenario 122
contact, adding to an account 125
creating an account 123
opportunity, adding to an account 129

accounts, managing
sales data, viewing 126

activities
accounts, associating with 128
contacts, associating with 139
creating a new activity 138
delegating an activity 139
general activities, adding using Calendar 

view 139
Activities view, adding from general 

activity 150
applet classes

Siebel Medical Goods 183
Applet print tag 188
applets

default behavior, overriding 23
form applets, designing 33
list applets, designing 34
multiple-applet views, toggling 

between 22
print applets, designing 33
Print buttons, configuring 34
printing, configuring 34
screen allocation 22
toggling between 108
URLs in applet fields 108

application memory, increasing 120
application-level menu

about 106
architecture

five layers described 17
asterisk (*), meaning in forms and 

applets 25
Auto Order, creating from quote 145
auto pop-up list

using, about 26
automatic backup

after synchronization 114
AutoQuote

See also quotes, developing
about using and Quote Items fields 

(table) 142
creating a quote 143
quote fields automatically completed 

(table) 142

B
Back button, about 109
backing up data

about 114
automatic backup after 

synchronization 114
database backup parameters, editing 85
database backup, about enabling 84
database backup, setting up 85
external media, backing up to 85
restoring data from a backup 115
restoring from a backup, about 86
troubleshooting 171

barcode scanning, preparing handheld 
application for 103

business components
list of supported components 181

business object declarations, setting PDQ 
examples 71

business object filters
configuring 35

buttons
about and behavior 27

C
calendar

customizing, about 113
viewing 113

Calendar view, adding general 
activities 139

Calendar view, adding general 
activity 150

Cell print tag 189
client

installation, troubleshooting backup and 
restore 171

performance troubleshooting 177
columns, working with 110
Comment print tag 191
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CompactFlash card
backing up to, about 85
handheld application, about installing 

from 88
installation, setting up on 86
stand-alone installer, creating 88

Companion Sync
administration of 68

Companion Synchronization
checklist, using to troubleshoot 172
handheld application, using to install 100
handheld, using with 116
log files, using for troubleshooting 174
note, synchronizing to the Siebel 

Server 77
using to deploy patches 90

companion synchronization server, 
described 14

configuration file
See also configuring
default views, specifying 42
directives, about 70

configuring
Siebel Handheld client 15
Web Client and Handheld Client, differences in 

configuring 18
conflicts

See synchronization, conflict handling and 
recover

contacts
account, adding to 125
activities, associating with 139
contact participants, specifying 140
opportunity, associating with 136
opportunity, associating with an existing 

opportunity 132
contacts, managing

contacts, described 129
medical education event, inviting to 152
notes, sharing about a contact 133

customer relationships, managing
about 137
activities, about 137
activity, creating a new activity 138
activity, delegating 139
business scenario 138
contact participants, specifying 140
contacts, associating with activities 139
employee participants, specifying 140
general activities, adding using Calendar 

view 139

D
data

automatic backup after 
synchronization 114

backing up, about 114
columns, working with 110
Companion Synchronization, synchronizing 

handheld client for 117
Companion Synchronization, using with 

handheld 116
Direct Server Synchronization, using with 

handheld client 118
entering, about 110
exporting 112
Find, about using 111
queries, about 111
queries, creating 111
queries, executing 111
queries, refining 111
restoring data from a backup 115
Siebel Handheld Synchronization, using with 

handheld client 116
synchronizing data, about 115

data filtering
developing data filters, steps 67
pick applet, data filtering for 69

database backups
about 114
automatic backup after 

synchronization 114
database backup parameters. editing 85
enabling, about 84
restoring data from a backup 115
setting up database backups 85
troubleshooting 171

DDvP
See Direct Server Sync via Proxy

default sync filters, about 68
Direct Server Sync via Proxy, about 15
Direct Server Synchronization

See also Direct Server Synchronization (DDS) 
infrastructure

about 69
about and diagram 15
checklist, using to troubleshoot 172
described 14
handheld application, using to install 101
handheld client, using with 118
log files, using for troubleshooting 173
network performance, 

troubleshooting 178
patches, using to deploy 89
server performance, troubleshooting 177
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Direct Server Synchronization (DDS) 
infrastructure

DDS components, about installing 78
DSS object manager configuration file, 

editing 79
hardware and network configuration, 

recommended 77
multiple synchronization servers, using 81
planning, about 76
server logging levels, configuring 80
server process management, 

optimizing 81
server topology overview 77
Siebel Server installer, using 78
synchronization performance and scalability, 

about 81
synchronization security, about 81

direct synchronization server, 
described 14

Divider print tag 191
documents, defining 33
downloading patches 91
drilldowns, about 31
DSS object manager configuration file, 

editing 79
dynamic hyperlink, about 31

E
ellipsis, and expandable fields 108
employee participants, specifying 140
end user error messages

See troubleshooting
EndofLine print tag 192
error data, accessing 98
error messages

See troubleshooting
errors

general synchronization errors 119
synchronization transaction conflicts 119

expenses, tracking
detailed line items, adding 148
expense report. creating 148

exporting data 112
extended insert processing

about and synchronization 96
enabling 96

extended pick processing
about and synchronization 93
enabling 94

external media
backing up to 85
handheld application, about installing 

from 88

stand-alone installer, creating 88

F
features, new 11
Find

about using 111
Footer print tag 193
form applets, configuring

about 25
designing, about 33
group boxes, about 26
labels, about 26
layout sequence 25

Format print tag 194
Forward button, about 109

G
general activities, creating

about and scenario 149
Activities view, adding from 150
Calendar view, adding 150

general sync filters, about 68
GetCount print tag 195
GetDate print tag 195
GetField print tag 196
GetRegistry print tag 197
GetTime print tag 198
GetTotal print tag 198
global user properties, list of 186
GotoView method, using 23
group boxes, about configuring 26
guidelines

Siebel Handheld client screen, about 
designing for 21

Siebel Handheld client, configuration 
guidelines 21

Siebel Handheld, recommended configuration 
guidelines 31

H
handheld device logs

list of log files 174
synchronization errors, logging 175

handheld interface
See interface

Header print tag 199
help

Siebel Expert Services, about using 179
Siebel Professional Services, about 

using 179
History arrows, about 109
Home Page applet, using 26
hyperlinks, about 31
Siebel Medical Handheld Guide Version 7.7 ■ 215



Index ■  I
I
installing

barcode scanning, preparing handheld 
application for 103

CompactFlash card. setting up installation 
on 86

Companion Sync, using to deploy 
patches 90

database backup parameters, editing 85
Direct Server Sync, using to deploy 

patches 89
Direct Server Sync, using to install handheld 

application 101
external media, about installing from 88
external media, backing up to 85
install directory, changing 88
patches, about distributing 88
patches, downloading 91
print templates in the Install directory 86
process of installation 82
read-only files, changing attributes 91
reinstalling the handheld application 102
restart parameter, setting 87
restoring from a backup, about 86
setup.ini file, editing 82
software on handheld. about 99
stand-alone installer, creating 88
SyncURL, changing 87
uninstalling handheld application 103
upgrade kits, creating to remotely deploy 

patch files 91
upgrading the handheld application 102
user database backup, about enabling 84
user database backup, setting up 85
using Companion Sync users to install 

handheld application 100
Integrated Sync

handheld client, synchronizing for Companion 
Synch 117

synchronizing data, and 116
interface

application-level menu 106
components, about and diagram 105
expandable fields 108
Minimize button 107
Queries drop-down list 107
screens menu, about 106
screens menu, navigation level 108
Show drop-down list, about 106
Show drop-down list, navigation level 108
Siebel toolbar, about 107
Siebel toolbar, customizing 107
status bar 107

toggling between applets 108
URLs in applet fields 108

L
labels, about configuring 26
list applets, configuring

about 24
designing, about 34
recommended strategy 24

log files
Companion Sync logs, using for 

troubleshooting 174
Direct Server Sync logs, using for 

troubleshooting 173
handheld device logs, using for 

troubleshooting 174

M
MarginBottom parameter 205
MarginLeft parameter 206
MarginRight parameter 206
MarginTop parameter 206
Maximize Minimize Applet button, 

about 107
MedEd event

See medical education event, setting up
media

external media, backing up to 85
handheld application, about installing from 

external media 88
stand-alone installer, creating 88

medical education event, setting up
about 151
contact, inviting to an event 152
creating a medical education event 152

memory, increasing 120
menu bar, about 29
Minimize button, about 107
multiple synchronization servers

about using 81
Multi-Value Group applet, support of 19

N
naming conventions, about 22
network performance, about 178
new features 11
notes, sharing about a contact 133

O
opportunities

account, adding to 129
contact, adding to an opportunity 136
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contact, associating with an existing 
opportunity 132

creating an opportunity 135
defined and examples 133
opportunity quotes, about viewing 137
products, associating to an 

opportunity 136
sales methods, about 133

orders, managing
Auto Order, creating from your quote 145
creating an order manually 146
order line items, adding 146
terms and totals, adding 147

P
Page Break print tag 200
PaperHeight parameter 206
PaperSize parameter 206
PaperWidth parameter 207
parent form applet, about 22
participants, specifying 140
PatchAgent, about 88
patches

Companion Sync, using to deploy 
patches 90

Direct Server Sync, using to deploy 
patches 89

distributing, about 88
downloading 91
read-only files, changing attributes 91
synchronizing data, and 116
upgrade kits, creating to remotely deploy 

patch files 91
PDQ filters, administration

Companion Sync, about 68
Direct Server Sync mode, about 69

PDQs
Queries drop-down list, and 107

performance
application memory, increasing 120
client performance, about 177
handheld screen, about designing for 21
improving by identifying user activities 21
improving performance, about 120
network performance, about 178
server performance, about 177
SQLTrace and synchronization 175

pick applets, data filtering for
about 69
business object declarations, setting 

examples 71
configuration file directives 70
Popup Visibility Type setting, overriding 73

visibility, designating 72
Picture print tag 200
pop-up lists

auto pop-up lists, about using 26
Popup Visibility Type setting, 

overriding 73
predefined queries

Queries drop-down list, and 107
Predefined Queries (PDQs)

general and default PDQ filters, 
described 68

preferences
setting user preferences 113

print applets
designing, about 33

Print buttons, configuring 34
print tagging language

See print templates
print templates

Applet print tag 188
Cell print tag 189
Comment print tag 191
creating print templates 35
Divider print tag 191
EndofLine print tag 192
Footer print tag 193
Format print tag 194
GetCount print tag 195
GetDate print tag 195
GetField print tag 196
GetRegistry print tag 197
GetTime print tag 198
GetTotal print tag 198
Header print tag 199
Install directory. installing in 86
Page Break print tag 200
Picture print tag 200
print template file, creating overview 187
SetVariable print tag 202
Static Text print tag 202
Title print tag 202
variables, example using in template 203
views, associated with 23

PrinterBaudrate parameter 207
PrinterCompressed parameter 208
PrinterDensity parameter 208
PrinterDither parameter 208
PrinterDraftMode parameter 209
PrinterFormFeed parameter 209
PrinterHandshake parameter 210
PrinterOrientation parameter 210
PrinterPort parameter 210
PrinterType parameter 211
printing
Siebel Medical Handheld Guide Version 7.7 ■ 217



Index ■  Q
handheld application, printing with 112
printing quotes 145
printing, configuration settings

default printing settings, list of 211
MarginBottom parameter 205
MarginLeft parameter 206
MarginRight parameter 206
MarginTop parameter 206
PaperHeight parameter 206
PaperSize parameter 206
PaperWidth parameter 207
parameters and syntax 205
PrinterBaudrate parameter 207
PrinterCompressed parameter 208
PrinterDensity parameter 208
PrinterDither parameter 208
PrinterDraftMode parameter 209
PrinterFormFeed parameter 209
PrinterHandshake parameter 210
PrinterOrientation parameter 210
PrinterPort parameter 210
PrinterType parameter 211

printing, configuring
about 32
applet, configuring for printing 34
documents, defining 33
form applets, designing 33
list applets, designing 34
print applets, designing 33
Print buttons, configuring 34
print templates, creating 35

private notes
contact notes, adding 133

products, associating an opportunity 
with 136

projects
naming conventions, and 22

Q
queries

about using 111
creating a query 111
executing 111
refining 111

Queries drop down list, about 107
quotes

opportunity quotes, about viewing 137
quotes, developing

about 141
AutoQuote, about using and Quote Item fields 

(table) 142
AutoQuote, quote fields automatically 

completed (table) 142

AutoQuote, using to create a quote 143
business scenario 141
creating a quote 141
printing a quote 145
quote line items, adding 144
quote line items, deleting 144

R
read-only files

changing attributes for upgrade kits 91
record navigation buttons 109
records, navigating a list of

about 109
Back and Forward buttons 109
History arrows 109
record navigation buttons 109

reinstalling the handheld application 102
report

expense report, creating 148
reports

views, associated with 23
repository

compiling 32
restart parameter, setting 87
restoring data

from a backup 115
troubleshooting 171

S
sales data, viewing 126
sales methods, about 133
screens

designing screens for Siebel Handheld, 
about 22

screen allocation 22
screens menu

about 106
navigation level 108

scripting
deactivating scripts, about 75
user interface methods, calls to 75

server installation
Direct Server Synchronization (DDS), about 

installing 78
Direct Server Synchronization (DDS), using 

Siebel Server installer 78
DSS object manager configuration file, 

editing 79
hardware and network configuration, 

recommended 77
multiple synchronization servers, using 81
planning for, about 76
server logging levels, configuring 80
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server process management, 
optimizing 81

server topology overview 77
synchronization performance and scalability, 

about 81
synchronization security, about 81

server logging levels, configuring 80
server performance, troubleshooting 177
server process management, 

optimizing 81
ServiceCE Generic, about 29
setup.ini file, editing 82
SetVariable print tag 202
shared notes

contacts, adding 133
Show drop-down list

about 106
navigation level 108

Siebel Anywhere
using to create upgrade kits 91

Siebel eScript
issues and validation 75

Siebel Expert Services
about using 179

Siebel Handheld Client
application memory, increasing 120
auto-pop-up list, using 26
compiling the repository 32
configuration guidelines 21
configuration guidelines, recommended 31
Direct Server Synchronization, using with 

handheld client 118
form applets, about configuring 25
general synchronization errors 119
handheld screen, about designing for 21
Home page applet, about 26
hyperlinks, about 31
improving performance, about 120
list applets, configuring 24
menu bar, about 29
Multi-Value Group applet, support of 19
printing, configuring 32
process of configuring 17
scripting, about 75
Siebel Web Client, differences in 

configuring 18
status bar, about 30
synchronization conflicts, preventing 31
synchronization transaction conflicts 119
synchronizing for Companion Synch 117
testing the handheld application 37
toolbars, about 30
unsupported functions 19
user functionality, defining 20

user interface elements, about 
configuring 24

Siebel Handheld projects
about creating and naming conventions 22

Siebel Handheld Synchronization
application memory, increasing 120
Companion Synchronization, using with 

handheld 116
Direct Server Synchronization, using with 

handheld client 118
general synchronization errors 119
handheld client, synchronizing for Companion 

Synch 117
handheld client, using 116
improving performance, about 120
synchronization transaction conflicts 119

Siebel Handheld upgrade kit
creating upgrade kit 91
read-only files, changing attributes 91

Siebel Medical Handheld
applet classes, list of 183
business components, list of 

components 181
Siebel Mobile Web Client

Companion Sync, using to deploy 
patches 90

installation, about 82
read-only files, changing attributes for 

upgrade kits 91
upgrade kit, creating 91

Siebel Professional Services
about using 179

Siebel Server installer
DSS component, using to install 78
DSS object manager configuration file, 

editing 79
server logging levels, configuring 80
server process management, 

optimizing 81
Siebel toolbar

about 107
customizing 107

Siebel Visual Basic (VB)
issues and validation 75

Siebel Web Client
Multi-Value Group applet, support of 19
scripting, issues and validation 75
Siebel Handheld client, differences in 

configuring 18
unsupported functions 19

signature capture
enabling, about and screen capture 

buttons 35
signature capture applet control user 
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properties 36
software

about installing on handheld 99
SQLTrace, enabling 175
.SRF file

compiling repository file 32
stand-alone installer, creating 88
Static Text print tag 202
status bar

application window, appears at bottom 
of 107

toolbar, located above 30
synchronization

Direct Server Sync via Proxy, about 15
Direct Server Sync, about and diagram 15
methods and architecture 14
overview 14
servers, types of 14

synchronization, conflict handling and 
recovery

about 93
error data, accessing 98
extended insert pick processing, about 96
extended insert pick processing, 

enabling 96
extended pick processing, about 93
extended pick processing, enabling 94

synchronizing
application memory, increasing 120
automatic backup after 

synchronization 114
Companion Synchronization, using with 

handheld 116
data, about 115
Direct Server Synchronization, using with 

handheld client 118
general synchronization errors 119
handheld client, synchronizing for Companion 

Synch 117
handheld synchronization errors, 

logging 175
improving performance, about 120
multiple synchronization servers, using 81
performance and scalability, about 81
resynchronization problems, 

troubleshooting 173
security, about 81
Siebel Handheld Synchronization, using with 

handheld client 116
synchronization conflicts, preventing 31
transaction conflicts 119
troubleshooting, about problems caused 

by 172
SyncURL, changing 87

T
technical support

Siebel Expert Services, about using 179
Siebel Professional Services, about 

using 179
templates

print templates, creating 35
print templates, views associated with 23

terms, adding 147
testing the handheld application 37
timeout parameter

Windows 2000, changing on 176
Windows NT, changing on 176

Title print tag 202
toggling between applets 108
toolbars

about 107
configuring 30
customizing 107
toolbar functions 30

totals, adding 147
troubleshooting

client installation, backup, and restore 171
client performance, about 177
Companion Sync checklist, using 172
Companion Sync log files 174
Direct Server Sync checklist, using 172
Direct Server Sync log files 173
general synchronization errors 119
handheld device logs 174
network performance, about 178
resynchronization problems 173
server performance, about 177
Siebel Expert Services, about using 179
Siebel Professional Services, about 

using 179
SQLTrace, enabling 175
synchronization transaction conflicts 119
synchronization, about problems caused 

by 172
timeout parameter, changing on Windows 

2000 176
timeout parameter, changing on Windows 

NT 176

U
ui

See user interface elements, configuring
uninstalling the handheld application 103
upgrade kits

creating to remotely deploy patch files 91
read-only files, changing attributes 91

upgrading
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handheld application 102
preparing to upgrade 99

URLs
in applet fields, 108

user functionality, defining
about 20

user interface elements, configuring
about 24
auto pop-up lists, about using 26
buttons, about and behavior 27
form applets, about configuring 25
Home Page applet, about 26
hyperlinks, about 31
list applets, about configuring 24
menu bar, about 29
status bar, about using 30
toolbars functions 30
toolbars, about configuring 30

user interface methods
calls to business component script 75

user preferences
about customizing 113

user properties
global user properties, list of 186
list of 185

V
views

default behavior, overriding 23
designing views for Siebel Handheld, 

about 22
drill-down only 23
new views, adding 41
print templates or reports, associated 

with 23
visibility, designating 72

W
Web server timeout errors

timeout parameter, changing on Windows 
2000 176

timeout parameter, changing on Windows 
NT 176

Windows
timeout parameter, changing on Windows 

2000 176
timeout parameter, changing on Windows 

NT 176
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